FURUNO ELECTRIC CO., LTD.

OPERATOR'S MANUAL

INMARSAT-C
MOBILE EARTH STATION

woee. FELCOM 15

www.furuno.co.jp



FURUNO ELECTRIC CO., LTD.

9-52 Ashihara-cho,
Nishinomiya, 662-8580, JAPAN

Telephone : +81-(0)798-65-2111
Fax : +81-(0)798-65-4200

Pub. No. OME-56350-K
(DAMI ) FELCOM15

ESF

(Elemental Chlorine Free)

The paper used in this manual
is elemental chlorine free.

[0 FURUNO Authorized Distributor/Dealer

A - DEC. 2002
K :JuL. 10, 2009

*00080934917*




IMPORTANT NOTICES

General

e The operator of this equipment must read and follow the descriptions in this manual.
Wrong operation or maintenance can cancel the warranty or cause injury.

e Do not copy any part of this manual without written permission from FURUNO.
e If this manual is lost or worn, contact your dealer about replacement.
e The contents of this manual and equipment specifications can change without notice.

e The example screens (or illustrations) shown in this manual can be different from the
screens you see on your display. The screens you see depend on your system
configuration and equipment settings.

e Save this manual for future reference.

¢ Any modification of the equipment (including software) by persons not authorized by
FURUNO will cancel the warranty.

e All brand and product names are trademarks, registered trademarks or service marks of
their respective holders.
How to discard this product

Discard this product according to local regulations for the disposal of industrial waste. For
disposal in the USA, see the homepage of the Electronics Industries Alliance
(http://www.eiae.org/) for the correct method of disposal.

How to discard a used battery

Some FURUNO products have a battery(ies). To see if your product has a battery(ies), see
the chapter on Maintenance. Follow the instructions below if a battery(ies) is used.

In the European Union

The crossed-out trash can symbol indicates that all types of

batteries must not be discarded in standard trash, or at a trash

site. Take the used batteries to a battery collection site

according to your national legislation and the Batteries Directive Cd

2006/66/EU.
In the USA

Ni-Cd and lead-acid rechargeable batteries must be recycled.
Take the used batteries to a battery collection site according to
local laws.

The Mobius loop symbol (three chasing arrows) indicates that @9 élﬁ

Ni-Cd Pb

In the other countries

There are no international standards for the battery recycle symbol. The number of symbols
can increase when the other countries make their own recycling symbols in the future.



A SAFETY INSTRUCTIONS

AN WARNING

Do not open the equipment.

Hazardous voltage which can
cause electrical shock, burn
or serious injury exists inside
the equipment. Only qualified
personnel should work inside
the equipment.

Hazardous microwave.
Do not approach within
60 cm of the antenna radome
when it is transmitting.

Microwave radiation can be
harmful to the human body,
particularly the eyes.

Radiation Level | At
10W/m? 0.6 m

Leave the equipment powered while
underway. (For antenna maintenance
and the like, turn off the power at the
mains switchboard.)

Distress cannot be communicated unless
the equipment is powered.

Do not disassemble or modify the
equipment.

Fire, electrical shock or serious injury can
result.

Turn off the power immediately at the
ship's mains switchboard if water
leaks into the equipment or the equip-
ment is emitting smoke or fire.

Continued use of the equipment can cause
fire or electrical shock. Contact your
dealer for advice.

Do not locate the terminal unit near
water or places subject to water splash.

Electrical shock, fire or personal injury may
resullt

Any repair work must be done by a
licensed radio technician.

Improper repair work can cause electrical
shock or fire.

AN WARNING

Do not operate the equipment with
wet hands.

Electrical shock may result.

A\ CAUTION

Use the proper fuse.

Use of a wrong fuse can result in fire or
permanent damage to the equipment.

This equipment is intended for marine
application.

WARNING LABEL

A warning label is attached to the
terminal unit. Do not remove the label.
If the label is missing or damaged,
contact your dealer about replacement.

( AWARNING A W Name: Warning Label (2)
{To avoid electrical shock, do not Type: 03-129-1001-1

. N - i |
e e ouet No usersenviceable | e No.: 100-236-741
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FOREWORD

Introduction

FURUNO Electric Company thanks you for considering and purchasing the
FELCOM 15 Inmarsat C Mobile Earth Station. We are confident you will discover
why the FURUNO name has become synonymous with quality and reliability.

Mainly consisting of an antenna unit and a terminal unit, the FELCOM 15
provides the full range of distress and general communication services for
mobile and fixed terrestrial subscribers in the Inmarsat C communication
network. Its compact size permits installation where space is limited.

FURUNO designs and manufactures this equipment with much attention to
operation and maintenance simplicity. However, please read and follow the
recommended procedures for operation and maintenance to get the most out of
the equipment.

This manual provides a brief introduction to the Inmarsat C system (pages x thru
xiv). For more detailed information, refer to the information below.

Inmarsat C Maritime Customer Relations Officer
Maritime Services Operations Department
International Maritime Satellite Organization (Inmarsat)

Address: 99 City Road, London, EC1Y 1AX, UK
Telephone: +44 20 7728 1777 (Switchboard)

Fax: +44 20 7728 1142
URL: www.inmarsat.com
E-mail customer_care@inmarsat.com

Vii



Features

e Conforms to the following standards: IMO A.807(19), MSC.68(68) Annex 4,
MSC/Cir 682, IMO A.694(17), IEC 61097-4 (1994), IMO A.664(16), IEC
60945 (2002), IEC 61162-1 (2000).

e E-mail facility. (To send E-mail, register with an LES which provides e-mail
services.)

e Built-in Enhanced Group Call (EGC) receiver permits operation as EGC-only
receiver.

e Terminal unit accepts a wide variety of peripheral equipment: Distress
Message Controller (DMC), PC, navigator, etc.

e Connection of external terminal unit for operation from remote location such
as the bridge.

e Store-and-forward telex communication (public telex network)
e Data reporting and Polling

e GPS receiver (option) built in the terminal unit provides GPS-generated
position.

e Diagnostic programs for maintenance

e Terminal unit provides a floppy disk drive for storage of received and
transmitted messages on floppy disks.

e Menu driven operation

Program Number

PC Board Program No. | Version No. Date of Modification
RF CON CPU 1650159 03 5/2004
TERM CPU 1650162 03 5/2004

viii



SYSTEM CONFIGURATION

ANTENNA
UNIT
IC-115

;~=-+1 DGPS |
SHIP'S MAINS : EGC Printer 1 24 VDC
100/115/220/230 VAC TERMINAL UNIT [ A PP205 i
10, 50/60 Hz T AL © o 1C-215 i PooTTT T v
®: \c-DC Power Supply | > L Personal L Printer |
® PR-240 P i Computer K i
""""""""""""""""" 71 (PCIAT compatible) i ~7 7777
SHIP'S MAINS | GPS Board | TITTITTIIIIIIIIL L
12/24VDC @ OP16-47 "1 Shipboard LAN (Ethernet) |
® Printer= : [} 1 0
: PP-510 = O
*For 12 VDC ship's mains, ‘ : 4
DC-DC converter is Mini Keyboard .
- Distress Alert/
required to use PP-510. presee Received Call Unit
S A IC-305
i Distress Message Controller ;
o bmés I JUNCTION
OR BOX Alarm Unit | max.2
U SORRRRR IC-315 IC-306/IC-350 | units
{SSAS Alert Unit | {SSAS Alert Unit |___;
IC-307 1C-307 oo

............................................

(Max. 3 units)
** = Mandatory for EGC operation as required by IMO RES. A.664(16).

CATEGORY OF UNITS

Unit Category

Terminal Unit | Protected from weather

Antenna Unit
Other Units

Exposed to weather

Protected from weather

- -: Navigatorg

—— : Standard Supply
: Option
e : Local Supply



INMARSAT C SYSTEM OVERVIEW

Introduction

The Inmarsat C system provides worldwide telex and data transmission and
reception of written information to owners of an Inmarsat C transceiver or a
terrestrial telex network via satellite. Further, e-mail can be sent via the internet.

Communication mode is store-and-forward telex, which means all information
sent are first stored at an LES and then delivered to designated party.

An EGC (Enhanced Group Call) receiver is built in the FELCOM 15 to receive
the following types of messages, broadcast by LESs:

e SafetyNET -governments and maritime authorities can use this service to
distribute maritime safety information to ships within selected areas.

e FleetNET™-commercial subscription organizations or shipping companies
can use this service to transmit trade information (for example, company
news or market prices) simultaneously to a selected group of ships, to
provide up-to-the-minute information.

e EGC system-related is sent by Inmarsat to certain shipping companies and
geographical areas.

FELCOM 15 allows you to make distress calls. They are given immediate priority
over all other calls, and are automatically routed to a land-based Rescue
Co-ordination Centre (RCC).

Besides its primary application of ship-shore, shore-ship or ship-ship
communications, the Inmarsat C service has also proved beneficial to trucking
firms who have found it indispensable for communicating with their vehicles. In
this manual, however, we will concentrate on ship applications, the main
application.



INMARSAT C SYSTEM

Inmarsat C System Configuration

L

Same as left Same as left Same as left

N

Satellite

| AOR-West ,  AOR-East IOR POR

OCC: Operation Control Center
SCC: Satellite Control Center
NCS: Network Coordination Station
MES: Mobile Earth Station

LES: Land Earth Station

Inmarsat C system configuration

The Inmarsat C system consists of the Operation Control Center (OCC), Satellite
Control Centers (SCC), Network Coordination Stations (NCS), Land Earth
Stations (LES) and Mobile Earth Stations (MES). The OCC, located at Inmarsat’s
London headquarters, coordinates a wide range of activities in the Inmarsat
system, including commissioning of mobile earth stations.

The Inmarsat C system divides the world into four regions and each region is
covered by its own satellite.

Inmarsat system satellites

Region Satellite Satellite Position
AOR-West Inmarsat 3, F4 54.0°W
AOR-East Inmarsat 3, F2 15.5°W
IOR Inmarsat 3, F1 64.0°E
POR Inmarsat 3, F3 178.0°E

In each region there is one NCS and several LESs. The NCS keeps track of all
Inmarsat C transceivers in its region and broadcasts information such as
navigational warnings, weather reports and news. The LESs provide the link
between the MES and the terrestrial telecommunications networks via satellite.

Xi



INMARSAT C SYSTEM
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INMARSAT C SYSTEM

Communications Network

The illustration below shows the Inmarsat C communications network.

Network NCS/NCS Signaling Link
Coordination

Station (NCS)

NCS/LES
Signaling Link NCS Common Channel
Mobile Earth
Station (MES)
Data i Cranner o\, bta Teminai |
Communications - , . .
Network Land Earth E Data Circuit : Equipment (DTE) ; E
Station || Terminating |
MES Message | Equipment X
(LES) Channel | (DCE) o~ b
Telex Network y : Enhanced Group : !
LES TDM \ (Caliing (EGC) Receiver; |
™ Channel e e :
Terrestrial T
Communications
Network

Inmarsat C communications network

NCS common channel  The NCS has two major functions:
1) Transmitting information on a common channel.
2) Transmitting EGC messages to MESs.
NCS/LES signaling link  This is the link between NCS and all LESs in its
region. All EGC messages pass through this link.
LES TDM channel This channel carries the circuit control signal for
MES and transmits messages from LES to MES.
MES message channel This channel carries messages from MES to LES.
MES signaling channel  This channel transmits requests, distress alerts, data
reports, etc. In addition, it carries login and logout
from MES to NCS.
NCS/NCS signaling link  This is the link between NCSs. It exchanges data
between MESs operating in different ocean regions.
MES interface The MES consists of the Data Circuit Terminating
Equipment (DCE) and the Data Terminal Equipment
(DTE). The DCE consists of the antenna unit, and
the DTE consists of a terminal unit, a keyboard and
printer.
Terrestrial network The major functions of the LESs are:
interface
1) Telex store-and-forward conversion
2) Handling EGC messages
3) Handling distress alerts
4) Data Reporting and Polling
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INMARSAT C SYSTEM

Types of MES

There are three types of MES: class 1, class 2 and class 3. This FELCOM 15
is a class 2 MES.

Class 1: 1) Transmits messages to LES
2) Receives messages from LES
Class 2: 1) The functions of class 1 plus operation as an EGC receiver
when not transmitting or receiving.
2) EGC-only receiver
Class 3: The function of class 1 plus simultaneous operation as an
EGC-only receiver.

Peripheral Equipment

X1V

The following equipment can be additionally connected to the FELCOM 15.

Distress Message Controller (DMC-5)

The DMC-5 provides for transmission and monitoring of the distress alert. For
further details, refer to the operator’s manual of the DMC-5.

Distress
fo ‘ o‘ : T
[ - VHF D t
Istress
SEEs 7
[ | ‘7
=
= PROCEDURE DSC SSB .
Distress
\V4
Inmarsat C
NAME FELCOM 15
o o

Distress Message Controller DMC-5

Distress message controller system



LRIT COMPLIANCE

This equipment can function as a marine communications terminal for the LRIT
(Long-Range Identification and Tracking) system, as prescribed by the IMO regulation
MSC.202(81). The LRIT uses the FELCOM's Data Report/Polling feature for LRIT position
reporting.

The LRIT system is fully automatic, thus no operation is required of the user. However,
follow the guidelines shown below to use this equipment as an LRIT device.

The data listed below is sent by the FELCOM when it receives a command from the LRIT
data center.

e ID number of this equipment

e Position of your ship

e Time of position

The FELCOM sends data at intervals between 15 minutes and 6 hours.

The FELCOM automatically receives commands (related to time of position reporting,
transmission interval) from the LRIT data center. To receive the commands at all times,
keep the equipment powered and logged in.

%) Satellite System

// - \ T(i—_ast Station
/

i «————| Country A |
LRIT DATA | =
CENTER I «— | Country B |
‘ il
| Y— Country C |
LRIT system

XV



LRIT COMPLIANCE

Notes on the LRIT system

Power the equipment and keep it logged in at all times except for special occasions
such as when the ship is dry-docked for repairs. Position information is automatically
sent at fixed intervals, thus no operation is required. However, keep the equipment in a
ready state to received commands from the LRIT data center. Combined use for routine
messages, distress messages and SSAS (Ship Security Alert System) is possible.

The source of position data for this equipment can be its internal GPS receiver or
external GNSS (Global Navigation Satellite System) equipment. For GNSS equipment,
interface directly to the shipborne global navigation satellite system equipment.

If external GPS equipment is used, set it to use WGS84 datum. Further, the output
sentences should minimally be as follows:

- Time data input: ZDA

- Position data input: RMC or GGA and VTG (pair)

This equipment and external GNSS equipment must be powered in the following
manner.
- If the above equipment is to be used as a GMDSS device also, connect them to an
auxiliary power source (radio communications battery).
- If the above equipment will not be used as a GMDSS device, connect them to both
main and emergency power sources (via AC-DC power unit PR-240).

If an error message appears, take the necessary measures to restore normal operation
as soon as possible. Shown below are representative alarms.
- WARNING: External NAV equipment failure.
Position data is not correctly input from the external GNSS equipment. Check the
GNSS equipment and the wiring between it and the FELCOM.
- WARNING: Internal GPS UNIT failure.
Position data is not correctly input from the internal GPS receiver. If this alarm occurs
frequently, have the set checked.
- WARNING: Synchronization loss. Please check the current Ocean Region. -
- WARNING: BBER over 80%. Scanning NCS start manually.
Problem with receiving the Inmarsat-C signal. Check if the current sea area is
suitable for your position. If it is not, change the sea area. If the area is suitable and
the alarm continues, check the antenna and antenna cable. Request service if the
problem persists.

XVI



1. OPERATIONAL OVERVIEW

1.1 Terminal Unit

The terminal unit is the heart of the FELCOM 15 system, creating, transmitting
and receiving messages.

POWERDC
switch

Floppy disk[
drive

DISTRESSO
button

Terminal unit IC-215

1.1.1 Turning the power on/off

Press the [POWER] switch to power or turn off the terminal unit, antenna unit,
Distress Alert/Received Call Unit and Alarm Unit.

1.1.2 DISTRESS button

Use the [DISTRESS] button to transmit the distress alert when there is a
life-endangering situation on your ship.

1.1.3 Diagnostics

When the terminal unit is turned on it automatically checks itself for proper
operation. For detailed information, see Chapter 8.
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114

1.15

1.1.6

1-2

Floppy disk drive, floppy disks

The terminal unit provides a floppy disk drive for storing transmitted and received
messages on floppy disks. The floppy disks used with the system are 2HD (1.44
MB) and 2DD (720 KB).

Audio alarm

The audio alarm is released in the following instances.

Unit Telex, Distress EGC message received Trouble
e-mail | acknowledge | Distress | Urgency | Other | detected
received received

Terminal Unit YES YES YES YES NO YES
Distress NO YES YES YES NO NO
Alert/Received
Call Unit
Alarm Unit YES NO NO NO NO YES
Distress NO YES YES YES NO NO
Message
Controller

Adjusting brilliance

Raising brilliance: Press [Alt] + [F7].
Lowering brilliance: Press [Alt] + [F6].




1.2

Keyboard

The FELCOM 15 is almost 100% keyboard controlled. Operation is carried out
with the function keys, numbered F1-F10 at the top of the keyboard. The figure
below shows keyboard layout.

Function——— File

1.2.1

Transmit Reports i .
\ Edit EGC ) Logs OptlonsSetup F’OSIté?Qp Alarm
( P )
Bl S e ) A A A S A G e )
! @ # $ & * ( ) - Sacke | [1om
1 2 3 4 6 7 @|s EB]e o X = space
] Q w E R T Y u | [0} P { } PgUp
Tab @ 5] [ =N WS 1 \
cas A |s |D G |n Jo |k |t ! Pg Dn
[ B El}
@ z |x c |v |s [N [m |< |> |- S U
Shift o] B El Wil Shift
= m Im o 1< v 1=
- )
Keyboard
Key description
Esc Cancels key input and returns to previous display
screen.
F1-F10 These are the function keys, and they choose
menus.
Backspace Deletes the character to the left of the cursor.
Ins Works the same as “paste.” See “Copying and
pasting text” in paragraph 3.2.4.
Del Deletes the character selected with the cursor.
Home Moves the cursor to the top of the message being
edited.
End Moves the cursor to the bottom of the message
being edited.
PgUp Goes to the previous page of the edit screen.
PgDn Goes to the next page of the edit screen.

[71, 1, [«], [=]

Enter

Shift

Alt

Control the cursor.

Registers key input; inserts carriage return in TX
message.

Chooses upper or lower case alphabet. Press and
hold down the key and then press the [Caps Lock] to
get upper or lower case alphabet. Note that only
upper case alphabet are used in telex.

Executes the shortcut key operation when combined
with an alphabet key. See paragraph 1.2.2.
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1. OPERATIONAL OVERVIEW

Space

Caps Lock

Tab

Ctrl

Fn

Num Lock

Inserts a space. In addition, it displays the file list, a
partial view of a file, etc., depending on menu.
Turns upper case alphabet input on or off. The Caps
Lock LED lights when upper case alphabet input is
on.

Inserts horizontal tab characters. The number of tab
characters the key can insert per line of text can be
programmed for two, four or eight tabs.

Works in combination with alphabet keys as follows:
Ctrl + [M]: Same as Enter.

Ctrl + [H]: Same As Back Space.

Ctrl + [I]: Same as Insert.

Ctrl + [V]: Same as Overwrite+Insert on Edit Mode in
the Editor Setup menu.

Combined with an arrow key, it scrolls screen (T, 1),
or shifts cursor («, —).

Turns numeric input on or off. Note that you cannot
enter alphabet when the Num Lock LED is lit.

Note: In telex, lower case, #, &, *, $, @, %, etc. are not used. A full list of
characters useable in telex appears in the Appendix. For e-mail all
characters and symbols may be used.



1.2.2

1.2.3

Shortcut keys

The FELCOM 15 provides the keyboard shortcuts shown below for commonly

used functions.

Shortcut keys

Shortcut key

Function

[Alt]+][N] Same as New in File menu
[Alf]+[O] Same as Open in File menu
[AI]+[Q] Same as Close in File menu
[Alt]+[D] Same as Delete in File menu
[Alt]+[S] Same as Save in File menu
[Alt]+[P] Same as Print in File menu
[Alt]+[X] Same as Undo

[Del] Same as Cut in Edit menu
[Alt]+[C] Same as Copy in Edit menu

[Ins] Same as Paste in Edit menu

[Fn] + « Same as Top of Text in Edit menu
[Fn] + — Same as End of Text in Edit menu
[Alt]+[V] Same as Change Window in Edit menu

Function key description

Function key description

Menu Description
File (F1) Processes files.
Edit (F2) Provides text editing facilities.
Transmit (F3) Transmits messages.
EGC (F4) Sets up EGC message facilities.
Reports (F5) Sets up data/message reporting function.
Logs (F6) Displays sent and received message logs.
Options (F7) Login, logout; testing facilities.
Setup (F8) Sets up the system.

Position (F9)

Enter your ship’s position manually.

StopAlarm (F10)

Silences audio alarm.
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1.3

1-6

Distress Alert/Received Call Unit IC-305, Alarm
Unit IC-306

Distress Alert/Received Call Unit IC-305

The [DISTRESS] button functions to transmit the distress alert. To transmit the
distress alert, press the button until its lamp lights continuously. For further
details on how to transmit the distress alert, see paragraph 6.1.

The IC-305 releases the audio alarm and the lamp in the [ALARM ACK] button
flashes when an EGC distress or urgency broadcast is received. Press the
[ALARM ACK] button to acknowledge the alarm, and the alarm tone changes. To
silence the alarm and extinguish the lamp, press the function key F10 on the
keyboard of the terminal unit.

Alarm Unit IC-306

The IC-306 releases the audio alarm and flashes the lamp in its [ALARM
RESET] button when a telex or e-mail is received. To silence the audio alarm in
this case, press the [ALARM RESET] button on the IC-306. In addition to telex or
e-mail notification, the audio alarm sounds and the lamp flashes also for the
equipment trouble listed below. To acknowledge this alarm, press the [ALARM
RESET] button, and the alarm tone changes. To silence the alarm and flashing
of the button in case of external equipment abnormality, press the [F10] key on
the keyboard.

* “Unsync” condition (MES is not synchronized with satellite) continues for six
minutes. (UNSYNC appears at the bottom of the screen.)

* BBER is over 80% (BBER of 080 or higher appears on the system status
monitor.)

Note: The equipment cannot scan automatically in the above two situations.
Reselect ocean region referring to paragraph 7.2.
* Printer has no paper
* No data is received from internal or external GPS navigator

» Update position alert (manual position input) when position has not been
updated for four hours.

* Equipment trouble (synthesizer, oscillator, etc.)

FURUNO NMARSAT-MES FURUMO NVARSAT MES

Keep pressed for 4 s in
case of

DISTRESS

MES ALARMS AND
INCOMING MESSAGES

BRaNERFNAEM. 4BBFT .
S S ERETCE S &R,

Distress Alert/Received Call Unit Alarm Unit
1C-305 1C-306

Distress Alert/Received Call Unit IC-305, Alarm Unit IC-306



1. OPERATIONAL OVERVIEW

1.4  Printer PP-510 (option)

The PP-510 prints transmitted and received messages. The POWER switch is
on the right side of the unit. The lamp on the switch lights when the power is on.
If the paper is set correctly the ON LINE lamp also lights. When both those
lamps are lit, the printer is ready to print information received from the terminal
unit. For further details, refer to the PP-510’s operator’s manual.

POWER Switch
Qo000 ) e

NLQ Lamp | ‘ __ON LINE Lamp

NS

POWER
IP.PARKI FF l \ I ' lon LINE' O P.OUT

PAPER OUT Lamp
POWER Lamp
ON LINE Switch
NLQ Switch
LINE FEED Switch

FORM FEED Switch
P.PARK Switch

Printer PP-510
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1. OPERATIONAL OVERVIEW

1.5

Standby Display

After the equipment is turned on and the diagnostic test has been conducted, the
standby display appears, showing the system status monitor. The system status
monitor provides various operating information. For a detailed description, see
paragraph 8.4.

File Edit Transmit EGC Reports Logs Options Setup Position StopAlarm
IMN: 443156710
Date 02-02-25 BBER 000
Time 01:32 (UTC) CIN OK ( 0dB)
Send Level OK ( 0)
Position LAT 34:30.00N Rx AGC Level OK (254)
LON 135:00.00E REF Offset Freq OK( OH2)
Waypoint LAT Synthe Local OK
LON VCXO Control 131
Course 345.5 DEG
Speed 10.2KTS
Current NCS 344 (IOR) LOGOUT Antenna Power Supply  OK
Current Channel  NCSCC
Current TDM NCSCC Water Temperature 68.2 DEG
MES Status Idle Water Current
GPS Status rxxk Direction 232 DEG
Speed 19 KTS
DCE Memory 32818 Bytes free Depth
Current State: IDLE Retuning 02-02-25 01:32 (UTC)
NCS: IOR LOGOUT LAT: 34:30.00N
DCE F15 Ver. ## LON: 135:00.00E
##: Program Version No. of RF CON Board
Standby display

After the diagnostic test has been completed, the equipment automatically starts
synchronizing itself with a satellite. When the indication “Retuning” is replaced
with “ SYNC(NCS), the synchronization process is completed. Then, you are
ready to receiving EGC messages. For further details see paragraph 2.4.

Note: When the caution shown below appears, it is necessary to change the
LES ID in the distress alert setup to match current ocean region. For
further details, see paragraph 6.2.

CAUTION

Pre-set LESID for DISTRESS ALERT isinvalid in the present ocean region.
Please input preferred LES ID in the [Distress Alert Setup] menu.




1. OPERATIONAL OVERVIEW
15.1 Display indications
The display is divided in three sections:
1) The function menu area

2) The working area
3) The operating status area

File Edit Transmit EGC _ Reports Logs Options Setup Position StopAlarm +4—— 1) Function
_ H*— Menu

2) WORKING AREA

——3) Operating

Status

(6) (7) (10)
®

Location of display indications

Below are the indications and meanings of the items in parentheses in the
illustration above.

(1) Distress alert information message

No display (no distress alert)

Sending Distress Alert

Sending Distress Alert Test

Distress Acknowledgement Received
Distress Message Call Activated
Distress Message Call Acknowledged
Distress Button Test Mode

(2) Communication network mode

No display Normal operation

Restoration Mode Problem at NCS

(Flashing)

Restoration Mode Previously designated LES is transmitting the
(Reverse video) NCS common channel signal.
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1. OPERATIONAL OVERVIEW

(3) Terminal unit status

IDLE Idle (awaiting receiving, awaiting transmitting)
IDLE (PENDING) Awaiting reply from LES

SENDING Sending

RECEIVING Receiving

LOGIN Logged in with NCS

LOGOUT Logging out with NCS

DISTRESS ALERT When own vessel is transmitting the distress alert
Data Report Sending data report

TESTING Performance Verification (PV) testing

TEST SETUP Requesting PV testing

SCANNING NCS scanning

EGC RECEIVER EGC-only receiver operation

(Reverse video)

Delivery Status Req. Transmitting delivery status request

Forced Clearing Stopping receiving, transmitting, or scanning

(4a) Communication status

CALLING Now calling

WAITING FOR ACKNOWLEDGEMENT Waiting for acknowledgement from
LES.

RECEIVING EGC MESSAGE Now receiving EGC message

WAITING FOR BACKOFF Waiting to transmit data report

Successful Login. Login was successful

Login failed. Login failed

Successful Logout Logout was successful

Logout failed. Logout failed

Successful Distress Alert. Distress alert successfully

Distress Alert Failed Distress alert could not be transmitted.

Successful Forced Clearing. Forced clearing successful

Forced Clearing Failed. Forced clearing unsuccessful

SENDING MESSAGE PACKETS. Sending TX message packets

WAITING FOR ACKNOWLEDGEMENT Waiting for acknowledgement from LES

Successful sending to LES. Message successfully sent to LES

Sending message failed. Message could not be sent to LES

Call rejected. LES rejected your message

Call pending. LES temporarily suspending
communications

Received Call. Call received from LES

Received Call(ITA2). Call(ITA2) received from LES

RECEIVING MESSAGE PACKETS Receiving message packets

CLEARING Clearing TX sequence

Successful receiving. You successfully received message

Receiving failed. You could not receive message

Successful Data Report. Data report successfully sent.

Data Report failure. Data report could not be sent.

PV TEST CALL is rejected. PV test call rejected by NCS
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PV TEST CALL is pending.

1. OPERATIONAL OVERVIEW

PV test pending by LES

TEST-RECEIVING MESSAGE Receiving test message from LES
TEST-SENDING MESSAGE Sending test message to LES
TEST-DISTRESS ALERT Sending test distress alert to LES
WAITING FOR ACTIVATION Waiting start of PV test

WAITING FOR TEST RESULT Waiting for results of PV test
CLEARING Clearing PV test

PV TEST is Completed.

PV TEST Failure.

PV test is completed.
PV test failed.

(4b) RF CON/CPU'’s program version number

DCE F15 Ver. XX (XX = Version Number)

Note: Error message is displayed when equipment abnormality is detected.

(5) Frame synchronization

Blank

SYNC (NCS)
SYNC (LES)
MES Sig. Ch
MES Msg. Ch
UNSYNC
Retuning

Changing channel, or during transmission
Synchronizing with NCS

Synchronizing with LES

Changing MES signaling channel
Changing MES message channel

Out of synchronization

Synchronizing with NCS or LES

(6) Ocean region receiving

No display
AOR-W
AOR-E
IOR

POR

(7) Logging status

LOGOUT
LOGIN
LOGIN (Flashing)

Out of synch with satellite
Atlantic Ocean Region-West
Atlantic Ocean Region-East
Indian Ocean Region
Pacific Ocean Region

Logged out with ocean region
Logged in with ocean region
Logging in with ocean region
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1-12

(8) Other information

No display No receive message in memory, or printer is
operating.

REC. MESSAGE EXISTS Displayed when a routine message has

(Reverse video) not been printed, or a confidential message is
received.

Data Report When data reporting is activated.

(Reverse video)

Message Report Message report setting is activated.

(Reverse video)

(9) Date and time display

With connection of a navigator (internal GPS navigator or external navigator),
date and time (received from satellite) are displayed. Manually input date and
time are also displayed.

(10) Ship’s position

With connection of a navigator (internal GPS navigator or external navigator),
ships position is displayed in latitude and longitude and updated every 30
seconds, or manually input position is displayed.



1.6

1. OPERATIONAL OVERVIEW

Menu Overview

Operation of the FELCOM 15 is carried out through a menu system which you
access with the function keys at the top of the screen. The example below
shows how to choose menu options from the Editor Setup menu.

1. Press the [F8] key to display the Setup menu.

File Edit Transmit EGC  Reports Logs Options Position StopAlarm

Setup

1. Distress Alert Setup

2. System Setup

3. Editor Setup

4. Terminal Setup
5. EGC Setup

6. Auto Mode Setup
7. E-Mail Setup

8. Directories

9. Configuration

Setup menu

2. Choose desired menu by pressing appropriate numeric key. For example,
press the [3] key to show the Editor Setup menu.

Note: You may also choose a menu with the [t1] and [I] keys, pressing
[Enter] after making selection.

File Edit Transmit EGC  Reports Logs Options Position  StopAlarm

Setup
Editor Setup

Ascii
Edit Mode Insert
Word Wrap ON
Line No. ON
Tab Width 4 Char
Column Width 69
Cursor Type Block
Scroll Full Screen

Editor setup menu

3. Choose desired menu item by pressing the [1] or [1] keys followed by the
[Enter] key. A window displaying the options for the item selected or an
alphanumeric data entry window appears depending on your selection. For
example, choose Word Wrap.

OFF

Word wrap options window
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1.7

1-14

Note: On some menus the update window appears after

you press the [Esc] key. This is done to ask you to
confirm settings. Yes is selected; press the [Enter]
key to register settings, or press [ -] to choose No
and press the [Enter] key to escape.

Error Messages and Alerts

The terminal unit displays error messages and alerts, in the CAUTION window,
to call your attention to misoperation, failed operation and system error. A list of
error messages appears in Chapter 8 and alerts appear in the Appendix.

To erase an error message or alert, press the [Esc] key.

4. Pressthe [1]or [1] key to choose option desired and press the [Enter] key.
5. Press the [Esc] key several times to return to the standby display.

File Edit Transmit EGC  Reports Options  Setup Position StopAlarm

Log
2. Receive Message Log
Send Message Log
No. Message File Station LES Priority Send Status Délivery
CAUTION

No Message.

<Press ESC key to continue>

Location of error messages and alerts




1.8

1.8.1

Using a PC (local supply)

When using a PC as a sub terminal, the optional FD-ROM is required. The sub
terminal only functions for communications; initial settings, etc. are conducted
from the main terminal.

FD-ROM
Code No.: 004-438-920
Type: 16-5-0164

PC requirements

OS: Windows 98, 2000, ME, XP, Vista
Memory: Min. 32 MB

Hard disk: Min. 20 MB free space
CPU: 100 MHz or better
Floppy disk drive

Windows is a registered trademark of Microsoft Corporation in the US and other
countries used under license.

Installing software

After installing the equipment, install the FELCOM 15 software (F15PC) in the
PC as follows:

Turn on the PC.

Set FD-ROM in floppy disk drive.

Click the icon of “SETUP.EXE” in the floppy disk. The setup procedure

begins, showing the welcome dialog box.

|retal Ehield

Welcome ta the FELCOM15 Setup program.  This pragranm wil
ingtall FELCOM1S on your computer.

Itiz strongly recommended that you exit all Windows programs
before mnning this Setup program.

Click Cancel to quit Setup and then close any programs you have
runking. Click Mest to continue with the Setup program.

WARMIMG: Thiz program iz protected by copyright law and
international treaties.

|nautharized reproduction or distribution of this program, or any
portion of it, may result in gevere civil and criminal penalties. and
will be prozecuted to the masimum extent pozsible under law.

¢ Back

Cancel |

Welcome dialog box

1-15



1. OPERATIONAL OVERVIEW

4. Click the [Next] button.

Setup will install FELCOR15 in the fallowing directon.
Toinztall to thiz directony, click Mest.

To install to a different directory, click Browse and select another
directory.

You can chooze not to install FELCORM1S by clicking Cancel to
exit Setup.

C:A\Program FileshFurunohFELCOM1S Browsze... |
Cancel |

Choose destination location dialog box
5. Click the [Next] button.

" Destination Directorny

|rretal Efield
¢ Back

Setup will add program icons to the Program Folder listed below.
Y'ou may twpe a new folder name, or select one from the existing
Folders list. Click Mest to continue.

FProgram Folders:

FELCOMTS

E sisting Folders:

Dell Accessonies
EAST JOY

IBM AS400 WwWindows
Java 2 Runtime Environment

Lhaca
M etaphaze LI

|rretal Efield

¢ Back I Mest > I Cancel

Select program folder dialog box
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6. Click the [Next] button.

Setup haz enough information to start copring the program files.
IF you want to review or change any zettings, click Back. 1f you
are zatisfied with the zettings, click Mext to begin copying files.

Current Settings:

Setup Type: ;I
Complete

Target Folder
C:AProgram Files\FurunohFELCOM15

Uszer Infarmation
Mame: |
Compaty:

i o
Cancel |

|rretal Efield

¢ Back

Start copying files dialog box
7. Click the [Next] button and the installation begins. When the installation is
completed, the FELCOM 15 dialog box appears.

&0 FELCOM15 [_ O] ]
JFiIe Edit  Wiew Fawvorites Tools  Help ‘

J SBack -« = v | &hSearch [4Folders  ¢FHistary ||:|E_L_|* i » | Eg-

| Address | FeLCoMLS | e
Py u _E

e F15PC

FELCOM 15 dialog box

1-17



1. OPERATIONAL OVERVIEW

8. Click the Close button ()at the top right corner of the dialog box. The
“Setup Complete” dialog box appears.

Setup Complete

Setup has finished copying fles bo your computer:
Setup will niow laurich the progran. Select pour option belaw

I #es Launch the progiam file

Click Fitish to eomplete Setup.

et [ =]

el | e |

Setup complete dialog box

Note: If you want to launch the program file now click the box next to “Yes,
Launch the program file.” The application will launch after the
completion of step 9.

9. Click the [Finish] button. The FELCOM 15 PC application shortcut is created
on the desktop.

Note: To uninstall the F15 application see the operator’s manual for the PC.
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Starting up, quitting the application

For information about PC operating procedures, see the owner’s manual of the
PC.

[N

5.
6.
7.

. Turn on the terminal unit.
. Turn on the PC.

Double-click the FELCOM 15 icon to start the application.

. To quit the application, press the [F12] key while pressing the [Alt] key. (You

may also quit the application by clicking the Close button.) Then, the
following window appears.

OK to quit system?

Press the [«] key to choose Yes and then press the [Enter] key.
Turn off the PC according to Windows operating procedure.
Turn off the terminal unit.

Note 1:If the application is quit using a method different from that described

above newly changed settings will not be memorized.

Note 2: The procedures described in this manual are intended for use with the

terminal unit. Operation from a PC is similar, however key names, etc.
may be different and some functions are not available. The functions not
available with a PC are as follows:

Keving Sequence Function not available with PC

F3-1 Distress priority selection on Transmit Message

F7-1 Login

F7-2 Logout

F7-3 Abort (forced clearing)

F7-4 Select NCS (selection of NCS common channel)

F7-5 Ocean Region (selection of ocean region)

F7-7 Functions other than “PV Test Result” and
“Diagnostic Test” on Test menu

F8-1 Distress Alert Setup

F8-2 Functions other than IMN on System Setup menu

F8-5 EGC Setup

F8-9 EGC and NCS Channel Lists on Configuration menu
(registration of EGC and NCS channels)

F9 Position (manual input of position)

1-19



1. OPERATIONAL OVERVIEW

1-20

Operation for PC

® Printer Selection

Choose the printer connected to the PC as follows:

1. Press function key [F1] to open the File menu.

Edit Transmit EGC

Reports Logs Options Setup Position StopAlarm

File

1. New ALT-N

2.0pen  ALT-O
3.Close  ALT-Q
4.Save  ALT-S

9. MIME (Decode)

File menu

2. Press the [8] key to open the Print Setting window.

3. Press [|] or [1] to choose appropriate printer.

Please select Printer
and press Enter key.

Print Setting

Windows Printer

No Printer

PP-510

Print setting

No Printer: Choose this item if no printer is connected.

Windows Printer: Choose if a PC-use printer is connected.

PP-510: Choose if PP-510 is connected.
4. Press the [Enter] key to finish.




® Backing up the System

System data can be backed up to a floppy disk or to a selected folder on the
computer hard drive. However, when saving system data to the terminal unit,
data can only saved to a floppy disk.

1. Press the function key [F8] and the [9] key to open the configuration menu.

—— Setup —|
Configuration

2. LES List

3. EGC Channel List

4. NCS Channel List

5. E-Mail/SMS Service List
6. Save/Load

3. DITECTOTIeS
9. Configuration

2. Press the [6] key to select Save/Load
— Save/Load ——

Save

Load

3. Pressthe[r ] to scroll up and select [Save], then press the [Enter]
key.

— Save ——
2. Station List
3. LES List
4. E-Mail/SMS Service List
5. Other

4. Press the number key corresponding to the data which you want to save.
ALL: Save all contents (excluding the Distress Alert Setup menu)
Station List: Subscriber list
LES List: Coast station list
Email/SMS Service List: Email/SMS coast station list
Other: For all other data except the [Distress Alert Setup] menu, subscriber
list, coast station list, and email service coast station list
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1. OPERATIONAL OVERVIEW

The [Browse for folder] dialogue box will appear.

Browse For Folder

2]

Select the Folder that wou want to stare your documents in,

Dieskbop

ﬁ My Docurnents
Q‘ My Cormputer
-- My Mebwork Places

=
New Folder I OK | Cancel |

4

[Browse for Folder] dialogue box (Windows XP). Appearance will vary
depending on computer and OS.

5. Select a destination folder and press [OK]. The computer will display the
“OK to save?” message.

6. Select [Yes] and press the [Enter] Key.
7. Press the [Esc] key 3 times to return to the main menu



2.

SYSTEM INITIALIZATION

2.1
2.1.1

This chapter provides the information necessary for initializing the FELCOM 15.
Once the equipment is initialized, you need do no more than press a few keys to
get fully automatic transmission and reception.

Inmarsat assigns an MES an Inmarsat Mobile Number (IMN) when it applies for
Inmarsat registration. The IMN is necessary to communicate in the Inmarsat
system. It is entered into the FELCOM 15 during the installation.

System Settings

Confirming the main terminal

The main terminal is where you set up the system. (You cannot set up the
system from an external terminal.) Confirm that the main terminal is selected as
below.

1. Press the [F8] key to choose the Setup menu.

File Edit Transmit EGC  Reports Logs Options Position StopAlarm

Setup

1. Distress Alert Setup

2. System Setup

3. Editor Setup

4, Terminal Setup
5. EGC Setup

6. Auto Mode Setup
7. E-Mail Setup

8. Directories

9. Configuration

Setup menu

If your screen looks something like the one shown in the illustration above, you
are using the main terminal. (If you are using an external terminal, some menu
items appear in gray.)
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2.1.2 System setup

The System Setup menu provides for input of date, time, operating mode, and
port function.

1. Press the [F8] key to choose the Setup menu.

File Edit Transmit EGC  Reports Logs Options Position StopAlarm

Setup

1. Distress Alert Setup

2. System Setup

3. Editor Setup

4, Terminal Setup
5. EGC Setup

6. Auto Mode Setup
7. E-Mail Setup

8. Directories

9. Configuration

Setup menu
2. Press the [2] key to display the System Setup menu.

Setup I
System Setup

03:11 02-02-25 (YY-MM-DD)
Entered at installation —— IMN

(Cannot be changed.) MES Operation Mode ~ INMARSAT-C
Nav Port OFF
Active Port INT
Message Output Port INT
EGC Output Port INT
Network Setup

Command Window

System setup menu
3. System Date & Time is selected; press the [Enter] key to open the date entry

window.
Setup I
System Setup
02-02-25| (YY-MM-DD)
IMN
MES Operation Mode INMARSAT-C
Nav Port OFF
Active Port INT
Message Output Port INT
EGC Output Port INT
Network Setup
—1 Command Window

System setup menu, date entry window
4. Enter the date with the numeric keys. (Entry of date is not necessary if a GPS
navigator is connected to the FELCOM 15.)
5. Press the [Enter] key to close the window. (Note that the IMN is entered
during installation. The IMN window cannot be opened.)
6. Press the [1] key twice to choose MES Operation Mode.
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7. Press the [Enter] key to open the MES operation mode options window.

Setup I
System Setup
System Date & Time 01:53 02-02-25 (YY-MM-DD)
IMN
Nav Port EGC
Active Port
Message Output Port INT
EGC Output Port EXT
Network Setup EXT
—| Command Window

System setup menu, MES operation mode options window

8. Pressthe [i] or [1] key to choose operating mode, INMARSAT-C or EGC.
The INMARSAT-C setting provides telex communications and operates as an
EGC receiver when the equipment is not transmitting or receiving. The EGC
setting enables EGC-only operation. In this case, “Current State: EGC
RECEIVER” appears (reverse video) at the bottom of the screen.

9. Press the [Enter] key to close the window.

10.Press the [I] key to choose Nav Port.

11. Press the [Enter] key to open the nav port options window.

Setup |
System Setup
System Date & Time 01:53 02-02-25 (YY-MM-DD)
IMN
MES Operation Mode INMARSAT-C
[Nayport
Active Port EXT
Message Output Port INT
EGC Output Port
Network Setup
—1 Command Window

System setup menu, nav port options window

12.Press the [1] or [1] key to choose the navigator which is interfaced to the
FELCOM 15.

OFF:  No navigator interfaced or manual input of position

EXT:  Choose this setting to use external navigator. If two or more navigators
are connected, the FELCOM 15 automatically chooses ship’s position
data in the order of GPS, Loran C, and DECCA.

INT: Use the GPS receiver (option) built in the terminal unit.

Note: If there is no navigator (Nav Port setting is “OFF"), you should enter
position manually, in the Position menu. Refer to paragraph 2.8.

13.Press the [Enter] key to close the window.
14.Press the [1] key to choose Active Port.
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15.Press the [Enter] key to open the active port options window.

Setup I
System Setup
System Date & Time 01:53 02-02-25 (YY-MM-DD)
IMN
MES Operation Mode INMARSAT-C
Nav Port OFF
[INT]
INT
Message Output Port ALL
EGC Output Port
Network Setup

Command Window

System setup menu, active port options window
16.Press the [1] or [1] key to choose active port (terminal unit); “INT” or “ALL” as
appropriate.
INT:  Use main terminal unit.

ALL: Use the terminal unit (PC, etc.) connected to the DTE port on the main
terminal.

17.Press the [Enter] key to close the window.
18.Press the [I ] key to choose Message Output Port.
19.Press the [Enter] key to open the message output port options window.

Setup I
System Setup
System Date & Time 01:53 02-02-25 (YY-MM-DD)
IMN
MES Operation Mode INMARSAT-C
Active Port INT
Nav Port OFE
EGC Output Port EXT
Network Setup INT+EXT
—1 Command Window AUTO

System setup menu, message output port options window
20.Press the [1] or [1] key to choose the terminal unit where you want to route
received messages.
INT: All received messages are routed to the main terminal.
EXT: All received messages are routed to the terminal unit connected to
the DTE port on the main terminal unit.
INT+EXT: All received messages are routed to both the main and external
terminal units.
AUTO: The sub address for the DTE port is 001. Received messages
having the sub address of 001 are routed to the DTE terminal.
Messages having a sub address other than 001 are routed to the
main terminal.
21.Press the [Enter] key to close the window.
22.Press the [1] key to choose EGC Output Port.
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23.Press the [Enter] key to open the EGC output port options window.

Setup I
System Setup
System Date & Time 01:53 02-02-25 (YY-MM-DD)
IMN
MES Operation Mode INMARSAT-C
Nav Port OFF
Active Port INT
M essage Output Port INT
EGC Output Port
Network Setup T
—1 Command Window

System setup menu, EGC output port options window
24.Press the [1] or [1] key to choose the terminal unit where to route receive
EGC messages; INT, main terminal; INT+EXT, main and auxiliary terminals.
25.Press the [Enter] key to close the window.
26.Press the [Esc] key to open the update window.

Setup |
System Setup
System Date & Time 01:53 02-02-25 (YY-MM-DD)
IMN
MES Operation Mode INMARSAT-C
Nav Port OFF
Active Port INT Update
Message Output Port INT | ___
EGC Output Port INT | No
See paragraph 2.1.3 Network Setup
Not used. » Command Window

System setup menu, update window

27.Yes is selected; press the [Enter] key to update system settings.
28.Press the [Esc] key to return to the standby display.
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2.2

2-6

Terminal Setup

The Terminal Setup menu provides for selection of date display format, currency
unit, screen saver on/off and window colors.

N

o

10.
11.

12.
13.

. Press the [F8] key to choose the Setup menu.
. Press the [4] key to display the Terminal Setup screen.

Terminal Setup
Date Disp. Form YY-MM-DD
Currency Unit uUss
Screen Saver ON
Window Color

Terminal Setup menu
Date Disp. Form is selected; press the [Enter] key to open its options window.

MMM-DD-YY
DD-MMM-YY

Date options
Press the [1] or [1] key to choose date display format desired and then press
the [Enter] key to close the window.
Press the [1] key to choose Currency Unit.
Press the [Enter] key to open the currency unit options window.

Uss
EUR
YEN
OTHER

Currency unit options

. Pressthe [i1] or [1] key to choose the currency unit to use to calculate toll

charges. SDR means Special Drawing Right and it is the common unit
charge used by all LES to assess toll charges. For OTHER (for currency not
shown in menu) enter currency unit name (4 characters max.). Your selection
appears next to Currency Unit in the Terminal Setup menu.

Press the [Enter] key to close the window.

Press the [1] key to choose Screen Saver.

Press the [Enter] key to open the screen saver options window.

Press the [1] or [1] key to choose “ON” or “OFF” as appropriate. ON to use
screen saver, OFF to disable the screen saver. The screen saver
automatically starts up 10 minutes after there is no key operation. To release
the screen saver, press any key.

Press the [Enter] key to close the window.

Press the [1] key to choose Window Color and press the [Enter] key.

—— Window Color

Window Color Setup
Default Color

Window color change menu



2. SYSTEM INITIALIZATION

14.You may change the background and foreground colors for the various
display screens on the terminal unit as follows:
Choose Window Color Setup and press the [Enter] key.

Window Color Setup

: Base Window
Fore Color :L_WHITE
Back Color : BLUE

To Change: ENTER To Change Value: L<=>R

Window color setup menu

b) Window is selected; use the [—] or [«] key to choose the item to adjust and
then press the [Enter] key.

Base Window: Standby display
RCV Message Display: Receive message display
EGC Message Display: EGC message display
EDIT1 — EDIT 2: Editor screens 1 and 2
Function: Menu
Sub Menul — Sub Menu4: Sub menus 1-4
Message: Status message
EDIT BASE WINDOW

File Edit Transmit |[EGC Reports Logs Options Setup Position| StopAlarm

<[1] UNTITLED1 >

1.
2:
|
MENU +|
|
|
|
|

CAUTION
—4_|7 MESSAGE

Location of items

Press the [1] key to choose Fore Color.
Press the [—] or [«] key to choose foreground color desired and then press the
[Enter] key.

e) Repeat steps b-d to set color for other items.

f) Press the [{] key to choose Back Color. Press the [—] or [«] key to choose
background color desired and then press the [Enter] key.

g) To set colors for other windows repeat steps a-f.

h) Finally press the [Enter] key to show the Update window.

i) Yes is selected; press the [Enter] key.

j) Press the [Esc] key to return to the Terminal Setup menu.
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Note: To restore all default color settings, choose Window Color from the
Terminal Setup menu, choose Default Color, press the [Enter] key, and
then press the [Enter] key again.

15.Press the [Esc] key twice to return to the standby display.

2.3 Login and Logout

Each time the terminal unit is turned on, register your vessel with the Inmarsat C
system to enable communications between your vessel and an LES. This is
called login.

Note that you can transmit the distress alert or receive EGC messages even if
you are not logged in.

If you will not be using the FELCOM 15 for a prolonged period, you should
logout from the Inmarsat C system, before turning off the terminal unit. The
Inmarsat C system will then register you as inactive, notifying anyone trying to
call you that you are currently unavailable. If you do not log out before turning off
the power, some LESs may attempt to send a message to you. They may
charge your correspondent, even if you don’t receive the message.

2.3.1 Login

1. Confirm that “SYNC (NCS)” appears at the bottom of the screen.
2. Press the [F7] key to display the Options menu.

File Edit Transmit EGC Reports  Logs Setup Position  StopAlarm

—— Options
2. Logout
3. Abort
4. Select NCS
5. Ocean Region
6. LES Information
7. Test

Options menu
3. Press the [1] key to display the Login screen.

—— Options —]

Login

Login screen
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Note: The terminal unit must be “idle” to login. (“Current State: IDLE”
appears at the bottom of the screen.) When it is not idle, “Ignored:
MES is not idle.” appears. Press the [Esc] key to return to the standby
display. Wait until the terminal unit becomes idle.

4. Yes is selected; press the [Enter] key to start login.
5. Login begins and the screen should now look something like the illustration
below, with “LOGIN” flashing.

File Edit Transmit EGC  Reports Logs Setup Position StopAlarm

—— Options ]

Login

Starting Login Process.
Press any key to escape.

LOGIN replaces IDLE.

/ Flashing during login
Current State: LOGIN SYNC (NCS) / 02-02-25 02:02 (UTC)
CALLING NCS: IOR LOGIN LAT: 34:30.00N
DCE F15 Ver. ** LON: 135:30.00E

Appearance of display screen during login

When login is completed, the message “Successful Login.” appears. Then,
the terminal unit goes into “Idle” status and LOGIN stops flashing.

6. Press the [Esc] key to return to the standby display.
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2.3.2 Logout

1. Press the [F7] key to display the Options menu.
2. Press the [2] key to display the logout screen.

Note: The terminal unit must be “idle” to logout. When it is not idle, “Ignored:
MES is not idle.” appears. Press the [Esc] key to return to the standby
display. Wait until the terminal unit becomes idle.

File Edit Transmit EGC  Reports Logs Setup Position StopAlarm
Options—I
Logout
Start
Current State: IDLE SYNC (NCS) 02-02-25 02:04 (UTC)
Successful Login. NCS: IOR LOGIN LAT: 34:30.00N
DCE F15 Ver.** LON: 135:30.00E

Options menu, logout screen

3. Yes is selected; press the [Enter] key to start logout. The screen now looks
something like the illustration below.

File Edit Transmit EGC  Reports Logs Setup Position StopAlarm
Options _|
Logout

Starting Logout Process.

Press any key to escape.
Current State: LOGOUT SYNC (NCS) 02-02-25 02:02 (UTC)
CALLING NCS: IOR LOGIN LAT: 34:30.00N
DCE F16 Ver. ** LON: 135:30.00E

Appearance of display screen during logout

4. When logout is completed, “Successful Logout.” appears and “Current State”
changes from LOGOUT to IDLE. Then, turn off the FELCOM 15.
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2.4
2.4.1
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EGC Settings
What is the EGC (Enhanced Group Call) service?

The EGC service enables EGC information providers to send SafetyNET™,
FleetNET™ and System messages via an LES to a specific groups of ships, or

to

all ships within a defined geographical area.

Each type of EGC service is sent as follows:

1)

2)

3)

The information provider prepares the message, and then accesses the
appropriate Country of the international telex network to send the message
to an LES.

The LES processes and forwards it to the NCS for the ocean region
designated by the provider.

Then, the NCS broadcasts the message throughout the ocean region. (The
operator may choose the EGC messages to receive by position (one
position) and geographical position (nine areas). For further details see
paragraph 2.4.2.)

. . NCS common channel
Information Provider chi
* Meteorological body —> LES1
* Navtex station MES
* Coast guard ch?
* Rescue center —> LES2 MES
* Shipping company,
etc.
—>| LES3 chs YyYy MES

NCS

Ch1-Ch3 are dedicated
channels for each LES.

The EGC system

Three EGC services are available:

1)

SafetyNET™

This provides a means for information providers to distribute Maritime Safety
Information (MSI) from shore-to-ship. Authorized information providers
include:

a) Hydrographic Offices, for navigational warnings

b) National Weather Services, for meteorological warnings and forecasts

c) Rescue Co-ordination Center, for shore-to-ship distress alerts and other
urgent information

d) International Ice Patrol, for North Atlantic ice hazards
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2) FleetNET™

3)

This service allows authorized information providers such as commercial
subscription services, shipping companies and governments, which have
registered with a LES that supports FleetNET™, to broadcast messages to
selected group of MESs. Typical applications of FleetNET™™ are

a) Fleet or company broadcasts

b) News broadcasts

c) Commercial weather services

d) Market quotations

e) Government broadcasts to all vessels on a country’s registration

System
EGC system-related is sent by Inmarsat to certain ship groups and
geographical areas.



2.4.2

2. SYSTEM INITIALIZATION

EGC setup

The FELCOM 15 receives EGC messages directed to its present position and
Navarea without further programming. The EGC Setup screen lets you choose
additional areas for which to receive messages and also the Navtex station and
type of message for Coastal Warning (NAVTEX Re-broadcast).

1. Press the [F8] key to display the Setup menu.

File Edit Transmit EGC Reports Logs Options Position  StopAlarm

Setup
1. Distress Alert Setup

2. System Setup

3. Editor Setup

4. Terminal Setup
5. EGC Setup

6. Auto Mode Setup
7. E-Mail Setup

8. Directories

9. Configuration

Setup menu
2. Press the [5] key to display the EGC Setup menu.

Setup
EGC Setup
Receive EGC Area
Navarea T SO TE e
Fixed Arem e

Waypoaint (from NAV Equipment)  OFF

NAVTEX
Station Code
Type of Message (Can't reject other report)
Ice reports OFF OMEGA messages  OFF
Meteo. forecasts  OFF SATNAV messages OFF
Pilot service OFF Other navaid msg OFF
DECCA messages OFF QRU (nomessage)  OFF

LORAN messages OFF

EGC setup menu
3. The cursor is selecting Additional Position, where you can enter the L/L
position of an ocean region you want to receive broadcasts about. Press the
[Enter] key to open the additional position entry window.
4. Enter position as follows:
a) Enter latitude (XX° XXX).
b) Press the [N] or [S] key as appropriate to enter coordinate.
c) Enter longitude (XXX° XXX).
d) Press the [E] or [W] key as appropriate enter coordinate.
5. Press the [Enter] key to close the additional position entry window.
6. Press the [1] key to choose Navarea.
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7. Press the [Enter] key to open the navarea entry window.

Setup

Receive EGC Area
Additional Position
Navarea
Fixed Area

NAVTEX
Station Code

Ice reports

Meteo. forecasts
Pilot service
DECCA messages
LORAN messages

OFF
OFF
OFF
OFF
OFF

EGC Setup

Waypoint (from NAV Equipment)  OFF

- Type of Message (Can't rgject other report)

OMEGA messages
SATNAYV messages
Other navaid msg
QRU (no message)

OFF
OFF
OFF
OFF

EGC setup menu, Navarea entry window

8. Enter additional Navarea(s) (I-XVI, up to nine) in two digits, referring to the
illustration below for code number.

Xiv
New Zealand

—60°

VI - N s
South Africa =

Note: “Fixed Area” is where you enter fixed areas (max. 3) for chart

Navareas
9. Press the [Enter] key to close the navarea entry window.

Auvstralia

¥

od

Xiv.
New Zea]

A

o

land

60°

correction service. However, this service is not yet available; enter no

data.

10. Press the [I ] key to choose Waypoint.

2-14



2. SYSTEM INITIALIZATION

11. Press the [Enter] key to open the waypoint options window.

| Setup I
EGC Setup
Receive EGC Area
Additional Position B
Navarea T
Fixed Area P T
---------------------- OFF | ----=-=-------
NAVTEX
Station Code
Type of Message (Can't reject other report)
| ce reports OFF OMEGA messages  OFF
Meteo. forecasts ~ OFF SATNAYV messages OFF
Pilot service OFF Other navaid msg OFF
DECCA messages OFF QRU (nomessage)  OFF
LORAN messages OFF

EGC setup menu, waypoint options window
12.Choose ON to receive broadcasts for the area which contains the destination
waypoint set on the navigator.
13.Press the [Enter] key to close the waypoint options window.
14.Press the [1] key to choose Station Code.
15.Press the [Enter] key to open the station code entry window.

Setup I

Receive EGC Area
Additional Position e
Navarea e e o o e o o o -
FixedArea e
Waypoint (from NAV Equipment)  OFF

NAVTEX
|
Type of M (ATt TE[ECt UUTEr TEPOIT)
Ice reports OFF OMEGA messages  OFF
Meteo. forecasts  OFF SATNAV messages OFF
Pilot service OFF Other navaid msg OFF
DECCA messages OFF QRU (nomessage)  OFF

LORAN messages OFF

EGC setup menu, station code entry window

16.Enter the navtex station code (A-Z) of the navarea, in upper case alphabet.
For details about navtex stations, consult the operator’s manual of the navtex
receiver.

17.Press the [Enter] key to close the station code entry window.

18.Choose message type to receive: Use the arrow keys to choose message
type, press the [Enter] key, choose ON or OFF as appropriate, and press the
[Enter] key.

Note: Navtex messages “Coastal navigational information”, “Meteorological
warning” and “Search and rescue alert” (they do not appear on the
EGC Setup menu) must always be received.
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19.Press the [Esc] key to open the update window.

Receive EGC Area
Additional Position )
Navarea e e e oo e o o
FixedArema o
Waypoaint (from NAV Equipment)  OFF

NAVTEX
Station Code
Type of Message (Can't reject other report)
| ce reports OFF OMEGA messag
Meteo. forecasts ~ OFF SATNAV m Update
Pilot service OFF Other navaidmsg|- - - - - - - - -
DECCA messages OFF QRU (no messag I No

LORAN messages OFF

EGC setup menu, update window
20.Yes is selected; press the [Enter] key to update EGC settings.
21.Press the [Esc] key to return to the standby display.

2.4.3 Adding EGC channels

The EGC Channel List stores EGC channels. There are currently four EGC
channels, one for each satellite. These four channels are pre-programmed into
the unit and marked in the EGC Channel List with asterisks. When more EGC
channels become available you can add them to the list as below.

1. Press the [F8] key to display the Setup menu.
2. Press the [9] key to display the Configuration menu.
3. Press the [3] key to display the EGC Channel List.

File Edit Transmit EGC Reports Logs Options Position  StopAlarm

Setup
Configuration |
EGC Channel List
ENTER: Set ESC: Quit

EEIER | 12580 | 10840 | 11088
| | |

EGC channel list

4. Using the arrow keys, place the cursor where there is no data entered.
Current EGC channels are marked with an asterisk. These channels cannot
be changed.
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5. Press the [Enter] key to open the EGC channel list entry screen.

Setup |
Configuration
EGC Channel List

ENTER: Set ESC: Quit
————— e
11080*  12580* | 10840* | 11088*

EGC channel list entry screen

6. Enter EGC channel frequency code. The EGC channel frequency code range
is 6000-14000.

Press the [Enter] key to close the text window.
8. Press the [Esc] key to open the update window.

Setup
Configuration
EGC Channel List

ENTER: Set ESC: Quit
----- i

11080* | 12580* 1NRAN* | 11NRK[kx

~

|
: : Update
| | e e
\:3 | No
| eS|

EGC channel list, update window
9. Yes is selected; press the [Enter] key to register input.
Note: If the EGC channel frequency code entered is invalid, the message
"Input Error: Channel No." appears. Clear the error message by

pressing the [Esc] key. Place the cursor at the invalid frequency, press
the [Enter] key and enter correct frequency.

10.Press the [Esc] key twice to return to the standby display.

2-17



2. SYSTEM INITIALIZATION

2.4.4 Saving, printing EGC messages automatically

You may save and print EGC messages automatically as below.

Automatically saving EGC messages

1. Press the [F8] key to display the Setup menu.
2. Press the [6] key to display the Auto Mode Setup menu.

Auto Mode Setup
Auto Log Print OFF
Receive Alarm OFF

Auto Receive Message Save OFF
Auto Receive Message Print OFF
Data Report & Polling Print OFF
Auto EGC Message Save
Auto EGC Message Print

Auto mode setup menu

3. Pressthe [1] or [1] key to choose Auto EGC Message Save and then press
the [Enter] key.

Auto Mode Setup
Auto EGC Message Save
OFF
FleetNET OFF
SafetyNET (Routine) OFF
SafetyNET (Safety) OFF
SafetyNET (Urgent & Distress) ON

Auto EGC message save menu

4. Pressthe [1]or[1] key to choose message type and then press the [Enter]
key.

5. Choose ON or OFF as appropriate and press the [Enter] key to close the
window.

Note: When SafetyNET (Safety) is turned off, SafetyNET (Safety) on the
Auto EGC Message Print menu is automatically turned on.

6. Press the [Esc] key three times to return to the standby display.
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Automatically printing EGC messages

You can turn on/off automatic printing of FleetNET™, SafetyNET™ (Routine) and
SafetyNET™ (Safety) messages. Distress and emergency SafetyNET™ (Safety)
messages are automatically printed regardless of printing setting.

1.
2.
3.

Press the [F8] key to display the Setup menu.

Press the [6] key to display the Auto mode setup menu.

Press the [1] key to choose Auto EGC Message Print and then press the
[Enter] key.

Auto Mode Setup
Auto EGC Message Print
OFF
FleetNET OFF
SafetyNET (Routine) OFF
SafetyNET (Safety) OFF

Auto EGC message print menu
Press the [1] or [1] key to choose message type and then press the [Enter]
key.
Choose ON or OFF as appropriate and press the [Enter] key to close the
window.
Note: When SafetyNET (Safety) is turned off, SafetyNET (Safety) on the
Auto EGC Message Save menu is automatically turned on.

Press the [Esc] key three times to return to the standby display.
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2.5 Adding NCS Channels

This section shows you how to add NCS channels to the NCS Channel List. 19
channels can be listed per each ocean region. Currently, there are four NCS
channels, and they are marked with asterisks in the list. Add NCS channels to
the list as below when they become operational.

1. Press the [F8] key to display the Setup menu.

2. Press the [9] key to display the Configuration menu.

3. Press the [4] key to display the NCS Channel List.

7.
8.

9.

Setup
Configuration

NCS Channdl List

IID

0210
0310
0410
0510
0610
0710
0810

_____________________ +_________
No | AOR (WEST) 1 AOR (EAST) | POR
FREQ | ID FREQ I ID  FREQ
_____________________ +_________
oL | [ | 11080 124 1 12580% | 244 | 12580°
1o 12 1
|1 | | 2 |
1 12 1
|1 | | 2 |
1 12 1
11 12 1
11 12 1

IOR
1D FREQ
344 | 10840*

Press the [Enter] key to open the data entry window.

NCS channel list
Use the arrow keys to place the cursor in a blank ID column.

Enter NCS channel ID number, in two digits (leading zero is not necessary).
The ID number range is 45-63.

Press the [Enter] key to close the window.
With the [ -] key, choose the frequency column.
Press the [Enter] key to open the frequency entry window.
10.Enter NCS channel frequency code. The frequency code range is

6000-14000.

11. Press the [Enter] key to close the window.
12.Press the [Esc] key to open the update window.
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Setup
Configuration

NCS Channel List

I 1D

o
a1
[eNeNelNoNeNoNo)

___| __________________
No | AOR (WEST) | AOR (EAST)
FREQ | ID FREQ I ID
0L | 044 | 11080% | 144 | 12580 | 244
1 2
|1 | 2
11 | 2
|1 | 2
|1 | 2
11 2
|1 | 2

ENTER: Set ESC: Quit

| 12580*
I

+ I
| |
| |
e B Fmmmmm - — - - -
| |
| |
| |
|
|
|
|
|

NCS channel list, update window
13.Yes is selected; press the [Enter] key to register input.
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Note: If the ID or frequency entered is invalid the message "Input Error:
NCS ID" (for invalid ID) or "Input Error: Channel No." (for invalid
frequency) appears. Clear the error message by pressing the [Esc]
key. Place the cursor at the invalid ID or frequency code. Then, press
the [Enter] key and enter correct ID or frequency.

14.Press the [Esc] key twice to return to the standby display.
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2.6

2.6.1

2-22

LES List

The LES List provides for storage of 44 LES names per ocean region. By
entering approximate toll charges in the LES list, you can see that information on
the Transmit message menu.

Displaying toll charges

Main LESs (LES name and ID) are already registered; but, toll charges are not.
To display toll charges when transmitting do the following:

1. Press the [F8] key to display the Setup menu.

File Edit Transmit EGC  Reports Logs Options Position StopAlarm

Setup

1. DistressAlert Setup

2. System Setup

3. Editor Setup

4. Terminal Setup
5. EGC Setup

6. Auto Mode Setup
7. E-Mail Setup

8. Directories

9. Configuration

Setup menu
2. Press the [9] key to display the Configuration menu.

Setup |
Configuration

2. LESList

3. EGC Channdl List

4. NCS Channel List

5. E-Mail/ SMS Service List
6. Save/Load

O. DITECIOITES

9. Configuration

Configuration menu
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3. Press the [2] key to display the LES List.

LESList
B S B R e
No | AOR(WEST) | AOR(EAST) | POR
| Name | Name | Name
el B R - - m - - -
01 I I Telenor SS.Inc | Telenor S.S.Inc
02 | StratosM.N | Stratos M.N. | Stratos M.N
03 | KDDI | KDDI | KDDI
| 04 1 Telenor SSAS | Telenor SSAS |
05 | | Telecom Itaia |
06 | | |
07 1 | |
08 | | | Korea Telecom

Ctrl+P: Print ENTER: List Entry ESC: Quit

Stratos M.N.
KDDI

Telenor SSAS
OTE

VSNL

Korea Telecom

LES list

4. Using the arrow keys, choose the LES for which you want to enter toll

charges. For example, choose KDDI in IOR.
5. Press the [Enter] key.

Setup |
Configuration —
LESList
Ctrl+P: Print ENTER: List Entry ESC: Quit
———————————— e e B el el e
AOR(WEST) | AOR(EAST) | POR [ IOR
Name I Name I Name I Name
———————————— e B e S i
Telenor S.S.INC e — et —
Stratos M.N. Name g | StratosM.N.
KDDI ID +005 J < DD
Telenor SSAS Remarks , | Telenor SSNS
Charge (US$/256hit) | OTE
TELEX *****.** | VSNL
FAX *****.** |
E-Mail x> | KoreaTelecom
SMS *****.**
PSDN *****.**
X4OO *****.**
DNID *****.**
SPEC *****'**
Erase the Name to delete this LES.

LES list, LES data entry window

6. Press the [{] key to choose TELEX and press the [Enter] key to open the text

entry window.

7. Enter telex charges (per 256 bit) and press the [Enter] key.

Enter the toll charges assigned by LES.
8. Enter toll charges for other items similarly.
9. Press the [Esc] key to return to the LES list.
10.Press the [Esc] key three times to return to the standby

display.
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2.6.2 Registering LES to LES list

Follow the procedure below to register a newly constructed LES. For LES ID see
the Appendix.

1. Press the [F8], [9] and [2] keys to show the LES list.
2. Use the arrow keys to place the cursor where desired. For example, choose
005 in the AOR(WEST) column.

Setup |
Configuration —
LESList
Ctrl+P; Print ENTER: List entry ESC: Quit
———————————— R e B il eI
AOR(WEST) | AOR(EAST) | POR I IOR
Name | Name | Name | Name
——————————————— e it B
01 | Telenor SSiInc | Telenor S.S.Inc | Telenor S.S.Inc |
02 | StratosM.N | Stratos M.N. | Stratos M.N | Stratos M.N.
|| 03 1 KDDI | KDDI | KDDI | KDDI
04 | Telenor SSAS | Telenor SSAS | | Telenor SSAS
o5 | I ' "eecom itdia | | OTE
06 | | | | VSNL
07 | | | |
08 | | | Korea Telecom | Korea Telecom
[
Place cursor here.
LES ID: XXX

|: No. (00-43)

0: AOR(WEST)
1: AOR(EAST)
2: POR
3: 10R

Configuration menu
3. Press the [Enter] key.

Setup
Configuration -
LESList
Ctrl+P: Print ENTER: List Entry ESC: Quit
———————————— e B e e it
AOR(WEST) | AOR(EAST) | POR [ IOR
Name | Name | Name | Name
———————————— R e Tttt S
Telenor S.S.INC g — = oo
Stratos M.N. | Stratos M.N.
KDDI ID +005 J < DD
Telenor S.SAS Remarks _ | Telenor SS.NS
Charge (US$/256bhit) | OTE
TELEX *****.** | VSNL
FAX *****.** |
E-Mai| oo xx | Korea Telecom
SMS *****.**

PgDN *****.**
X4OO *****.**
DNID *****.**
SPEC *****.**

Erase the Name to delete this LES.

LES list options
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4. Name is selected; press the [Enter] key to open the text entry window.

© o ~NOo O

Name :

ID l
Remarks :
Charge (US$H/256hit)
TELEX *****-**
FAX *****'**
E_Mall *****-**
S'\/IS *****'**
PSDN *****-**
x400 *****'**
DNID *****-**
SPEC *****'**

Erase the Name to delete this LES.

LES list, text entry window
Enter LES name (maximum 15 characters).
Press the [Enter] key.
Press the [{] key to choose Remarks.
Press the [Enter] key.
Enter remarks (up to 20 characters).

10.Press the [Enter] key.

11. Press the [{] key to choose TELEX and press the [Enter] key.
12.Enter TELEX toll charges (per 256 bit) and press the [Enter] key.
13.Enter toll charges for other items similarly.

14.Press the [Esc] key to return to the LES list.

15.Repeat steps 2-14 to enter another LES.

16.Press the [Esc] key three times to return to the standby display.

Editing the LES list

1.
2.
3.
4. Do the following:

Press the [F8], [9] and [2] keys to shown the LES list.
Use the arrow keys to choose the LES you want to edit.
Press the [Enter] key.

Change station name: Press the [{] or [1] key to choose Name and then
press the [Enter] key. Press the [Backspace] key to erase name and then
enter new name. Press the [Enter] key.

Delete station: Press the [{] or [T] key to choose Name and then press the
[Enter] key. Press the [Backspace] key to erase name and then press the
[Enter] key.

Press the [Esc] key to quit.

Press the [Esc] key three times to return to the standby display.
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2.6.4

2-26

Printing the LES list

1. Press [F8], [9] and [2] to display the LES list.
2. To print the LES list, press the [P] key while pressing the [Ctrl] key.

LES List ( Printed at 02-02-25 02:33)

+++++ AOR (WEST) ++++

No. Name LESID Remarks

01 Telenor SS.Inc 001 USA

02 Stratos M.N. 002 CANADA

03 KDDI 003 JAPAN

04 Telenor SS.AS 004 NORWAY
12 Xantic (NED) 012 NETHERLANDS
21  France Telecom 021 FRANCE

22 Xantic (AUS) 022 AUSTRALIA
+++++ AOR (EAST) +++++

No. Name LESID Remarks

01 Telenor SS.Inc 101 USA

Sample LES list printout
3. To return to the standby display, press the [Esc] key three times.
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Station List

Adding stations to the station list

The FELCOM 15 provides an “address book” for storing 99 station 1Ds. Enter
station IDs as below.

1. Press the [F8] key to display the Setup menu.
2. Press the [9] key to display the Configuration menu.
3. Press the [1] key to display the Station List.

File Edit Transmit EGC Reports Logs Options Position  StopAlarm

Setup |

Configuration —|

Station List

Group StationName  Type  Code D / Address
abc@ furuno.co.jp
02 Xyz E-Mall  xyz@ furuno.co.p
03 Seagull TELEX 584 463609999
04
05
L_| 06
07
08
Page Up, Page Down: Move Ctrl+P: Print
Sort (Ctrl+G: Group, Ctrl+N: Station Name, Ctrl+T: Type)

Sample station list

Note: You may sort the list by group name, station name or communication
type as follows:
Group name: Each press of [Ctrl] + [G] sorts the list by group name,
ascending or descending order.
Station name: Each press of [Ctrl]] + [N] sorts the list by station name,
in ascending or descending order.
Comm. type: Each press of [Ctrl] + [T] sorts the list by communication
type, in ascending or descending order.

4. Press the [{] key to place the cursor on a blank line.
5. Press the [Enter] key.

Station Name

Destination Type TELEX
Prefix Code

Country Code

Station ID

Modem Type

Address

Remarks

Erase the Name to delete this station.

Station list items
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2-28

6
7.
8
9.

. Press the [Enter] key to open the station group entry window.

Enter station group name, using up to five characters.

. Press the [Enter] key to close the window.

Press the [|] key to choose Station Name.

10.Press the [Enter] key to open the station name entry window.
11. Enter station name, using up to 15 characters.

12.Press the [Enter] key to close the window.

13.Press the [|] key to choose Destination Type.

14.Press the [Enter] key to open the destination type window.

TELEX

FAX
E-Mail
SMS
PSDN
X400
DNID
SPEC
TELEX (Prefixed)
FAX  (Prefixed)
PSDN  (Prefixed)
X400  (Prefixed)
DNID  (Prefixed)
SPEC  (Prefixed)

Destination (communication) type options

TELEX: Telex communication

FAX:  Facsimile service

E-Mail: E-mail (electronic mail) Service
SMS: Short Message Service

PSDN: Packet Switched Data Network
- to an office computer via a data network using X.25 standard.

X400: For future use
DNID: Data Network ID. Not used.

SPEC: Ship-to shore requests for safety service, accessed by using special
2-digit codes

15. Press the [{] or [T] key to choose destination type desired.
16. Press the [Enter] key to close the window. Follow appropriate procedure on

the next several pages.

Procedure for Telex

1.
2.
3.

Press the [{] key to choose Country Code.

Press the [Enter] key.

For ship-to-shore telex, enter international telex country code; ship-to-ship
telex, enter ocean region. A list of international telex country codes appears
in the Appendix.

Ocean Region

AOR-East: 581 POR: 582

IOR: 583 AOR-West: 584
Press the [Enter] key.
Press the [{] key to choose Station ID.
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6. Press the [Enter] key to open the station ID entry window.

7. Enter telex subscriber number (for ship-to-shore) or MES Inmarsat Mobile
Number (for ship-to-ship). Up to 15 characters, including space, can be
entered.

8. Press the [Enter] key to close the window.

9. Press the [{] key to choose Remarks.

10.Press [Enter] to open the remarks entry window.

11. Enter remarks, using up to 20 characters.

12.Press the [Enter] key to close the window.

13.Press the [Esc] key to return to the station list.

14. To enter another “telex” station, repeat the procedure from step 4 on page
2-27.

15. Press the [Esc] key three times to return to the standby display.

Procedure for FAX

1. Press the [{] key to choose Country Code.

2. Press the [Enter] key to open the country code entry window.

3. Enter international telephone code of subscriber. See the Appendix for list of
telephone codes.

4. Press the [Enter] key to close the window.

5. Press the [{] key to Station ID.

6. Press the [Enter] key to open the station ID entry window.

7. Enter fax number.

8. Press the [Enter] key to close the window.

9. Press the [{] key to choose Modem Type.

10. Press the [Enter] key to open the modem type options window.

Modem Type

T30 FAX

V21 V.21 300bps Duplex
V22 V.22 1200bps Duplex
V22B  V.22bis 2400bps Duplex
V23 V.23 600/1200bps
V26B  V.26bis 2400/1200bps
V26T V.26ter 2400bps Duplex
V27T V.27ter  4800/2400bps
V32 V.32 9600bps Duplex
Other

Modem type options window

11. Press the [{] or [1] key to choose mode type of subscriber. For a landline fax
or a fax-equipped Inmarsat B MES, choose “T30 FAX.”

12. Press the [Enter] key to close the window.

13. Press the [{] to choose Remarks.

14. Press the [Enter] key.

15. Enter remarks, using up to 20 characters.

16. Press the [Enter] key to close the window.

17. Press the [Esc] key to return to the station list.

18. To enter another “FAX” station, repeat the procedure from step 4 on page
2-27.

19. Press the [Esc] key three times to return to the standby display.
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2.7.2

2-30

Procedure for E-mail

Press the [{] key to choose Address.

Press the [Enter] key to open the e-mail address entry window.

Enter recipient’s e-mail address.

Press the [Enter] key to close the window.

Press the [{] to choose Remarks.

Press the [Enter] key.

Enter remarks, using up to 20 characters.

Press the [Enter] key to close the window.

Press the [Esc] key to return to the station list.

10 To enter another “E-mail” station, repeat the procedure from step 4 on page
2-27.

12. Press the [Esc] key three times to return to the standby display.

©oNoOhAWDE

Procedure for SMS

Press the [{] key to choose Address.

Press the [Enter] key to open the e-mail address entry window.

Enter recipient’s mobile phone number, beginning with country code.

Press the [Enter] key to close the window.

Press the [{] to choose Remarks.

Press the [Enter] key.

Enter remarks, using up to 20 characters.

Press the [Enter] key to close the window.

Press the [Esc] key to return to the station list.

10 To enter another SMS recipient, repeat the procedure from step 4 on page
2-27.

11. Press the [Esc] key three times to return to the standby display.

©C®NOOE®WNER

Editing the station list
1. Press [F8], [9] and [1] to display the Station List.

File Edit Transmit EGC Reports Logs Options RS=illdl Position StopAlarm

Setup |
Configuration S
Station List
Group StationName  Type  Code D / Address
abc@ furuno.co.jp
02 Xyz E-Mal xyz@ turuno.co.Jp
03 Seagull TELEX 584 463609999
04
05
L—| 06
07
08
Page Up, Page Down: Move Ctrl+P: Print
Sort (Ctrl+G: Group, Ctrl+N: Station Name, Ctrl+T: Type)
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Station list

Note: You may sort the list by group name, station name or communication
type as follows:
Group name: Each press of [Ctrl] + [G] sorts the list by group name,
ascending or descending order.
Station name: Each press of [Ctr]] + [N] sorts the list by station name,
in ascending or descending order.
Comm. type: Each press of [Ctrl] + [T] sorts the list by communication
type, in ascending or descending order.

2. Press the [{] or [1] key to choose a station and then press the [Enter] key.
3. Do one of the following:

Change station name: Press the [{] or [1] key to choose Station Name and
then press the [Enter] key. Press the [Backspace] key to erase station name
and then enter new data. Press the [Enter] key.

Delete station: Press the [{] or [T] key to choose Station Name and then
press the [Enter] key. Press the [Backspace] key to erase station name and
then press the [Enter] key.

4. Press the [Esc] key to save changes.
5. Press the [Esc] key three times to return to the standby display.

2.7.3 Printing the station list

1. Press [F8], [9] and [1] to display the Station List.
2. While pressing and holding down the [Ctrl] key, press the [P] key to print.

Station List ( Printed at 02-02-25 02:38)

No. Group Name Type  Dest, ID, Modem / Address Remarks
01 x1 abc E-Mall abc@ furuno.co.jp
02 x2 Xyz E-Mall xyz@ furuno.co.jp

03 x3 Seagull TELEX 584 463609999

-\ 5\~ Station Name M Subscriber's Number
Group Name

Country Code

Sample station list printout
3. Press the [Esc] key three times to return to the standby display.
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2.8

2-32

Entering Own Ship’s Position

When there is no navigation data or Nav Port in the System Setup menu is set
for OFF, enter ship’s position manually as follows:

1.

o~

Press the [F9] key to display the Position menu.

File Edit Transmit EGC  Reports Logs Options Setup StopAlarm

Ship Position
34:30.00N

LON 135:30.00E

Ship position window
Press the [Enter] key to open the latitude entry window.

Ship Position
E4:30.00N
LON

Latitude entry window
Enter latitude (XX° XX.XX) and then press the [N] or [S] key as appropriate to
enter coordinate.
Press the [Enter] key to close the window.
Press the [1] key to choose LON.
Press the [Enter] key to open the longitude entry window.

Ship Position

LAT
035:30.00E

Longitude entry window

. Enter longitude (XXX° XX.XX) and then press the [E] or [W] key as

appropriate to enter coordinate.
Press the [Enter] key to close the window.
Press the [Esc] key to open the update window.

File Edit Transmit EGC  Reports Logs Options Setup StopAlarm

Ship Position
LAT 34:50.00N
L Update 00E

Ship position, update

10.Yes is selected; press the [Enter] key to update position and close the Ship

Position menu. The position entered appears at the bottom right corner of the
system status monitor screen. It is also entered on “Update Distress Alert”
screen (see Chapter 6).
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Creating a Directory

You can create and specify the directory where to save incoming and outgoing
messages to a floppy disk. If no directory is made, the messages are saved to
the root directory of the floppy disk.

2. SYSTEM INITIALIZATION

Creating a directory where to store messages

The procedure below shows how to create a directory on a floppy disk.

wn =

N

Insert a floppy disk in the disk drive.
Press the [F8] key to display the Setup menu.
Press the [8] key to display the Directories menu.

Directories

EGC Message Directory

Message Directory

Directories menu

. Press the [T] key to choose Message Directory and then press the [Enter]

File Edit Transmit EGC Reports Logs Options

[A:\ ]
- - Filename - - - Size - - - Date & Time - - - - - -

0 Files exist 1456640 bytes free

To View: SPACE Make Dir: INS  Remove Dir: DEL

Setup Position StopAlarm

Setup menu, message directory

5. Press the [Ins] key.

’, Make Directory
I

Directory name entry window
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6. Enter directory name and press the [Enter] key. Entered name appears.

— Root directory(]
(Top of floppy disk hierarchy)

Setup .
Message Directory
[A:\ABC\. ]
- - Filename - - - Size - - - Date & Time - - - - - -

<DIR>  2002-02-28 20:54
<DIR>  2002-02-15 02:13

Directory name

Message directory

Note 1: To create a directory within a directory (at step 6), repeat steps 5
and 6.
Note 2: To return to the root directory, place the cursor on [. .] and press the
[Enter] key.
7. Press the [1] key.
8. When the floppy disk drive lamp goes off, press the [Esc] key to show the
update window.
9. Yes is selected; press the [Enter] key.
10. Press the [Esc] key twice to return to the standby display. Then, received
messages (transmitted messages) are saved to the directory created above.

Note 1: To remove a directory, do steps 1-4 in the above procedure, choose the
directory to remove and then press the [Del] key.

Note 2: A directory for EGC messages can also be made as above. In this case
choose EGC Message Directory at step 4.
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Specifying directory where to store messages

You may specify the directory where to store messages on a floppy disk as

follows:
1. Press the [F8] and [8] keys to show the Directories menu.
2. Press the [1] key to choose Message Directory and press the [Enter] key.
— Root directory

(Top of floppy disk hierarchy)O

5 Setup Message Directory

[A:\ ABC\.

- - Filename - - - Size - - - Date& Time - - - - - -

O <DIR>  2002-02-28 20:54

0oo <DIR>  2002-02-15 02:13

Message directory
3. Press the [1] key to place the cursor on [ee].
4. Press the [Enter] key. Root directory is displayed.
5. Pressthe [1] or [1] key to choose a directory.
6. Press the [Enter] key.
7. Press the [1] key to place the cursor on the top line ([A: ]). The floppy disk
drive lamp lights.
8. When the floppy disk drive lamp goes off, press the [Esc] key to show the
update window.

9. Yes is selected; press the [Enter] key.

10. Press the [Esc] key twice to return to the standby display.

Note: The directory where to store EGC messages can also be created. In this

case choose EGC Message Directory at step 2.
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2.10 E-mail Service/SMS Station List

E-mail service providers and SMS stations are already registered in the
FELCOM 15. To add new e-mail service providers or SMS stations, follow the
procedure below.

1. Press the [F8] key to display the Setup menu.

2. Press the [9] key to display the Configuration menu.
Setup |

Configuration

2. LESList

3. EGC Channel List

4, NCS Channdl List

5. E-Mail/SMS Service List
6. Save/Load

O. DITECIOITES

9. Configuration

Setup menu, configuration
3. Press the [5] key to display the E-Mail/SMSService List.
Setup

Configuration ——
E-Mail/SMS Service List

| | | |

1: LES Name IAORW!AORE |POR |IOR
| T T T | -

02 | Xantic (NED) | 012 (112 (212 | 312
Ll 03 | StratosM.N. loo2 [102 |202 |302
g 04 | Telenor SSAS ! 004 |104 | I 304
d 05 | KDDI | 003 [103 |203 |303
L]l o6 | SingaporeT. | I 210 |328
07 | France Telecom l'321 321 321 321
08 | Xantic (AUS) i 322 5322 5322 322

| |

Setup menu, E-Mail/SMS service list
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4. Press the [{] to choose a blank line in the Station Name column and then
press the [Enter] key.

Service ID (E-Mal)
(SM9)
LES ID(AORW)
(AORE)
(POR)
(IOR)

To:

Cc:

Subject:

Separalor OFF

Attach File(MIME)

Enter data for LES which offers e-mail services. For
details contact LES directly.

Example
Enter data of the KDDI LES as follows:

Service LES Name KDDI
Service ID (E-Mail) 28

Service ID (SMS) 66

LES ID (AORW) 004
(AORE) 104
(POR) 204
(IOR) 304

To: To:

Cc: CC:

Subject: Subject:

Separator: Blank

SMS: Blank

Attach File(MIME) ~ ON(UUENCODE)
5. Press the [Enter] key to open the service LES name entry window.

Service LES Name |I |

Service ID (E-Mail)
Service ID (SMS)
LES ID(AORW)

Separator: OFF
Attach File(MIME)

Service station list, service station name entry window

Type in LES which provides e-mail service.

Press the [Enter] key to close the window.

Press the [{] key to choose Service ID (E-Mail).

Press the [Enter] key to open the service ID entry window.
10 Enter E-mail Service ID (Special Access) Code.

11. Press the [Enter] key to close the window.

12.Press the [{] key to choose Service ID (SMS).

13.Press the [Enter] key to open the Service ID (SMS) entry window.
14.Enter SMS Service ID (Special Access Code)

15.Press the [Enter] key to close the window.

16.Press the [{] key to choose LES ID.

17.Press the [Enter] key to open the LES ID entry window.
18.Enter ID of AOR-W.

19.Press the [Enter] key to close the window.

20.Repeat steps 17-19 to enter AOR-East, POR and IOR.

© 0o ~NOo
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21.Press the [{] key to choose “To:.”

22.Press the [Enter] key to open the “to” header entry window.

23.Type appropriate “To” header (for example, TO:, to+, etc.).

24.Press the [Enter] key to close the “to” header entry window.
25.Press the [{] key to choose “Cc:.”

26.Press the [Enter] key to open the “Cc” header entry window.

27.Type appropriate “Cc” header (for example, CC:, cc+, etc.).

28.Press the [Enter] key to close the “Cc” header entry window.
29.Press the [{] key to choose “Subject:.”

30.Press the [Enter] key to open the subject entry window.

31.Type appropriate Subject header (for example, Subject:, subject+, etc.).

32.Press the [Enter] key to close the window.

33.Press the [{] key to choose “Separator.”

34.Press the [Enter] key to open the separator entry window.

35.Type appropriate Separator (for example, blank space, STX:, etc.).

36.Press the [Enter] key to close the window.

37. Press the [{] key to choose SMS.

38. Press the [Enter] key to open the SMS window.

39. If it is necessary to enter special Prefix “sms+” before telephone number,
enter the keyword now. For example, for Singapore Telecom enter
sms+8190123456789.

40. Press the [Enter] key to close the window.

41. Press the [{] key to choose “Attach File (MIME).”

42.Press the [Enter] key to open the Attach File (MIME) window.

43.Choose ON(BASE64), ON(UUENCODE) or OFF as appropriate.
BASEG64: General text converter
UUENCODE: UNIX text converter

44.Press the [Enter] key to close the window.

45.Press the [Esc] key four times to return to the standby display.
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2.11 E-mail Setup

Choose the LES where to forward e-mail. Also, you may need to register with an
LES which provides e-mail services.

1. Press the [F8] key to display the Setup menu.
2. Press the [7] key to choose E-mail Setup.

— Setu —
P E-Mail Setup

| | | |
LES Name IAORW|AORE [POR |IOR
__________________________ i e N E—

01 Telnor S.S.Inc

6. Auto Mode Setup

7. E-Mail Setup
8. Directories
9. Configuration

E-mail setup
3. Press the [Enter] key to open the e-mail station list.

E-Mail Setup

| | | |
LES Name IAORW|AORE |POR |IOR
T T

T |
01 Telenor S.S.Inc 001 101 201 321
012 112 1212 312

02 Xantic (NED)
002 |102 |202 |302

03 Stratos M.N.
04 Telenor SSAS 004 {104 {204 | 304

05 KDDI 003 1103 {203 | 303
06 Singapore T. l 1210 | 328
07 France Telecom 321|321 {321 321

08 | Xantic (AUS) 322 i322 i322 1322
] I

E-mail station list

4. Press the [{] or [T] key to choose the LES where e-mail is to be sent.
5. Press the [Enter] key.
6. Press the [Esc] key twice to return to the standby display.
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2.12.2
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Saving, Loading System Settings

You can save system settings to a floppy disk and load them into the terminal
unit. This is useful for having a backup copy of system settings.

Saving system settings to a floppy disk

1.

w

Insert a formatted floppy disk in the disk drive. (For how to format a floppy
disk, see paragraph 3.3.1.)

Press the [F8] key to show the Setup menu.

Press the [9] key to open the Configuration menu.

Press the [6] key to choose Save/Load.

Save/load
Load from FD

Save to FD is selected; press the [Enter] key.
—— Saveto FD

2. Station List

3. LESList

4. E-Mail/SMS Service List
5. Other

Key in the numeric corresponding to the item you want to save. Then, the
“OK to save?” appears.

ALL: All contents (Distress Alert Setup)

Station List: Station List

LES List: LES List

E-Mail/SMS Service List: E-mail service/SMS service list

Other: Other than Distress Alert Setup menu, Station List, LES List, E-mail
service/SMS service list.

Yes is selected; press the [Enter] key to save chosen system setting to the
floppy disk.

Loading system settings to the terminal unit

aprwnNPRE

Insert floppy disk which contains system settings in the disk drive.
Press the [F8] key to show the Setup menu.

Press the [9] key to open the Configuration menu.

Press the [6] key to choose Save/Load.

Press the [{] key to choose Load from FD and press the [Enter] key.
Load from FD

2. Station List

3. LESList

4, E-Mail/SMS Service List
5. Other

Press appropriate numeric key to choose the item to load. The “OK to load”
window appears.
Yes is selected; press the [Enter] key to load chosen system setting.



3.

FILE OPERATIONS

3.1

This chapter describes how to prepare, edit, save and print files (messages).

Files and Working Areas

To create a new message it is necessary to open a new file. After a new file is
opened, one of two working areas in the internal memory is secured to create

the message. The term “open a file” also refers to the loading of a prepared file

into a working area.

When you remove a file from a working area this is called “closing a file.”

FLOPPY DISK MEMORY

INTERNAL MEMORY

TWO WORKING AREAS

FILE 1

LCD
O

\O— Display

FILE 2

FILE 3

> 2

FELCOM 15's
memory

O
Can select one
for display.
(Change Window
on Edit menu)

Internal memory
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3. FILE OPERATIONS

3.2 Preparing Files
There are two types of files: routine and confidential. Files can be assigned a file
name and saved to a floppy disk for later use. A message may contain maximum
32 Kbytes of characters.

3.2.1 Preparing a routine file

1. Press the [F1] key to display the File menu.

J]lle] Edit Transmit EGC Reports Logs Options Setup Position StopAlarm

File

1. New ALT-N

2. Open
3. Close
4. Save

5. Delete

ALT-O
ALT-Q
ALT-S

ALT-D

6. Rename

9. MIME (Decode)

File menu

2. Press the [1] key to choose New. The display should now look something like
the illustration below.

Edit Transmit EGC Reports Logs Options Setup Position StopAlarm
<[1] UNTITLED1>
0001| 8
Cursor can be a square or an underline.
——— + + Fommm Fommmme B B <
TELEX 1Char. [Line i) 1 Col. 1] [Insert ]

Text editor screen

Note: When two working areas are opened and you try to open a third file,
the message “Save this message” appears. When this occurs close
an open file to free a working area.

3. The cursor is on the first line. Type your message.
4. To transmit the message you have just prepared, go to paragraph 4.1.2. To
save it to a floppy disk, for future transmission, go to paragraph 3.3.2.
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Preparing a confidential file

If communicating with another FELCOM 15, you can prepare a confidential
message by entering “S???-addressee code(-password):” in the first line of the
message text. You can also receive confidential messages containing this
header from a land subscriber or any MES which uses the FELCOM 15.

There are two types of confidential messages: message with addressee code
and message with both addressee code and password.

When the FELCOM 15 receives a confidential message, the message is neither
displayed nor printed immediately. To display or print the contents of a
confidential message, the recipient executes the procedure shown in paragraph
4.2.3.

Addressee code and password

Caller and recipient agree beforehand on both the addressee code and the
password. The addressee code might be the title of the recipient; for example,
CAPTAIN. The password could be the classification of the message; for example,
SECRET.

Preparing message with addressee code

Type the addressee code as shown in the illustration below and then type the
text of message.

— Be sure to enter colon.

S???-addressee code:¢ (text of message)

T— maximum 8 characters

Addressee code
Preparing message with both addressee code and password

Type the addressee code and password as shown in the illustration below and
then type the text of message.

Be sure to enter colon.

|
Y
S???-addressee code-password:  (text of message)

T T maximum 8 characters

Addressee code and password

When the recipient receives a message with both addressee code and password,
he must enter the password to view contents of the message.
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3.2.3 Editor menu setup

The Editor menu sets the parameters of the text editor.

1. Press the [F8] key to display the Setup menu.
2. Press the [3] key to display the Editor Setup menu.

File Edit Transmit EGC Reports Logs Options Position  StopAlarm
Setup
Editor Setup
Asdii
Edit Mode Insert
Word Wrap ON
Line No. ON
Tab Width 4 Char
Column Width 69
Cursor Type Block
Scroll Full Screen

Editor setup menu

3. The illustration above shows the default editor setup settings. To change

settings:

a) Press the [t] or [1] key to choose item.

b) Press the [Enter] key to open corresponding options window.
c) Choose setting with the [1] or [1] key.

d) Press the [Enter] key to register setting.

e) Press the [Esc] key twice to return to the standby display.

Text Mode:

Edit Mode:

Word Wrap:
Line No.:

Tab Width:

Column Width:

Cursor Type:

Scroll:

3-4

Choose “Telex” when creating a telex message. Only upper
case alphabet is permitted in telex. Use “ASCII” when
creating an e-mail message. Upper and lower case alphabet
may be used in an e-mail.

Choose “Insert” (insert character at cursor location) or
“Overwrite” (write over character at cursor location).

Turns on/off automatic hyphenation at the end of a line.
Turns line number display on or off.

Sets horizontal tab width; two, four or eight tabs per line.
Choose 69 for Telex or 40 to 80 for ASCII.

Chooses cursor configuration, “B* or underline.

Sets how much the screen moves up over the page (Full
Screen or Half Screen) when [PgUp] or [PgDn] key is
operated.
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3.

FILE OPERATION

Edit Transmit EGC Reports Logs Options Setup Posirion StopAlarm
<[1] UNTITLED1>

0001] |
Cursor can be a square or an underline.
Line Number
Displayed if Line No. is turned on in
Editor Setup menu.

TELEX 1 Char. [ Line 1/ 1 Col 1] [Insert 1

Text editor screen

Working with text
Cutting and pasting text

of the text to be

1. Use the arrow keys to place the cursor on the first character
cut.
2. Highlight the text to be cut by pressing the [—] key while pressing and

holding the [Shift] key. You can use the [«] or [>] key to adjust the highlight.

The figure below shows the appearance of highlighted text.
<[1] UNTITLED1>

0001|WE ARE CONFIDENT THAT YOU WILL ENJOY MANY YEARS OF OPERATION WITH

(002200318 INMARSAT STANDARD C MOBILE EARTH STATION CONGRATULATIONS§
0003ICONGRATULATIONS ON YOUR CHOICE OF FURUNO FELCOM&
e mmmmmm oo e o Fmmmm o Fmmmm e oo mme <

173 Char. [ Line 2/ 55] [Insert

]

<— Highlight

Appearance of highlighted text
3. Press the [F2] key to choose the Edit menu.

Edit
1. Cut DEL
2. Copy ALT-C
3. Paste INS
4. Insert (With Citation)
5. Select All ALT-A
6. Search or Replace
7. Goto Line
8. Time or Pos. Ins
9. Change Window ALT-V

Edit menu
4. Press the [1] key to choose Cut. The highlighted text is cut a
text is reformatted. If a mistake is made, you can immediatel
by pressing the [Ins] key.

nd the remaining
y restore the text
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5. To move text to a new location after it has been cut, place the cursor at the

exact spot in the message where the cut text is to start. When the text cursor
is placed correctly, press the [F2] key and then the [3] (Paste) key.

Copying and pasting text

1. Choose the text you want to copy.

N

<[1] UNTITLED1>

S R B O B SO oo <

0001|THE FURUNO FELCOM INMARSAT STANDARD C MOBILE EARTH STATION, A
0002ISATELLITE COMMUNICATIONS SN PACKAGE FOR VIRTUALLY EVERY VESSEL.&

TELEX 131Char. [ Line 2/ 2 Col. 66] [Insert ]

Appearance of highlighted text

Press the [F2] key to display the Edit menu.
Press the [2] key to choose Copy. The text selected is copied to the

clipboard.
Place the cursor at the exact spot on the message where the copied text is to

start.

<[1] UNTITLED1>

0001 THE FURUNO FELCOM INMARSAT STANDARD C MOBILE EARTH STATION, A
0002|SATELLITE COMMUNICATIONS UNIT PACKAGE FOR VIRTUALLY EVERY VESSEL.

0003

Cursor

S S O . S S O <

TELEX 131 Char. [ Line 2/ 2 Co. 66] [Insert ]

Cursor selects location where to paste text

5. Press the [F2] key followed by the [3] key. The text is placed at the cursor

3-6

location.

<[1] UNTITLED1>

0001| THE FURUNO FELCOM INMARSAT STANDARD C MOBILE EARTH STATION, A
0002|SATELLITE COMMUNICATIONS UNIT PACKAGE FOR VIRTUALLY EVERY VESSEL.

0003IUNIT &8

TELEX 137Char. [ Line 3 3 Co. 5] [Insert ]

Text pasted at cursor location
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Insert (with Citation)

When you reply to a received message, you can insert the received message.
“>" is placed at the head of the received message to distinguish it from your
message.

Select All

Chooses the entire current file for cut and copy.

Search and Replace

Searching text

The Search feature lets you search for text in a forward or backward direction.

1. Atthe Edit menu, press the [6] key to choose “6 Search or Replace.”

—— Search or Replace

1. Search Alt-F
2. Replace Alt-R

Search and replace menu
2. Press the [1] key to choose “1. Search.”

Search

Search Word

Direction Forward

Search window
3. Search Word is selected; press the [Enter] key to show the search word entry
window.
Type the word to find and press the [Enter] key.
5. Press the [|] key to choose Direction and press the [Enter] key.

»

Search

Search Word
Forward
o

Back

Direction window
6. Press the [|] or [1] key to choose direction to search from the cursor location;
Forward or Back and press the [Enter] key.
7. Press the [Esc] key.

Search Start?
e
| No

Search start window
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8.

9.

Yes is selected; press the [Enter] key.

When the unit finds the word, the cursor stops at the first character of the
word. If the string could not be found, the message “Not Found (To Quit:
ESC)” appears. Press the [Esc] key to quit.

To continue the search, press the [Enter] key.

Replacing text

The Replace feature helps you replace every occurrence of a word or phase with
another word or phase in a file.

1.

N o Ok

At the Edit menu, press the [6] key to choose “6 Search or Replace.”

—— Search or Replace

1. Search Alt-F
2. Replace Alt-R

Search and replace menu
Press the [2] key to choose “2. Replace.”

——  Replace
Replace Word

Direction Forward
Query or ALL Query

Replace menu

Search Word is selected; press the [Enter] key to open the search word entry
window.

Enter search word and then press the [Enter] key.

Press the [1] key to choose Replace Word and press the [Enter] key.

Enter replace word and then press the [Enter] key.

Press the [1] key to choose Direction and then press the [Enter] key.

———— Replace
SearchWord ABC
ReplaceWord 123

Forward |
Forward

Query or ALL Back

Replace menu, direction menu
Press the [|] or [1] key to choose direction to search from the cursor location
and press the [Enter] key.
Press the [1] key to choose Query or All and then press the [Enter] key.

—— Replace
SearchWord ABC
Replace Word 123

Direction
Qury or ALL

All

Replace menu, query or all
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10. Press the [|] or [1] key to choose Query or All.

Query: Stop at each occurrence of word to answer yes or no to
replacement.

All: Replace every occurrence of word without stopping to confirm.
11. Press the [Esc] key.

Replace Start?
............ e
| No

Replace start window

12. Yes is selected; press the [Enter] key to start the replacement. If you selected
“All” at step 10 all occurrences of the search word are replaced with the
replace word. If the string could not be found, the message “Not Found (To
quit: ESC)” appears. Press the [Esc] key to quit.

If you selected “Query” at step 10, the message below appears when the
search word is found. Press the [Enter] key to replace the word, or hit the
Space bar to go to the next occurrence of the search word.

Replace OK? (OK: ENTER Pass: SPACE To quit: ESC)

Go to line

Moves the cursor to the desired line in the current file.

Goto Line

1.Topof Text HOME

2. End of Text END
3. Goto Line

Goto line options

1. Top of text: Go to top of text
2. End of text: Go to end of text
3. Go to line: Specify line number to go to

Time or Pos. Ins

Inserts time or position in a sentence.

1. Atthe Edit menu, press the [8] key to choose “8. Time or Pos. Ins.”

—— Timeor Pos. Ins.

2. Position

Time or position insert options

2. Press the [1] key to insert time; [2] key to insert position at the cursor
position.
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3.3

3-10

Saving Files

After you have created a message you may wish to save it to a floppy disk, for
future use. The types of floppy disk used with the system are 2HD and 2DD.

Inserting a floppy disk

Gently insert a floppy disk in the disk drive on the front panel of the terminal unit.
Handle floppy disks carefully to prevent damage to the disk, which could cause
loss of data.

Ejecting a floppy disk

Press the eject button on the right side of the drive and then remove the disk.

Care and handling of floppy disks

* Do not remove a floppy disk from the drive while the operating lamp on the
disk drive is lit. Damage to the disk may result.

* The tab on the disk slides up to reveal a hole in the housing (or slides down,
to cover the hole). Open the hole to write-protect the disk.

D Hole opened: Write protect

O

0= % Tab

Floppy disk
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Formatting a floppy disk

To save a message to a floppy disk the disk must first be formatted. Formatting
prepares the disk so that information can be written to its surface.

1. Insert a blank floppy disk into the disk drive.
2. Press the [F1] key.

3. Press the [8] key (Format Disk).
File

1
Format Disk

Insert new disk. 2HD (1.44MB)

And select mediatype. 2DD (720kB)

9. MIME (Decode)

Format disk, disk type options

4. Press the [|] or [1] key to choose appropriate media type.
5. Press the [Enter] key.

Format Disk -

Insert new disk.
And select mediatype. |77 T T T T~

Format disk, format start window
6. Press the [«] key to choose Yes and then press the [Enter] key to format the
disk. The screen shows a progress bar as below. When formatting is
completed, the floppy disk drive lamp goes off.

Format Disk
] 8%

If there is no floppy disk in the drive, the message “FD access failure: Drive
not ready.” appears. Press the [Esc] key to erase the message and then
insert a floppy disk in the drive.

Note: If formatting failed, the message (flashing) “Format failed, press any
key to continue.” appears.
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3.3.2 Saving files

You can save a message two ways: Save it without losing your place on the
screen (called “save”), or save it before clearing the screen (called “close”).

Save file, retain place on screen

1. Press the [F1] key to display the File menu.
2. Press the [4] key. The screen should look something like the one below.

Edit Transmit EGC Reports Logs Options Setup Position StopAlarm

File I <[1] UNTITLED1>
Save ILE EARTH STATION, A
28 | ] |RTUALLY EVERY VESSEL.
- - Filename - - - Size - - - Date& Time - - - - - -
E0970715.001 868  02-02-25 02:33

E0970715.002 372 02-02-25 02:52
E0970715.003 6794  02-02-25 02:59

E0970715.004 864  02-02-25 03:13
4 Filesexist 579584 bytes free
| | ToView: SPACE MakeDir:INS RemoveDir: DEL +--------- Al— <

Col. 4] [Insert ]

Save window

3. Enter a file name, up to eight characters with extension name (three
characters). You may not use a colon, quotation mark or semicolon or vertical
line.

(file name) . (extension name)

3 characters
period
8 characters

Configuration of file name
4. Press the [Enter] key to save the file to the disk and keep it on the screen.
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Save file, clear screen

1. Press the [F1] key to display the File menu.
2. Press the [3] key. The message “Save this message?” appears on the
screen.

Edit Transmit EGC Reports Logs Options Setup Position StopAlarm

File <[1] A:\SEIZOUSE>
1. New ALT-N |TTHAT YOU WILL ENJOY MANY YEARS OF OPERATION WITH
2. Open ALT-O [TANDARD C MOBILE EARTH STATION FELCOM
3. Close Ao}  ON YOUR CHOICE OF FURUNO FELCOM. &
4. Save ALT-S

5.Delete  ALT-D

_6; F_le_n(ilnje ______ Save this message?

7.Print ALT-P 7w | Ne |

____________ , No

8. Format Disk

9. MIME (Decode) o e R + N <

TELEX 178 Char. [ Line 3/ 3 Col. 52] [Insert ]
File menu

3. Yes is selected; press the [Enter] key.

Edit Transmit EGC Reports Logs Options Setup Position StopAlarm
i File I <[1] A\SEIZOUSE>
Type file Save :ARS OF OPERATION WITH
name here 4 (AN 1 N FELCOM
3 - - Filename - - - Size - - - Date& Time - - - - - - OM. 3
4 ABC281 . 901 02-02-25 20:54
i COIEKI . 42 02-02-25 02:13
Y COMTEST. 42  02-02-25 05:42
8 E0970715.001 868 02-02-25 02:33
"1 E0970715.002 372 02-02-25 02:52
-| E0970715.003 6794 02-02-25 02:59
§ E0970715.004 864 02-02-25 03:13
"4 E0970715.005 1910 02-02-25 03:48
L 74 Filesexist 578560 bytes free IR oo <
Al ToView: SPACE MakeDir: INS RemoveDir: DEL | cqol. 4 } [Insert ]

Save window

4. Enter a file name.
5. Press the [Enter] key to save the file name and clear the screen.
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3.4  Opening Files
3.4.1 Opening files

1.
2. Press the [F1] key to display the File menu.
3.

4. Pressthe [1]or[1] key to choose a file.

Set the floppy disk containing the file you wish to open in the disk drive.

Press the [2] key. The screen shows a list of the files stored in the floppy disk.

To view a portion of a file, press the space bar. After confirming, press the [Esc]
key.

File

Open

SEIZOU
THE FURUNO FELCOM INMARSAT STANDARD C MOBILE EARTH STATION, A
SATELLITE COMMUNICATIONS UNIT PACKAGE FOR VIRTUALLY EVERY VESSEL.
UNIT 8

Partial view of a file
Press the [Enter] key.
A few moments later the contents of the file appear on the screen and the

title bar shows the file name. You may repeat this procedure to load a second
file into a working area.

3.4.2 Switching between files

You can switch between files by pressing the [9] key (Change Window) on the
Edit menu ([F2]), or pressing Alt+V on the editor screen.

3-14
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<
<

@D[F2]
2 9: Change Window

or [ALT] + [V]

How to alternate display of files in working area 1 and 2.

How to switch between files
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Opening a file when both working areas are occupied

If both working areas in the memory are occupied when you attempt to open a
file, you are asked if you want to save the file currently chosen before closing it
to open another file.

Save this message?
| No

Prompt for closing a file

1. To save the file, press the [Enter] key. (Choose “No” and press the [Enter]
key if you do not need to save the file. Go to step 4.)

Edit Transmit EGC Reports Logs Options Setup Position  StopAlarm
File | <[1] A:\SEIZOUSE>
Save tARS OF OPERATION WITH
2 [A\SEIZOSE ] DN FELCOM
3 - - Filename - - - Size - - - Date& Time - - - - - - OM. B
4 ABC281 . 901 02-02-25 20:54
~| COIEKI . 42 02-02-25 02:13
9 COMTEST. 42 02-02-25 05:42
8 E0970715.001 868 02-02-25 02:33
_7 E0970715.002 372 02-02-25 02:52
-| E0970715.003 6794 02-02-25 02:59
§ E0970715.004 864 02-02-25 03:13
~| E0970715.005 1910 02-02-25 03:48
| 74 Filesexist 578560 bytes free IR R <
A| ToView: SPACE MakeDir: INS RemoveDir: DEL | col. 4 } [Insert ]

Save window
2. To enter same file name as edited file, press the [Enter] key.

File aready exists. Overwrite?

Overwrite file window

3. Yes is selected; press the [Enter] key.
4. Press the [1] or [|] key to choose file to open and then press the [Enter] key.
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3.5 Saving a File Under a New Name

1. Open a file referring to paragraph 3.4.1.

Edit the file.

Press the [F1] key.

Press the [3] (Close) or [4] (Save) key depending on your objective. [3] saves
the file and closes the screen; [4] saves file and keeps position on the
screen.

hwn

Edit Transmit EGC Reports Logs Options Setup Position  StopAlarm

File <[1] A:\\SEIZOUSE>
1. New ALT-N |T THAT YOU WILL ENJOY MANY YEARS OF OPERATION WITH
2. Open ALT-O [TANDARD C MOBILE EARTH STATION FELCOM
3. Close XREel (ON YOUR CHOICE OF FURUNO FELCOM. &
4. Save ALT-S

5.Delete  ALT-D

_6'_ F_Qe_n"i‘"je ______ Save this message?

7.Print  ALT-P e ne

____________ , No

8. Format Disk

9. MIME (Decode) o R e R e <
TELEX 178 Char. [ Line 3/ 3 Col. 52] [Insert ]

Save window

5. For “Close,” press the [Enter] key.
6. Press the [Backspace] key to delete original file name. Enter file name for

new file.
Edit Transmit EGC Reports Logs Options Setup Position  StopAlarm
File | <[1] A:\SEIZOUSE>
Save tARS OF OPERATION WITH
2 [A\SEIZOSE 1 ] DN FELCOM
3 - - Filename - - - Size - - - Date& Time - - - - - - OM. B
4 ABC281 . 901 02-02-25 20:54
- | COIEKI . 42 02-02-25 02:13
3 COMTEST. 42 02-02-25 05:42
_6 E0970715.001 868 02-02-25 02:33
7 E0970715.002 372 02-02-25 02:52
-| E0970715.003 6794 02-02-25 02:59
8 E0970715.004 864 02-02-25 03:13
‘9 E0970715.005 1910 02-02-25 03:48
B 74 Filesexist 578560 bytes free IR R <
A| ToView: SPACE MakeDir: INS RemoveDir: DEL | Col. 4 } [Insert ]

Save window
7. Press the [Enter] key.

Note: Should you decide to save the file under the

original name, skip step 6. The screen | Fledready exists. Overwrite?
shown right appears. Overwrite the file by : No

pressing the [Enter] key, or choose “No” and
press the [Enter] key to escape.
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3. FILE OPERATION
Printing Files on Floppy Disks
You can print out a hard copy of a file stored on a floppy disk.

1. Press the [F1] key to display the File menu.
2. Press the [7] key. A list of files stored on the disk appears.

Print

[A:\R0970729 ]
- - Filename - - - Size - - - Date & Time - - - - - -
R0970729.001 02-01-10 07:21
SEIZOU . 139  02-01-10 06:22
SEIZOUSE. 117  02-02-25 06:29

TO715 . 836  02-02-23 04:53

T7170 . 20  02-02-18 08:55

TEST TXT 29  02-01-14 10:03
TESTCAL. 128  02-02-11 15:02
YANOT 146  02-02-10 17:37

75 Files exist 578560 bytes free

To View: SPACE Make Dir: INS  Remove Dir: DEL

Print window
3. Press the [1] or [|] key to choose a file. To get a partial display of the file, tap
the space bar. After confirming the file, press the [Esc] key.
4. Press the [Enter] key to print the file.

Combining Files

In the procedure below we’ll combine file A and B.

1. Open file A.

2. Open file B.

3. Place the cursor at the beginning of the file B. While pressing and holding
down the [Shift] key, press the [{] key to highlight the entire file. (You can
also choose a portion of the file.)

4. Press the [C] key while holding down the [Alt] key to place file B on the
clipboard.

5. Press the [V] key while holding down the [Alt] key to switch to File A.

6. Press the [—] key while holding down the [Fn] key followed by the [Enter] key
to place the cursor at the end of file A.

7. Press the [Ins] key. File B is inserted at the end of the file A.
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3.8 Deleting Files

1. Press the [F1] key to display the File menu.
2. Press the [5] key. A list of files stored on the disk appears.

File |
Delete

[A:\ABC28 ]
- - Filename - - - Size --- Date& Time - - - - - -
ABC28 . 901 02-01-10 20:53
ABC281 . 901 02-01-10 20:54
COIEKI . 42 02-02-25 02:13
COMTEST. 42 02-02-23 05:42
E0970715.001 868 02-02-18 02:33
E0970715.002 372 02-01-14 02:52
E0970715.003 6794 02-02-11 02:59
E0970715.004 864 02-02-10 03:13

75 Filesexist 578560 bytes free
To View: SPACE MakeDir: INS  Remove Dir: DEL

Delete window
3. Press the [1] or [|] key to choose the file you want to delete. To verify the
contents of that file, tap the space bar. After confirming the contents, press
the [Esc] key.
4. Press the [Enter] key. The prompt “OK to delete file?” appears.

File |
Delete

[A\ABC28 ]
- - Filename - - - Size --- Date& Time - - --- -
ABC281 . 901 02-01-10 20:54
COIEKI . 42 02-02-25 02:13
COMTEST. 42 02-02-23 05:42
E0970715.001 868 97-07-15 _
E0970715.002 372 97-07-15| OK todel fl%t_e_ file?
E0970715.003 6794 97-07-15
E0970715.004 864 Mo

75 Files exist 578560 bytes free
ToView: SPACE MakeDir: INS RemoveDir: DEL

Delete window
5. Press the [Enter] key to delete the file.
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Renaming Files

Do the following to rename a file.

1. Press the [F1] key.
2. Press the [6] key.

File .
Rename

[A\Test ]
- - Filename - - - Size - - - Date& Time - - - - - -
Tes 901 02-01-10 20:53
ABC281 . 901 02-01-10 20:54
COIEKI . 42 02-02-25 02:13
COMTEST. 42 02-02-23 05:42
E0970715.001 868 02-02-18 02:33
E0970715.002 372 02-01-14 02:52
E0970715.003 6794 02-02-11 02:59
E0970715.004 864 02-02-10 03:13

75 Filesexist 578560 bytes free
ToView: SPACE MakeDir: INS Remove Dir: DEL

Rename window

w

4. Press the [Enter] key.
Rename
Enter new filename

Test

File name entry window

Delete old file name, and then type new file name.
6. Press the [Enter] key.

o

Press the [1] or [|] key to choose the file you want to rename.
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3.10

3-20

Decoding E-mail Attachment

When you can't read an e-mail attachment because it has been coded by MIME
(Multipurpose Internet Mail Extensions), you may decode it as below.

1. Save the MIME-coded file to a floppy disk. (See paragraph 4.2.5 for the
procedure.) This step is not necessary if Auto Receive Message Save is
turned on in the Auto Mode Setup menu.

2. Press the [F1] key to open the File menu.

3. Press the [9] key to choose MIME(Decode).

Edit Transmit EGC  Reports Logs Options Setup Position StopAlarm

File
| Decode
[A:\E0970715 ]
- - Filename - - - Size--- Date& Time------

E0970715.001 868  02-02-25 02:33
{1 E0970715.002 372 02-02-25 02:52
E0970715.003 6794  02-02-25 02:59

E0970715.004 864  02-02-25 03:13

4 Filesexist 579584 bytes free

1 ToView: SPACE MakeDir: INS Remove Dir: DEL
|

Decode window

4. Press the [1] or [|] key to choose the file you want to decode.
5. Press the [Enter] key.

File chosen at step 4

MIME Decode
Checking 'E09.7(.)715.001" e Decode
Decode'ABC.ini> |
| No

|
File attachment

Decode window

6. Yes is selected; press the [Enter] key to decode the file.
File

| Save

[AMABC.nill ]

- - Filename - - - Size--- Date& Time------
E0970715.001 868  2002-02-25 02:33
{ E0970715.002 372  2002-02-25 02:52
E0970715.003 6794  2002-02-25 02:59
E0970715.004 864 2002-02-25 03:13

4 Filesexist 579584 bytes free

1 ToView: SPACE MakeDir: INS Remove Dir: DEL
|

Save window
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7. To change file name, press the [Backspace] key to erase the file name, new
file name and then press the [Enter] key. After decoding the file the screen
looks something like the one shown below.

MIME Decode

Checking 'E0970715.001" - -
Decode 'ABC.ini'?

Now decoding * -

Complete.

Decoded 1 file (s).

Press any key to escape.

MIME decode screen

8. Press the [Esc] key twice to return to the standby display.

9. Press the [F1] and [2] keys in that order.

10. Press the [1] or [|] key to choose the file selected at step 7 and then press
the [Enter] key.
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4.

INMARSAT C COMMUNICATIONS

4.1

41.1

This chapter explains how to transmit and receive. Before conducting any
communications, be sure to login with the NCS in your area, following the
instructions in paragraph 2.3.1.

To transmit e-mail, you may need to register for e-mail services with appropriate
LES which provides such services. Further, it is necessary to register with
appropriate LES to receive e-mail from land mail system. For further details,
contact appropriate LES.

Transmitting

To transmit a message, create the message, attach the address of the recipient
and then send it to the LES. The address of the recipient in the Inmarsat C
system is his telex number, for transmission via landline, or MES Inmarsat
Mobile Number (IMN), when transmitting to a ship.

The message can be one you've just prepared or one stored on a floppy disk.
(Messages cannot be transmitted by direct keyboard input.)

Code description

Code can be specified at the terminal unit.

IA5: International alphabet No. 5, ASCII code (7 bit).
Specify this code to transmit English containing lower case alphabet.

ITA2: No. 2 international communications alphabet (5 bit). Specify this code for
message which contains only No. 2 international communications
alphabet (see A-11). ITA2 code is transmitted faster than IA5 code.
Land-based telex equipment uses ITA2. The LES converts all codes into
ITA2. Code which cannot be converted is shown with the question mark
(?).

DATA: Data (8 bit). Use this code to transmit data.
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Message language, subscriber, destination type and code

Message | Subscriber Destination Type | Code | Remarks
English Inmarsat C MES | Telex IA5
Telex Telex ITA2
Fax PSTN IAS Modem type “T30”
E-mail E-mail IA5
Russian Inmarsat C MES | PSDN DATA
Fax Not available
E-mail E-mail DATA
Japanese | Inmarsat C MES | PSDN DATA
Telex Not available
Fax Not available
E-mail E-mail DATA
Data Inmarsat C MES | PSDN DATA
Land Network PSDN DATA
4,1.2 Transmitting prepared message

4-2

This section explains how to transmit a message you have just prepared, via fax,
telex, e-mail or SMS. For distress transmission, see Chapter 6. For 2-digit code
services, see the table in paragraph 4.1.6.

Transmitting a message to a station registered on station list

1. Prepare message on the screen. For e-mail or SMS, set Text Mode in the
Editor Setup menu to Ascii. See paragraph 3.2.3. For e-mail attachment,
prepare the attachment and save it to a floppy disk. SMS messages over
160 characters in length are sent in parts.

2. Press the [F3] key to display the Transmit menu.

File Edit EGC Reports Logs Options Setup Position  StopAlarm
- Transmit <[1] UNTITLED1>

1. Transmit Message

2. Cancel

3. Request Delivery Status
ek mm e f S Fommmm o S, B T S T B <
TELEX 25Char. [ Line 2/ 2 Co. 1] [Insert ]

Transmit menu
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3. Press the [1] key to display the Transmit Message menu.

Displays communication charge. See paragraph 2.6.1.

File Edit EGC Reports Logs Options Setyp Position StopAlarm
- Transmit ————— <[1] UNTITLED1>
Transmit Message
Normal
Message File Message now being edited  Size \ 24
Station Name Cosgt *****xx* % (|SE)
Destination Type TELEX
Prefix Code
Country/Ocean Code
Station ID
Modem Type
_ Address
Subject
L Attach File _
LESID
Option
Confirmation ON
Send Delay 00:00
Delivery Delay Immediate
Code IA5
[ TRANSMIT ]

Transmit message menu

4. Press the [1] key twice to choose Station Name.
5. Press the [Enter] key to open the Station List.

File Edit EGC Reports logs Options  Setup StopAlarm
Transmit ———
Transmit Message
Priority Normal IB)
Message F Station List ol a
Group Station Name Type Code ID/Address
Dedtination~ -~~~ -~ -~~~ -~~~ -~~~ """ """ """"""""""""""°"°"°7°% OHz)
Country| &8 FURUNO TELEX 81 321
Station | 02 FRNINMBTSTS TELEX 583 343199999
Modem| 03  Seagull E-Mail  Seagull @furuno.co.jp
Address 04  whale E-Mail whae@furuno.co.jp
Subject | 05
Attach LES 06
Option 07
Confirm 08
SendD| o -
Deliver 7 |:Select SPACE: Select Stations B.SPACE: Cancel Mark  INS: Edit
Code Sort (Ctrl+G: Group, Ctrl+N: Station Name, Ctrl+T: Type)

[ TRANSMIT ]

Transmit message menu, station list
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6. Press the [t] or [{] key to choose station and then press the [Enter] key. To
choose multiple stations* (simultaneous transmission), choose a station and
then press the Space bar. Selected stations are marked with an asterisk (in
case of Telex or FAX). For e-mail address, press the Space bar to choose
“To” “Cc,” Blank, “To”... consecutively. * = Max. 10 telex stations, 7 FAX and
10 e-mail, and one SMS.

Station List

Group Station Name Type Code ID/ Address

£ 01 FURUNO TELEX 81 321

%02 FRNINMBTSTS TELEX 583 343199999

03 Seagull E-Mail Seagull@furuno.co.jp
04 whale E-Mail whale@furuno.co.jp
05

06

07

08

7 | :Select SPACE: Select Stations B.SPACE: Cancel Mark INS: Edit
Sort (Ctrl+G: Group, Ctrl+N: Station Name, Ctrl+T: Type)

Station list

Note 1: Messages having different communication format or prefix code
(two-digit code) cannot be sent simultaneously.

Note 2: To cancel selection (erase asterisk, To or Cc), choose station and
press the [Backspace] key.

Note 3: You may sort the list by group name, station name or
communication type as follows:

Group name: Each press of [Ctrl]] + [G] sorts the list by group name,
ascending or descending order.

Station name: Each press of [Ctrl] + [N] sorts the list by station
name, in ascending or descending order.

Comm. type: Each press of [Ctrl] + [T] sorts the list by
communication type, in ascending or descending order.

Note 4: You may edit the communication charges (see paragraph 2.7.1)
from the Station List by pressing the [Ins] key. After editing charges,
press the [Esc] key. “OK to save” appears; press the [Enter] key.

7. For E-mail follow the procedure below. For other communication formats, go

to step 8.

(1) Press the [{] key to choose Subject.

(2) Press the [Enter] key to open subject entry window.

(3) Type subject.

(4) Press the [Enter] key to close the window.

(5) To attach a file, press the [{] key to choose Attach File.
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(6) Press the [Enter] key to open the attach file window.

Transmit Message

Priority Normal
Message File
Station Name
Destination Type
Prefix Code
Country/Ocean Code
Station ID
Modem Type
Address
Subject
-
LES ID
Option
Confirmation
Send Delay
Delivery Delay

E-Mail
Select File

Transmit ———— <[1] UNTITLED1>

Message now being edited  Size 24

Code ENTER: Select DEL: Remove

[ TRANSMIT ]

Transmit message menu, select file window opened

(7) Press the [Enter] key to open the file list window.
(8) Press the [1] or [{] key to choose a file and then press the [Enter] key.

(9) Press the [Esc] key to close the window.

8. Press the [{] key to choose LES ID. If the communication format is e-mail,

the LES set in paragraph 2.11 appears.

9. Press the [Enter] key to open the LES setting window.

- Transmit ———— <[1] UNTITLED1>
Transmit Message
Priority Normal
Message File Message now being edited ~ Size 24
Station Name Cost *#*iiiik #x(JSS)
Destination Type TELEX
Prefix Code
Country/Ocean Code
Station ID
Modem Type
Address
Subject
L Attach File
Name LES ID Remarks
Option Telenor S.S.Inc 201 USA
Confirmation 202
Send Delay KDDI 203 JAPAN
Delivery Delay Korea Telecom 208 KOREA
Code Singapore Telecom210 SINGAPORE (NCS, ID244)
[ TRANSMIT ]
LES ID options

10.Press the [1] or [{] key to choose LED desired.

Note: You may edit the communication charges (see paragraph 2.7.1) from
the Station List by pressing the [Ins] key. After editing charges, press
the [Esc] key. “OK to save” appears; press the [Enter] key.

11. Press the [Enter] key to close the window.
12.Press the [{] key to choose Confirmation.
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4-6

13. Press the [Enter] key to open the confirmation window.

14. To request notification of delivery from the LES, choose ON. If not necessary
choose OFF.

15. Press the [Enter] key to close the window.

16.Press the [{] key to choose Send Delay.

17.Press the [Enter] key to open the send delay entry window.

18.To send a message after a certain delay, enter a time up to 99 hours 59
minutes. (The Send Delay is used to time message arrival to suit recipient’s
office hours.)

19.Press the [Enter] key to close the window.

20.Press the [{] key to choose Delivery Delay.

21.Press the [Enter] key to open the delivery delay options window.

22.Delivery Delay requests the LES for “Immediate” or “Deferred” transmission
to the recipient designated. Press the [1] or [{] key to choose Immediate or
Deferred. For information on this service, consult with LES where message is
to be sent.

23.Press the [Enter] key to close the window.

24.Press the [{] key to choose Code and press the [Enter] key.

25.Press the [t] or [{] key to choose “IA5 (for e-mail, fax) ”, “ITA2 (for telex)”
“DATA” or “SMS” as appropriate.

26.Press the [Enter] key to close the window.

27.Press the [{] key to place the cursor on TRANSMIT.

28.Press the [Enter] key to open the start window.

Transmit Message

Priority Normal
Message File SEISETU.TXT Size 46
Station Name FURUNO COSt ¥****xk* ** (U%)
Destination Type TELEX

Prefix Code

Country/Ocean Code 81

Station ID 321

Modem Type

Address

Subject

Attach File
LESID 303 (KDDI) Start
Option

Confirmation ON | No

Send Delay 00:00

Delivery Delay Immediate

Code IA5

Transmit message screen

29.Press the [Enter] key to send the message to the message queue. (To
escape, choose “No” and press the [Enter] key.) The message “Message is
entered in sending Queue. Press any key.” appears.

Note 1: If some data has not been entered, the message “Input Error: xx.”
(xx: error content) appears.

Note 2: When you send a message which contains more than 32 KB of data,
the message “Message file is too large (but sent only with 32 KB).”
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Note 3: Messages sent to the message queue may contain up to 32 KB of
data. If data is larger than 32 KB, the message “Cannot enter this
message to sending Queue. Press any key.” appears.

30.Press the [Esc] key twice to return to the standby display.

The message(s) will be transmitted according to the Send Delay setting.
“Current State: SENDING” appears at the bottom of the screen while the
message is being transmitted. If the message was transmitted successfully,
“Successful Sending message” appears and the TX message is printed (if
“Confirmation is ON). You can view details about the message in the Display Log

(see paragraph 4.3).

Sent Message

DELIVERY CONFIRMATION OFF

Message File
LES

Priority
Destination

: 00OFOX.TXT Message Size : 277 characters

: Stratos M.N. Date : 02-03-10

- Normal Time : 06:06 (UTC)

: TELEX (Prefixed) 00111222222222222222 (1A5)
00111333333333333333
00111444444444444444

Display log printout example (“Confirmation” OFF)
When Confirmation is ON and you receive a delivery status message, the
message “Delivery Status received for (file name).” appears and the delivery

status message is printed.

Sent Message

DELIVERY CONFIRMED

Message File  : OOFOX.TXT Message Size : 277 characters
LES : Stratos M.N. Date 1 02-03-10
Priority - Normal Time :06:06 (UTC)
Destination : TELEX (Prefixed) 00111222222222222222 (1A5)

Display log printout example (“Confirmation” ON, message delivered)

Sent Message but not delivered
DELIVERY FAILURE : xxx

Message File  : OOFOX.TXT Message Size : 277 characters
LES : Stratos M.N. Date : 02-03-10
Priority - Normal Time :06:06 (UTC)
Destination : TELEX (Prefixed) 00111222222222222222 (1A5)

Display log printout example (“Confirmation” ON, message not delivered)

Sent Message but not delivered
DELIVERY STATUS NOT RECEIVED (In case of timeout)

Message File
LES

Priority
Destination

: 00FOX.TXT Message Size : 277 characters
. Stratos M.N. Date 1 02-03-10
: Normal Time :06:06 (UTC)

: TELEX (Prefixed) 00111222222222222222 (1A5)

Display log printout example (“Confirmation” ON, delivery status not received)
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-

TRANSMIT MESSAGE STATUS
The terminal unit displays transmit message status as follows:

Message Send failed. This appears if the message could not
be transmitted because of technical reasons such as satellite
malfunction, signal degradation, or no reply from LES. Try toO
transmit the message again.

Message Send rejected. This appears when the LES rejects
the message because of non-technical reasons such as unpaid

subscriber's fee.

Message Send pending.This appears when the circuits at the
LES are busy. Your message will be transmitted when a circuit

becomes clear.

Transmitting a message to a station not registered on station list

1.

Prepare message. For e-mail or SMS, set Text Mode in the Editor Setup
menu to Ascii. See paragraph 3.2.3. For e-mail attachment, prepare the

attachment and save it to a floppy disk. SMS messages over 160 characters

in length are sent in parts.
Press the [F3] key to display the Transmit menu.
Press the [1] key to show the Transmit Message menu.

Displays communication charge. See paragraph 2.6.1.

File Edit EGC Reports Logs Options Setyp Position StopAlarm

Transmit ———— <[1] UNTITLED1>

Message File

Station Name

Destination Type
Prefix Code
Country/Ocean Code
Station 1D
Modem Type
Address
Subject
Attach File

LESID

Option
Confirmation
Send Delay
Delivery Delay
Code

[ TRANSMIT ]

Transmit Message
Normal

Message now being edited  Size Y 24

Cog ********.**(U$)

TELEX

ON

00:00
Immediate
IA5

Transmit message menu
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4. Press the [{] key three times to choose the Destination Type.
5. Press the [Enter] key to open the destination type options window.

- Transmit ——— <[1] UNTITLED1>

Transmit Message
Priority Normal
Message File Message now being edited  Size 24
Station Name Cost ¥****xxx %% (SH)
=
Prefix Code
Country/Ocean Code | E-Mail
Station ID SMS
Modem Type PSDN
| Address X400
S o
— LEgtlthh File TELEX (Prefixed) -
- FAX (Prefixed)
Option PSDN  (Prefixed)
Confirmation X400  (Prefixed)
Send Delay DNID  (Prefixed)
Delivery Delay SPEC (Prefixed)
Code IAS
[ TRANSMIT ]

Transmit message menu, destination type options window

6. Press the [t] or [{] key to choose Destination Type among “TELEX,” “FAX",
“E-mail” or "SMS" as appropriate.
7. Press the [Enter] key to close the window.
8. Continue the procedure according to destination type:
TELEX (Prefixed): Page 4-10
FAX: Page 4-12
E-mail:  Page 4-13
SMS: Page 4-14
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Communication type: TELEX (Prefixed)

1. Press the [I] key to choose Country/Ocean Code.
2. Press the [Enter] key to open the country/ocean code entry window.

o~

- Transmit ——— <[1] UNTITLED1>

Transmit Message

Priority

Message File

Station Name

Destination Type
Prefix Code
Station ID
Modem Type
Address
Subject

L Attach File

LESID

Option
Confirmation
Send Delay
Delivery Delay
Code

[ TRANSMIT ]

Normal
Message now being edited

TELEX

[

ON

00:00
Immediate
IA5

Size 24
Cog *hkkkhkkkkk **(U%)

Transmit message menu, country/ocean code window

For ship-to-shore telex, enter recipient’s telex country code. For example, to
use KDDI (Japan) enter 720. For ship-to-ship telex, enter recipient’s ocean

region.
Ocean Region
AOR-East: 581
POR: 582
IOR: 583
AOR-West: 584

Press the [Enter] key to close the window.
Press the [1] key to choose Station ID.
Press the [Enter] key to open the station ID entry window.

Transmit ——— <[1] UNTITLED1>

1 Priority

Jy MessageFile

Station Name

Destination Type
Prefix Code

Modem Type

- Address

Subject

— Attach File

LESID

Option
Confirmation
Send Delay
Delivery Delay
Code

[ TRANSMIT ]

Country/Ocean Code

Station ID D

Transmit Message
Normal
Message now being edited  Size 24
Cost ********.**(U$)
TELEX

ON

00:00
Immediate
IA5

Transmit message menu, station ID window opened




7. Type either recipient’s telex subscriber number (ship-to-shore) or IMN

(ship-to-ship).
8. Press the [Enter] key to close the window.
9. Press the [1] key to choose LES ID.
10.Press the [Enter] key to open the LES ID entry window.

Transmit ———— <[1] UNTITLED1>
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Priority

Message File

Station Name

Destination Type
Prefix Code
Country/Ocean Code
Station ID
Modem Type
Address
Subject
Attach File

Option
Confirmation
Send Delay
Delivery Delay
Code

[ TRANSMIT ]

Transmit Message
Normal
Message now being edited  Size 24
Cost *¥**xxk*x .**(U%)

TELEX

Name LESID Remarks

Telenor SS.Inc 201 USA

202

KDDI 203 JAPAN

KoreaTelecom 208 KOREA

Singapore Telecom210 SINGAPORE (NCS, 1D244)

LED ID entry window

11. Press the [1] or [1 ] key to choose LES.
12.Press the [Enter] key to close the LES ID entry window.
13.Follow from step 12 on page 4-5.
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Communication type: FAX
Press the [1] key to choose Country/Ocean Code.

Press the [Enter] key to open the country/ocean code entry window.
Enter country code of recipient, referring to the list in the Appendix.
Press the [Enter] key to close the window.

Press the [1] key to choose Station ID.

Press the [Enter] key to open the station ID entry window.

Enter recipient’s fax number.

Press the [Enter] key to close the window.

Press the [1] key to choose Modem Type.

10 Press the [Enter] key to open the modem type options window.

- Transmit ————— <[1] UNTITLED1>

©CoNORWDE

Transmit Message
Priority Normal
Message File Message now being edited  Size 24
Station Name Cost ****x*%k (| JSE)
Destination Type FAX
Prefix Code
Country/Ocean Code ——— Modem Type
Station ID
v2l V.21 300bps Duplex
_ Address V22 V.22 1200bps Duplex
Subject V22B  V.22bis 2400bps Duplex
L Attach File V23 V.23 600/1200bps ' —
LESID V26B V.26bis 2400/1200bps
Option V26T V.26ter 2400bps Duplex
Confirmation V27T V.2T7ter 4800/2400bps
Send Delay V32 V.32 9600bps Duplex
Délivery Delay Other
Code 1A5
[ TRANSMIT ]

Transmit message menu, modem type options window

11. Press the [1] or [1] key to choose modem type. For transmission to landline
fax or to fax-equipped Inmarsat B MES, choose “T30.” (You cannot transmit a
FAX to another Inmarsat C MES.)

12.Press the [Enter] key to close the window.

13.Press the [1] key to choose LES ID.

14.Press the [Enter] key to open the LES ID window.

15.Press the [1] or [1] key to choose LES ID.

16.Press the [Enter] key to close the window.

17.Follow from step 12 on page 4-5.



Communication type: E-mail

4. INMARSAT C COMMUNICATIONS

1. Press the [I] key to choose Address.
2. Press the [Enter] key to open the address entry window.

- Transmit ——— <[1] UNTITLED1>

Transmit Message |

Priority
Message File
Station Name
Destination Type
Prefix Code
Country/Ocean Code
Station ID
Modem Type
-
Subject
L Attach File
LESID
Option
Confirmation
Send Delay
Delivery Delay
Code
[ TRANSMIT ]

Normal
Message now being edited  Size 24
Cost ********.**(U%)
E-Mail
INET

201 (Telenor S.S.Inc)

ON

00:00
Immediate
1A5

Transmit message menu, address entry window

3. Type recipient’s e-mail address.
4. Press the [Enter] key to close the window.
5. Press the [1] key to choose Subject.
6. Press the [Enter] key to open the subject entry window.
- Transmit ——— <[1] UNTITLED1> |
Transmit Message
Priority Normal
Message File Message now being edited  Size 24
Station Name Cosgt ******xx % (|SE)
Destination Type E-Mail
Prefix Code
Country/Ocean Code
Station ID INET
Modem Type
. Address
Subject |
L Attach File
LESID 201 (Telenor S.S.Inc)
Option
Confirmation ON
Send Delay 00:00
Delivery Delay Immediate
Code IA5
[ TRANSMIT ]

Transmit message menu, subject entry window opened

7. Type subject.

8. Press the [Enter] key to close the window.

9. If you want to attach a file, press the [1] key to choose Attach File.
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4-14

10.Press the [Enter] key to open the select file window.

- Transmit ——— <[1] UNTITLED1>
Transmit Message

Priority Normal

Message File Message now being edited  Size 24

Station Name Cost *****x%% x* (|SS)

Destination Type E-Mail
Prefix Code Sdlect File
Country/Ocean Code
Station 1D |
Modem Type
Address
Subject

- —

LESID

Option
Confirmation
Send Delay
Dedlivery Delay
Code ENTER: Select DEL: Remove

[ TRANSMIT ]

Transmit message menu, select file window

11. Press the [Enter] key to open the file list window.

12.Press the [1] or [|] key to choose a file and then press the [Enter] key to close
the window. To choose another, press the [Enter] key and then choose
another file.

13.Press the [Esc] key to close the window. The LES ID selected at paragraph
2.11 appears.

14.Follow from step 12 on page 4-5.

Communication type: SMS

Press the [{] key to choose Address.

Press the [Enter] key to open the address entry window.
Type recipient’s mobile phone number.

Press the [Enter] key to close the window.

Press the [{] key to choose LES ID.

Press the [Enter] key to open the LES ID selection window.
Choose LES ID.

Press the [Enter] key to close the window.

Follow from step 12 on page 4-5.
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Transmitting a file stored on a floppy disk

1. Close any open files.

2.

Insert floppy disk containing file to be sent.

3. Press the [F3] key to display the Transmit menu.

File Edit EGC Reports Logs Options Setup Position StopAlarm
——— Transmit ——
1. Transmit Message
2. Cancel
3. Request Delivery Status
Transmit menu
4. Press the [1] key to choose Transmit Message.
File Edit Transmit EGC Reports Logs Options Setup Position StopAlarm
Transmit ———
Transmit Message~
Normal
Message File Size 24
Station Name Cost *****%** %% (S& )
Destination Type TELEX

Prefix Code
Country/Ocean Code 82

Station ID 65-2111
Modem Type
Address
Subject
Attach File
LESID 303 (KDDI)
Option ON
Confirmation 00:00
Send Delay Immediate
Delivery Delay IA5
Code
[ TRANSMIT ]

Transmit message menu

5. Press the [1] key to choose Message File and press the [Enter] key.

Send
[A:\SEIZOUSE ]
- - Filename - - - Size - - - Date& Time - - - - - -
T . 9078 02-01-08 19:30
J . 13 02-01-28 20:57
R0970714.001 4973 02-01-29 05:56
R0970718.001 313 02-02-25 00:25
R0970729.001 412 02-02-25 07:21
SEZOU . 139 02-02-25 06:22
SEIZOU TXT 39 02-02-25 21:22
SEIZOUSE. 178 02-02-25 01:44
70 Filesexist 590848 bytes free
ToView: SPACE MakeDir: INS Remove Dir: DEL

File list

6. Press the [1] or [{] key to choose a file and press the [Enter] key. (You can
view a part of a file by tapping the space bar. After confirming the contents,

press the [Esc] key.)
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Note: When an e-mail with attachment is sent, the file volume increases by
1.5 times because of MIME coding. In this case, you can do the
following to lower toll charges:

a) Select file to attach from Message File.
b) Choose DATA from Code.

7. To transmit the message to a station registered on the station list, follow from
step 12 on page 4-5. To transmit to a station not listed on the station list,
follow from step 4 on page 4-9.

4.1.4 Canceling transmission on a message awaiting transmission

As noted earlier a transmit message is held in the buffer, usually until it is
transmitted satisfactorily. To cancel transmission on a message held in the buffer,
do the following:

1. Press the [F3] key to display the Transmit menu.
2. Press the [2] key to display the Cancel screen.

File Edit EGC Reports Logs Options Setup Position  StopAlarm
- Transmit ———— <[1] UNTITLED1>
1. Transmit Message Cancel
Message File Priority Send Status  Delivery
edit_msg.001 Normal Waiting
ek mm e f S B [ S Fommm o <
TELEX 25Char. [Line 2/ 2 Col. 1] [Insert ]

Cancel screen
Send status
Waiting: Waiting to transmit message.
Sending: Now sending message.
Fail: Failed transmission
Rejected: Message rejected by LES.
Pending: LES circuits occupied.

3. Press the [1] or [L] key to choose the message you want to cancel.
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4. Press the [Enter] key to open the cancel window.

File Edit EGC

Reports Logs Options Setup Position  StopAlarm

- ———— Transmit

1. Transmit Message

<[1] UNTITLED1>

Cancel

No. Message File Station

LES

Priority Send Status Delivery

01 ABC FURUNO Telenor SS.Inc Normal Waiting
02 FELCOM FUSA Telenor S.S.Inc Norma  Sending

Cancel
ves T
ek mm e f S B Fommm oo S Fommm o <
ASCII 25 Char. [Line 2/ 2 Col. 1] [Insert ] |

Cancel window

5. Press the [Enter] key to cancel a message, or choose “No” and press the
[Enter] key to escape from the Cancel menu.
6. Press the [Esc] key twice to return to the standby display.

Requesting delivery status

Automatically receiving delivery status

You can automatically receive delivery status of messages you send to a LES,
by selecting “Confirming ON” in the Transmit Message menu. Transmitted
messages which request delivery status appear in the Message Status List.

The Message Status List holds delivery status information for 30 messages.
When the list is full, the oldest entry is deleted to make room for the latest.

1. Press the [F3] key to show the Transmit menu.

File Edit EGC Reports Logs Options Setup Position StopAlarm

Transmit

1. Transmit Message

2. Cancel
3. Request Delivery Status

Transmit menu
2. Press the [3] key to display the Request Delivery Status list. If no messages
exist, “No message.” appears.

Request Delivery Status

No. Message File Station LES Priority Send Status Delivery
01 ABC FURUNO KDDI Normal Waiting

02 DEF FURUNO KDDI Normal Sending

03 GHI ASDFASDF  KDDI Normal 02-02-26 9:40 OCC(002)
04 JKL KDDI Normal 02-02-25 20:16

05 MNO ABCDEFGHIJ KDDI Normal 02-01-23 16:09 Complete
06 edit msy.002 KDDI Normal 02-01-22 9:48 EEE(001)
07 edit msg.001 KDDI Normal 02-01-20 12:34 ?77?7??

Sample request delivery states
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IMessage status list description]

No.:
Message File:

Station:

LES:
Priority:
Send Status:

Delivery:

Message number

File name. For no file name, “edit msg. 00X” appears (X =

number from 001-999).

Name of remote party (recipient)

The LES which received the message.

Normal or distress

The transmission status from the MES (own ship) to the LES;

waiting or sending, and data and time of transmission for

messages transmitted.

The delivery status from the LES to the recipient.

Complete: Message transmitted successfully

White space: Delivery status not yet received

Reason for no delivery:

OCC(002): Delivery tried (twice), but recipient busy.

ABS: Absent subscriber

BK: Message aborted

BMC:No end of message or end of transmission received

DER:Out of Order

DTE: Remote DTE clearing

EOS:Element of Service not subscribed (E-mail)

FMT: Format error

IAB: Invalid answerback

INC: Inconsistent Request (E-mail)

INF: Call the Network Information service

INV: Invalid Call

ITD: Awaiting delivery

LDE: Maximum message length exceeded

LPE: Local Procedure Error

NA: Access Barred

NC: Network Congestion

NCH:Subscriber’s number has been changed

NP: Not Obtainable

NRC:Reverse charging acceptance not subscribed

RIS: Recipient Improperly Specified (E-mail)

RDI: Redirected call

RPE: Remote Procedure Error

RSB: Retransmission still being attempted

TMD:Maximum number of addresses exceeded

UNK:Unknown status (for example when the Logical
channel number is zero)

Note: Some codes may not be used depending on LES.
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Manually requesting delivery status

You can manually request an LES for delivery status of a message you have

transmitted within the past 24 hours.

1. Press the [F3] key to display the Transmit menu.
2. Press the [3] key to display the Request Delivery Status list.

Request Delivery Status

No. Message File Station LES Priority Send Status
01 ABC FURUNO KDDI

02 editmsg.002 FURUNO KDDI Normal

Delivery
Normal 02-02-25 16:10

Request delivery status display

3. Press the [1] or [{] key to choose a file.
4. Press the [Enter] key. The start window appears.

Request Delivery Status

No. Message File Station LES Priority Send Status
01 ABC FURUNO K DDI

02 editmsg.002 FURUNO KDDI Normal

Delivery
Normal 02-02-25 16:10

Sample message file list

5. Yes is selected; press the [Enter] key to request status. If request was
successful the message “Successful Deliver Status Request.” appears.
6. Press the [Esc] key twice to return to the standby display.

Several minutes later the message “Delivery status received for (file name)”
appears on the display. The reply from the LES appears in the Delivery column
of the Request Delivery Status list.
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4.1.6

4-20

Accessing the 2-digit code services

A range of special safety and general maritime services, known as the 2-digit
code services, may be transmitted. The list on the next page shows the 2-digit
code services available.

To access a 2-digit code service do the following:
1. Using the text editor, prepare message requesting a 2-digit code service.

2. Press the [F3] key to open the Transmit menu.
3. Press the [1] key to display the Transmit Message menu.

File Edit gEEWSHlY EGC Reports Logs Options Setup Position StopAlarm
- Transmit ————— <[1] UNTITLED1>
Transmit Message
Normal
Message File Message now being edited  Size 24
Station Name Cost ******%* ** (US$)
Destination Type TELEX
Prefix Code
Country/Ocean Code
Station ID
Modem Type
_ Address
Subject
L Attach File |
LESID
Option
Confirmation ON
Send Delay 00:00
Delivery Delay Immediate
Code IA5
[ TRANSMIT ]

Transmit message menu

Press the [1] key three times to choose Destination Type.

Press the [Enter] key to open the destination type options window.
Press the [1] or [1] key to choose SPEC (Special).

Press the [Enter] key to close the window.

Press the [1] key to choose Station ID.

Press the [Enter] key to open the station ID entry window.

10 Key in 2-digit code referring to the table on the next page.

11. Press the [Enter] key to close the window.
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Maritime safety service 2-digit code

Code Content Remarks
31 Maritime enquiries Desirable for requesting information
including service offerings.
32 Medical advice Used for requesting medical advice.
33 Technical assistance Desirable for addressing technical enquiries
to appropriate personnel.
37 Time and charges Desirable for mobile operator when sending
requested at end of call traffic for a third party.
38 Medical assistance Used for requesting medical assistance.
39 Maritime assistance Used for requesting maritime search and
rescue assistance
41 Meteorological reports Necessary for ease of addressing weather
reports from ship to meteorological centers.
42 Navigational hazards and Used for making urgent navigational
warnings meteorological danger reports.
43 Ship position reports Used for routing of messages to ship safety
reporting systems.

12.Press the [1] key to choose LES ID.

13.Press the [Enter] key to open the LES window.

14.Press the [1] or [1] key to choose appropriate LES and press the [Enter] key.
15.Press the [I ] key to choose TRANSMIT.

16.Press the [Enter] key to show the start window.

17. Press the [Enter] key to transmit the message prepared.

Note: If some data is missing the message “Input error.xx (xx: error) is
displayed.

18.Press the [Esc] key twice to return to the standby display.

The message “Current State: SENDING” appears at the bottom of the screen
during transmission. If the message was transmitted successfully “Successful
Sending message” appears and the message is printed (Confirmation is
turned ON). You can see the contents on the Display Log.

Note 1: At present, not all LESs are offering the 2-digit code services. Contact
the LES Operations Coordinator directly for information.

Note 2: Some 2-digit code services may be provided free of charge by LESSs,
while other services are available for a fee, in some cases at reduced
rates. For information, contact the LES directly.
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4.1.7 Displaying the send message log
1. Press the [F6] key to display the Logs menu.

Logs

1. Send Message L og

2. Receive Message Log
3.EGCLog
4. Log

Logs menu

2. Press the [1] key to show the Send Message Log. The contents are the same
as the Request Deliver Status list. (See page 4.17.)

Send Message Log

No. Message File Station LES Priority Send Status Delivery

01 ABC FURUNO KDDI Normal Waiting

02 DEF FURUNO KDDI Normal Sending

03 GHI ASDFASDF KDDI Norma 02-02-26 9:40 OCC(002)

04 JKL KDDI Normal 02-02-25 20:16

05 MNO ABCDEFGHIJ KDDI Norma 02-01-23 16:09 Complete
ENTER: Show Details

Send message log

3. Press the [1] or [L] key to choose a file.
4. Press the [Enter] key to show data.

— Up to 10 stations displayed

in case of multiple addressees Attachment file
Send Message Detall
Destination Type: E-Mail
. Attach File

Station ‘ ABC

abc@furuno.co.jp DEE
Subject

Test
LESID: 203 (KDDI) Message Ref. No. : 00001125

A

Number assigned by LES

Send message details (example: e-malil
5. Press the [Esc] key three times to return to the standby display.
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Receiving
When a message is received

Each time the FELCOM 15 receives a telex or e-mail it displays the message
“Successful Receiving message.” If Auto Receive Message Save and Auto
Receive Message Print in the Auto Mode Setup are set for ON, the message is
automatically saved and printed (except confidential and password affixed
messages).

Received message alarm

If Receive Alarm in the Auto Mode Setup menu is set for ON, the audio sounds
when a telex or e-mail is received. You may silence the alarm with the [F10] key.

Receive message

Each message received is assigned a message number. This number is also
used when saving the file to a floppy disk.

R 0 0 2 0 2 2 5. 0 0 1
Receive 0: main DTE  year month  day receive
1. ext. DTE message no.

Message number
Log

The Log (see paragraph 4.3) shows message number, priority, date and time of
transmission, LES ID and file size (in bytes) of the latest 50 received and
transmitted messages.

Printing

When Auto Receive Message Print in the Auto Mode Setup menu is set for ON,
received messages (except confidential and password affixed messages) are
automatically printed. Manual printing is also available.

Saving and filing

Received messages are filed in the Display Message List, at the terminal unit
specified with Message Output Port on the System Setup menu. The Display
Message List shows the following:

Received message no.

LES ID

Priority

File size (in bytes)

Message classification

Password for confidential messages
Date and time of transmission
Status
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4.2.2

4-24

Setting the receive alarm
An audio alarm may be set to sound when a routine or confidential telex
message or e-malil is received. The factory setting is OFF.

1. Press the [F8] key to display the Setup menu.
2. Press the [6] key to display the Auto Mode Setup menu.

Auto Mode Setup
Auto Log Print OFF
Receive Alarm OFF
Auto Receive Message Save OFF
Auto Receive Message Print OFF
Data Report & Polling Print OFF
Auto EGC Message Save
Auto EGC Message Print

Auto mode setup menu

Press the [1] or [1] key to choose Receive Alarm.

Press the [Enter] key to open the receive alarm options window.

5. To enable the audio alarm, choose ON. The alarm will be released when a
routine or confidential message is received.

6. Press the [Enter] key to close the window.

7. Press the [Esc] key twice.
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Displaying, printing received messages

Received messages (except confidential or password affixed) are automatically
printed when the Auto Receive Message Print in the Auto Mode Setup is turned
on. To print confidential or password affixed messages follow the procedure
below.

If you cannot read an e-mail attachment, because it is MIME-coded, go to
paragraph 3.10.

1. Press the [F6] key to show the Logs menu.
Logs

1. Send Message Log

2. Recelve Message Log
3. EGC Log
4.Log

Logs menu
2. Press the [2] key to display the list of received messages.

Received Message Log

MessageNo. LES Priority Size Addressee Recdate & Time Status
R0971106.001 KDDI Normal 32767 02-02-06 16:10  Saved
R0971105.002 KDDI Normal 200 CAPTAIN 02-02-0517:30
R0971105.001 KDDI Distress 1234 02-02-05 14:15  Printed
R0971024.001 KDDI Normal 8251 02-01-2413:20  Saved

Memory Available: 12345 Bytes

ENTER: Display S: Save D: Delete

Receive message log

Display message list description

Message No.: Received message no.

LES: LES name

Priority: Normal or distress

Size: Size of file in bytes

Addressee: Addressee code appears for confidential messages.
Nothing appears for routine messages.

Rec date & time: Date and time message was received.

Status: Printed: message printed

Saved: message saved to floppy disk

No display: not yet printed confidential message, or
printer malfunction

Memory available: Memory available in the terminal unit

3. Press the [1] or [{] key to choose a file. To get a partial display of a file
selected, tap the space bar. Press the [Esc] key after confirming contents.
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4. Press the [Enter] key for routine messages and messages with addressee
code (no password).

Display Receive Message <R0971123.002->

FROM FURUNO

TOFRONTIER
THE QUICK BROWN FOX JUMPS OVER LAZY DOG.
ABCDEFGHIJKLMNOPQRSTUVWXY Z. 1234567890

Ctrl+P: Print

Sample received message

For messages with both addressee code and password, the password entry
window appears. Enter the password and then press the [Enter] key. If the
password is entered incorrectly, the buzzer sounds. Reenter the password.

Receive Message Log
MessageNo. LES Priority Size Ad Rec date & Time Status
R0021106.001 KDDI Normal 767 / 5‘\ 02-11-06 16:10  Saved
R0021105.002 Normal 200 [CAPTAIN)] 02-11-05 17:30
R0021105.001 KDDI Distress 1234 v 02-11-0514:15  Printed
R0021101.001 KDDI Normal 3256 OFFHEER\ 02-11-01 3:45 Printed
R0021024.001 KDDI Normal 8251 \02-10-24 13:20 Saved

Memory Ave PASS WORD: |}

Enter: Display S: Save D: Delete

Location of password
5. To print a message, press the [P] key while pressing the [Ctrl] key.

Receive Message (SECRET)
A Appears only for confidential messages
Message No. : R0970323.001
Message Ref. No. : 00000000
LES :LESor LESID
Priority : Normal (or Distress)
Message Size : 205 characters

Recelve Date & Time : 02-02-25

Sample printout
6. Press the [Esc] key three times to return to the standby display.
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About attachments

The FELCOM 15 receives a file with an attachment over a landline two ways.
(The method depends on LES.)

* Mail main text and text mail which includes information about the attachment.

e Attachment data

— Mail and attachment file data
Attachment data
Receive Message Log

MessageNo. LES Priority Size Addressee Recdate& Time Status

4 R0021105.002 KDDI Normal 18 02-11-0517:40  Printed
R0021105.001 KDDI Normal 210 02-11-0517:30  Printed
R0021104.001 KDDI Distress 1234 02-11-04 14:15  Printed
R0021101.001 KDDI Normal 3256 OFFICER 02-11-01 3:45 Printed
R0021024.001 KDDI Normal 8251 02-10-2413:20  Saved

Memory Available: 3317 Bytes

Enter: Display S:Save D: Delete

Receive message log

Some files stored on the Receive Message Log may not be readable. Choose
the file and press the [Enter] key. If the file is unreadable, because itis in a
language other than English, press the [Esc] key to return to the Receive
Message Log. Insert a floppy disk in the disk drive and press the [S] key. Insert
the floppy disk in a PC and open the file from the PC.

One attachment
Display Receive Message <R0021105.001->

FROM : FURUNO
TO: FRONTIER

1 attachment
18 bytes, test

Text

|
Attachment name

Example of main text and text mail with attachment data
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4.2.4  Automatically printing received messages
You may automatically print received messages (except confidential or password
affixed) as follows:

1. Press the [F8] key to display the Setup menu.
2. Press the [6] key to display the Auto Mode Setup menu.

Auto Mode Setup
Auto Log Print OFF
Receive Alarm OFF
Auto Receive Message Save OFF
Auto Receive Message Print OFF
Data Report & Polling Print OFF
Auto EGC Message Save
Auto EGC Message Print

Auto mode setup menu

Press the [1] or [|] key to choose Auto Receive Message Print.
Press the [Enter] key.

Press the [1] key to choose ON.

Press the [Enter] key to close the window.

Press the [Esc] key twice.

NOo Ok

4.2.5 Saving received messages to a floppy disk

1. Press the [F6] key.
2. Press the [2] key to display the Receive Message Log.

Receive Message Log
Message No. LES Priority Size Addressee Recdate& Time Status
R0971106.001 KDDI Normal 32767 02-02-04 16:10  Saved
R0971105.002 KDDI Normal 200 CAPTAIN 02-02-0517:30 Printed
R0971105.001 KDDI Distress 1234 02-02-0514:15  Printed
R0971101.001 KDDI Norma 3256 OFFICER 02-02-01 3:45 Printed
R0971024.001 KDDI Normal 8251 02-01-2413:20  Saved

Memory Available: 3317 Bytes

ENTER: Display S: Save D: Delete

Sample delete message screen
3. Press the [1] or [|] key to choose a file. To confirm contents of a file, press the
[Enter] key. For confidential messages the password entry window appears
after pressing the [Enter] key. Enter the password and press the [Enter] key.
4. Press the [S] key to copy the file to the floppy disk. For confidential
messages the password entry window appears. Enter password and press
the [Enter] key. The password is saved to the floppy disk.

Note: If a file by that name already exists on the floppy disk, “Already exist on
FD.” appears.
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4.2.6 Automatically saving received messages to a floppy disk
You may automatically save received messages other than confidential or
password-affixed messages to the floppy disk as follows:

1. Press the [F8] key.
2. Press the [6] key to display the Auto Mode Setup menu.

Auto Mode Setup
Auto Log Print OFF
Receive Alarm OFF
Auto Receive Message Save OFF
Auto Receive Message Print OFF
Data Report & Polling Print OFF
Auto EGC Message Save
Auto EGC Message Print

Auto mode setup menu
Press the [1] or [|] key to choose Auto Receive Message Save.
4. Press the [Enter] key to open the auto receive message save options
window.
Press the [1] key to choose “ON”.
Press the [Enter] key to close the window.
7. Press the [Esc] key twice.

w

o 0

Note: To designate directory where to store receive messages, see paragraph
2.9.2.
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4.2.7

4-30

Deleting received messages

1. Press the [F6] key to display the Logs menu.
2. Press the [2] key to choose Receive Message Log.

Memory Available: 3317 Bytes

Receive Message Log
MessageNo. LES Priority Size Addressee Recdate & Time Status
R0971106.001 KDDI Normal 32767 02-02-04 16:10  Saved
R0971105.002 KDDI Normal 200 CAPTAIN 02-02-0517:30 Printed
R0971105.001 KDDI Distress 1234 02-02-05 14:15  Printed
R0971101.001 KDDI Norma 3256 OFFICER 02-02-01 3:45 Printed
R0971024.001 KDDI Normal 8251 02-01-2413:20  Saved

ENTER: Display S: Save D: Delete

Sample receive message log

3. Press the [1] or [|] key to choose the message you want to delete. You can
confirm the contents of the message by pressing the [Enter] key. For
password-affixed messages, the password entry window appears. Enter the
password and press the [Enter] key. After confirming the contents, press the

[Esc] key.

4. Press the [D] key. You are asked if you are sure to delete the message. For
password affixed-message, the password entry window appears. Enter

password and press the [Enter] key.

Receive Message Log
MessageNo. LES Priority Size Addressee Recdate & Time Status
R0021106.001 KDDI Normal 32767 02-11-06 16:10  Saved
R0021105.002 KDDI Normal 200 CAPTAIN 02-11-0517:30  Printed
R0021105.001 KDDI Distress 1234 02-11-0514:15  Printed
R0021101.001 KDDI Normal 3256 OFFICER 02-11-01 3:45 Printed
R0021024.001 KDDI Norma 8251 02-10-2412:20  Saved
Delete
Memory Available: 331 _ T No

Enter: Display S: Save D: Delete

Delete window

5. Press the [Enter] key to delete the message, or choose No and then press

the [Enter] key to escape.
6. Press the [Esc] key twice to return to the standby display.
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Log

The Log stores the particulars of the latest 50 received and transmitted
messages. When the log becomes full, the oldest message is automatically
deleted.

Displaying and printing the display log

1. Press the [F6] key to display the Logs menu.
2. Press the [4] key to show the Display Log.

2, 3, 4. 5. 6, 7 8 9 0 n
Log
1. SR Mé&ageNo. Type Pri Dae Time LES Station Size Cond
“01 S T0971110.001 TELEX Nrm 02-02-25 19:10 302 FURUNO 12345 Success
02 R R0971110.001 TELEX Dis 02-02-25 19:25 302 — — — — —~ 365 Success
50 (max)
Ctrl+P: Print

Sample display log
3. To scroll the Display Log screen, press the [ ] key several times.
4. To print the log, press the [P] key while pressing the [Ctrl] key and press the
[P] key. To stop printing, press the [Esc] key.

Display log description

1) Log no.

2) SIR S: Send message, R: Received message

3) Message No.: Message no. or file name

4) Type: Message type (Telex, e-mail, etc.)

5) Pri: Priority; Normal or Distress

6) Date: Date message was received (transmitted).

7) Time: Time message was received (transmitted).

8) LES: ID of LES which handled the message

9) Station: Transmitting station name. Blank for unregistered station or
received message.

10) Size: Size of message in bytes

11) Cond: Transmission results. Blank if a received message.
Success: Successful transmission
Fail: Failed transmission

Rejected: Message rejected by LES
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Automatic printing of display log

The Display Log can be automatically printed every 24 hours as follows:

1. Press the [F8] key to display the Setup menu.

2. Press the [6] key to display the Auto Mode Setup menu.

o0k w

Auto Mode Setup

Auto Log Print

Receive Alarm

Auto Receive Message Save
Auto Receive Message Print
Data Report & Polling Print
Auto EGC Message Save
Auto EGC Message Print

OFF
OFF
OFF
OFF
OFF

Auto mode setup menu
Auto Log Print is selected; press the [Enter] key.

Press the [1] key to choose ON.
Press the [Enter] key to close the window.

Press the [Esc] key twice to return to the standby display. The log will be

printed at 00:00 (UTC) each day.
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EGC Messages

When an EGC message is received, RECEIVING EGC MESSAGE appears at
the bottom left corner of the display. If Auto Message Save in the Auto Mode
Setup is ON, EGC messages are automatically printed. EGC messages are
automatically received, printed and saved to the terminal unit selected with EGC
Output Port on the System Setup menu. The memory capacity for EGC
message is 32 Kbytes. When the EGC message memory becomes full, the
oldest EGC message is automatically deleted.

Displaying and reprinting EGC messages
1. Press the [F4] key.
EGC

1. Display EGC Message,

2. EGC Network ID

EGC menu
2. Press the [1] key to show the Display EGC Message screen.

File Edit Transmit Reports Logs Options Setup Position StopAlarm

Display EGC Message <E0021102.023>

EGC Message --- MET Navarea Warning or MET Forecast ---
Message Sequence No. : 00472

LES 1 KDDI
Priority : Urgent
Size : 285 characters

Receive Date & Time :02-11-02 06:08 (UTC)

ZCzC

NAVAREA XI WARNING

NAVAREA X1 0752.

ARAFURA SEA.

DERELICT F/V PARTIALLY SUBMERGED ADRIFT
IN 10-12.6S 133-19.6E, GEODETIC DATUM
UNKNOWN, AT 180200Z NOV.

CANCEL 0749/02.

CtrI+P: Print CtrI+S: Save

Sample Display EGC message screen
Press the [1] or []] key to scroll the screen.
4. To print a message, press the [P] key while pressing the [Ctrl] key. To stop
printing, press the [Esc] key.
5. Press the [Esc] key to return to the standby display.

w

EGC messages can be automatically saved to a floppy disk. See paragraph
2.4.4 for details.
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Displaying EGC closed network ID (ENID)

To join a FleetNET™ service, an MES must be registered with an information
provider. The information provider adds the MES to the group which is to receive
the service, by downloading a Group Call ID (via an LES which supports
FleetNET™ broadcasts), uniquely addressed to the MES. The MES stores the
ID and can accept broadcasts from the information provider. The MES operator
cannot change this stored EGC closed network IDs (ENIDs). Up to 64 ENIDs are
stored on a non-volatile memory.

The ENID stored can be accessed for downloading and deleting via the satellite
path. It is possible for an MES operator to inhibit (or activate as required), via the
terminal unit, selected ENIDs previously downloaded.

Along with the ENID the name of the information provider is stored. In the event
that a download command is received and the ENID storage area is full, an
ENID which has been inhibited (de-activated) by the MES operator will be written
over. If none has been inhibited, then the new download is not accepted.

Follow the procedure below to inhibit or activate an ENID.

1. Press the [F4] key to display EGC menu.
2. Press the [2] key to display the EGC Network ID List.

File Edit Transmit j=e]® Reports Logs Options Setup Position StopAlarm

EGC |
1.Di EGC Network ID List

ﬂ ENTER: Activate SPACE: Inhibit Ctrl+P: Print ESC: Quit
Mark "' means activation

01 * 00001 202 FURUNO
02 * 00002 202 FURUNO
03 * 04001 202 FURUNO
04 * 04002 202 FURUNO
05 * 04003 202 FURUNO
06 * 04005 202 FURUNO
07 * 04006 202 FURUNO
08 * 04007 202 FURUNO

EGC network ID list
Press the [1] or [|] key to choose the ENID you want inhibit (or activate).
4. Press the space bar to inhibit, or the [Enter] key to activate. The asterisk
mark disappears when an ENID is inhibited.
5. Press the [Esc] key to return to the standby display.

w
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Receiving EGC distress or urgent message

When the FELCOM 15 receives an EGC distress or an urgent message, the
audio alarm sounds from its terminal unit, the Distress Alert/Received Call Unit
IC-305 and the Distress Message Controller DMC-5. To silence the alarm, do the
following:

FELCOM 15: Function key [F10] (StopAlarm) on the terminal unit
IC-305: Function key [F10] (StopAlarm)
DMC-5: [ALARM RST] key

Displaying the EGC message log

1. Press the [F6] key to show the Logs menu.
2. Press the [3] key to display the EGC Message Log.

EGC Message Log
Message No. LES Priority Size Seg. No. Rec date& Time Type

E0021118.028 KDDI Urgent 428 01641 02-11-1810:27 ME
E0021117.002 KDDI Safety 1455 02035 02-11-1705:23 U.M Rct
Memory available: 32767 Bytes

ENTER: Display S: Save D: Delete

EGC message log
Scroll:  Press the [1] or [|] key.
Display message:Press the [Enter] key.
Save message: Insert floppy disk and press the [S] key.
Delete message: Press the [D] key. The Delete window appears
and Yes is selected; press the [Enter] key.
3. Press the [Esc] key twice to return to the standby display.
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D.

DATA REPORTING AND POLLING

5.1

This chapter provides the information necessary for data reporting and polling
reception. Data reporting provides automatic data transmission at regular
intervals from your ship to your home office. When your ship receives a polling
command from your home office; that is, a request for navigation data from your
ship, it automatically transmits this data to your home office.

No operator intervention is required during polling reception.

Satellite

Data report /\/‘ E
Message report Polling
=y 7
ﬂ e S
N =

Mobile Earth Station Land Earth Station Subscriber

Data Reporting

Data reporting provides automatic data transmission at predetermined intervals
from your ship to your home office. The data are position, speed, bearing and
other data sent from a navigator or an interface unit.

The data transmitted from the FELCOM 15 is temporarily stored in a data
reporting file at the LES. When an operator at your home office accesses the
LES, the LES delivers the data to your home office. Some LESs may deliver it
without being accessed.

Data reporting can be initiated by setting a data report on the FELCOM 15 or
receiving a polling command from your home office.

FELCOM 15 offers two types of reports as follows:
» Data report (on MES signaling channel)

Refer to paragraph 5.1.1.
* Message report (on MES message channel)

Refer to paragraph 5.1.2.

5-1



5. DATA REPORTING AND POLLING

5.1.1

5-2

Setting a data report

1.

2.

3.

»

© 0N

Press the [F5] key to display the Reports menu.
—— Reports

1. Data Report

2. Message Report
3. Data Network 1D

Reports menu
Press the [1] key to choose Data Report.

—— Data Report ——

1. Data Report 1

2. Data Report 2
3. Data Report 3
4. Data Report 4

Date report menu
Press [1], [2], [3] or [4] as appropriate.
Data Report

Data Report Programming
XS o

Report Length  Position and Course/Speed
Destination
DNID
LESID
Member No.
Activation Regular Interval
Interval Time 00:10
Report Times 1 (---: No Limit)
Start Timel -
Start Time2
Start Time3
Start Time4

Data report menu

Status is selected; press the [Enter] key to open the status options window.
Press the [|] or [1] key to choose appropriate option.

OFF: Data report off

ON: Enhanced Data Report (Data report w/confirmation)

ON: Usual Data Report (Standard data report)

For assured transmission, choose ON: Enhanced Data Report.

Press the [Enter] key to close the window.

Press the [{] key to choose Report Length.

Press the [Enter] key to open the report length options window.

Press the [|] or [1] key to choose appropriate option.

Pasition only: Own position

Position and Course/Speed: Position, course and speed

Position and Course/Speed with SEA INF: Position, course, speed, water
temperature, tide, and depth

10.Press the [Enter] key to close the window.
11. Press the [{] key to choose Destination.
12.Press the [Enter] to show the DNID (Data Network ID) list.
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13. Choose DNID desired and press the [Enter] key. (LES ID and Member No.
are automatically selected according to DNID.)

14. Press the [{] key to choose Activation.

15.Press the [Enter] key to open the activation options window.

16.Press the [|] or [1] key to choose “Regular Interval” or “Daily” as appropriate.

17.Press the [Enter] key to close the window.

18.Do one of the following depending on the selection you made at step 16.

“Regqular Interval” selected at step 16

(1) Press the [{] key to choose Interval Time.

(2) Press the [Enter] key to open the interval time entry window.

(3) Key in the interval time. The interval should be at least 10 minutes.
(4) Press the [Enter] key to close the window.

(5) Press the [{] key to choose Report Times.

(6) Press the [Enter] key to open the report times entry window.

(7) Key in the report times, or press the [Back Space] key to display “---“ to
choose “No Limit” to transmit data until the “Status” setting is turned OFF.

(8) Press the [Enter] key to close the window.

“Daily” selected at step 16

(1) Press the [{] key to choose Start Time 1.

(2) Press the [Enter] key to open the start time entry window.
(3) Key in the start time, in 24-hour notation.

a) (4) Press the [Enter] key to close the window.

(5) If necessary key in start times for Start Time 2-4.

19.Press the [Esc] key to show the update window.

Data Report
Data Report Programming

Status OFF
Report Length  Position and Course/Speed
Destination

DNID

LESID

Member No.
Activation Regular Interval

Interval Time 01:00

FELERMIUEY 24 (---:NoLimit)

Start Timel : Update
Start Time2  --:-- |_________
Start Time3 --l-- Yes I No
Start Timed  --:--

Data report menu (regular interval reporting)

20.Yes is selected; press the [Enter] key to register settings.
21.Press the [Esc] key twice to return to the standby display.
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5.1.2  Setting a message report

1. Press the [F5] key to display the Reports menu.
—— Reports

1. Data Report

2. Message Report
3. Data Network 1D

Reports menu
2. Press the [2] key to display the Message Report menu.

Message Report
1. Message Report 1
2. Message Report 2
3. Message Report 3
4. Message Report 4

Message report menu
3. Press [1], [2], [3] or [4] as appropriate

Message Report
Message Report Programming
Status OFF
Station Name
Destination Type TELEX
Prefix Code
Country/Ocean Code
Station ID
Modem Type
Address
Subject
LESID
Activation Regular Interval
Interval Time 00:10
Report Times 1 (---:NoLimit)
Start Timel
Start Time2
Start Time3
Start Timed -
Report Contents NAV
File

Message report menu

PIN code is unrelated to data reporting, however it is necessary for polling
(see paragraph 5.2). Enter PIN code as shown below.

4. PIN Code is selected; press the [Enter] key to open the PIN code entry
window.

Key in PIN code, using up to eight digits. The PIN code is a password used in
message reports. When a ship receives a polling command w/PIN code from
a shore subscriber and the code matches that of the ship, the ship sends a
message report.

Press the [Enter] key to close the window.

. Press the [1] key to choose Status.

. Press the [Enter] key to open the status options window.

o

o N o
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9. Press the [|] or [1] key to choose “ON” or “OFF” as appropriate.
ON: Message report on
OFF: Message report off

10.Press the [Enter] key to close the window.
11. Press the [I ] key to choose Station Name.
12.Press the [Enter] key to display the Station List.
13.Press the [|] or [1] key to choose a station.

Note: You may sort the list by group name, station name or communication
type as follows:
Group name: Each press of [Ctrl] + [G] sorts the list by group name,
ascending or descending order.
Station name: Each press of [Ctrl] + [N] sorts the list by station nhame,
in ascending or descending order.
Comm. type: Each press of [Ctrl] + [T] sorts the list by
communication type, in ascending or descending order.

14.Press the [Enter] key to close the window.
15.For e-mail following a)-d) below. For other communication formats, go to step
16.
a) Press the [!] key to choose Subject.
b) Press the [Enter] key to show the title window.
c) Type title.
d) Press the [Enter] key to close the window.
16.Press the [1] key to choose LES ID.
17.Press the [Enter] key to display the LES List.
18.Press the [|] or [1] key to choose an LES.
19.Press the [Enter] key to close the window.
20.Press the [1] key to choose Activation.
21.Press the [Enter] key to open the activation options window.
22.Press the [|] or [1] key to choose “Regular Interval” or “Daily” as appropriate.
23.Press the [Enter] key to close the window.
24.Do one of the following depending on the selection you made at step 22.
“Regqular Interval” selected at step 22
(1) Press the [!] to choose Interval Time.
(2) Press the [Enter] key to open the interval time entry window.
(3) Key in the interval time.
(4) Press the [Enter] key to close the window.
(5) Press the [{] key to choose Report Times.
(6) Press the [Enter] key to open the report times entry window.

(7) Key in the report times, or press the [Back Space] key to display “---“ to
choose “No Limit” to transmit data until the “Status” setting is turned OFF.

(8) Press the [Enter] key to close the window.
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“Daily” is selected at step 22
(1) Press the [{] to choose Start Time 1.
(2) Press the [Enter] key to open the start time entry window.
(3) Key in the start time.
(4) Press the [Enter] key to close the window.
(5) If necessary, key in the start time of Start Times 2-4.
25.Press the [{] key to choose Report Contents.
26.Press the [Enter] key to open the report contents options window.
27.Press the [1] or [1] key to choose the contents of message report and press
the [Enter] key to close the window.

NAV: Position, speed, course

NAV+SEA INF: Position, speed, course, water temperature, current, depth

NAV(R): Position, speed, course. The difference between this and “NAV”
above is that blank areas in data are shortened to lessen toll
charge.

FILE: Choose a file. (When chosen “FILE” is activated. Choose file

with cursor and press the [Enter] key.)

28.Press the [Esc] key to show the update window.

Message Report
PIN Code 12345678
Message Report Programming
Status ON
Station Name FRNINMBTSTSES
Destination Type TELEX
Prefix Code
Country/Ocean Code 583
Station 1D 343199710
Modem Type
Subject
LESID 303 (KDDI)
Activation Daily
Interval Time 01:00
Report Times 24 (---:NoLimit)
Start Timel 08:00
Start Time2 Update
Start Time3  |e———ooo oo
Start Time4 I No
NAV
File

Message report screen

29.Yes is selected; press the [Enter] key.
30.Press the [Esc] key twice to return to the standby display.
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Automatic printing of data report, polling command

Data reports and polling commands are automatically printed, in the default state.
If you do not require automatic printing of data reports or polling commands do
the following:

1. Press the [F8] key to open the Setup menu.
2. Press the [6] key to choose Auto Mode Setup.

Auto Mode Setup
Auto Log Print OFF
Receive Alarm OFF
Auto Receive Message Save OFF
Auto Receive Message Print OFF
Data Report & Polling Print OFF
Auto EGC Message Save
Auto EGC Message Print

Auto mode setup menu

Press the [|] or [1] key to choose Data Report & Polling Print.

Press the [Enter] key to open the options window.

5. Press the [|] key to choose OFF. (Choose ON to automatically print data
report and polling command.)

6. Press the [Enter] key to close the window.

7. Press [Esc] key twice to return to the standby display.

Hw
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5.2

5.2.1
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Polling

When the FELCOM 15 receives a polling command from your home office it
automatically transmits data to your home office. The data are position, speed,
bearing and other data sent from a navigator or an interface unit.

A polling command from your home office can also activate a data report or
message report if the corresponding setting is completed on the FELCOM 15. If
a polling command with a file name is received, the FELCOM 15 transmits the
file to your home office.

Polling commands

This paragraph shows you how to make the polling command at your home
office.

There are two kinds of polling commands: one is sent on the MES signalling
channel and the other is sent on the MES message channel.

Polling command on MES signalling channel

Request a land station to make the polling command because the format varies
with land station.

Polling command on MES message channel

To make the polling command, enter D???, hyphen, PIN code (max. 8 digits),
hyphen, file name, colon.

To send file data, type a hyphen and file name. Then, only the file specified in
the directory of the Message Directory is transmitted. If neither hyphen nor file
name is entered, nav data (own ship position, course, speed, etc) is transmitted.
For PIN Code setting, refer to the next page.

File Name

)
D?7?72-XXXXXXXX-TEST:

!

PIN Code

Polling command
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PIN Code

The PIN (Personal ID Number) code is an eight-digit code number agreed
upon by communicating parties, and there is no rule for determining PIN
code. It is a password used in message reporting. When a ship receives a
polling command w/PIN code from a shore subscriber and the code matches
that of the ship, the ship sends a message report.

To register PIN code number do the following:

1. Press [F5] to show the Report menu.
2. Press the [2] key to open the Message Report menu.
3. Press [1], [2], [3] or [4] key to show the following menu.

For polling command
Message Report
|:

M essage Report Programming

Status OFF

Station Name
Destination Type TELEX
Prefix Code
Country/Ocean Code
Station 1D
Modem Type
Address
Subject

LESID

Activation Regular Interval
Interval Time 00:10
Report Times 1 (---:NoLimit)
Start Timel
Start Time2 --i--
Start Time3 --i--
Start Timed --i--

Report Contents NAV
File

Message report menu

PIN Code is selected; press the [Enter] key to open the PIN code entry
window.

Enter PIN code number (max. 8 digits).

Press the [Enter] key.

Follow from step 4 on page 5-4.
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5.2.2
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Other polling commands
Telex

P???/PIN Code/TELEX/LES number/Country number/Subscriber’s number/File
name:

E-mail

P???/PIN Code/EMAIL/LES number/ E-mail address/File name:

Public Switched Telephone Network

P???/PIN Code/PSTN/Modem type/LES number/Country number/Subscriber’s
number/File name:

Modem type is selected from T30, V21, V22B, V22, V23, V26B, V26T, V27T or
V32.

Packet Switched Data Network

P???/PIN Code/PSDN/LES number/Country number/Subscriber’s number/File
name:

Data Network Identification

P???/PIN Code/DNID/LES number/Subscriber’s number/File name:

Facsimile

P???/PIN Code/FAX/LES number/Country number/Subscriber’s number/File
name:

2-digit telex service

P???/PIN Code/SPEC/LES number/Country number/Subscriber’s number/File
name:

For ship-to-ship communication, country number is ocean region number.
Subscriber’s number includes Station ID, Telex ID, etc.

If file name is not specified (/:), position, speed, bearing, water temperature,
current and depth are transmitted. Furthermore, / is deleted (:), position, speed
and bearing are transmitted.

For example, you transmit polling command to MES of PIN code 12345678 via
KDDI station (Pacific Ocean: 203) specifying telex number 720-5644325. Then,
that MES transmits position, speed, bearing, water temperature, current and
depth.

P??7?/12345678/TELEX/203/720/5644325/:

To have other MES transmit position, speed and bearing by e-mail to
abc@furuno.co.jp, for example, use the following command.

P???/12345678/EMAIL/203/abc@furuno.co.jp:



5.2.3 Polling reception

5. DATA REPORTING AND POLLING

No operator intervention is required during polling reception.

The printer (printer PP-510 optionally available) prints the status of polling
reception and transmits data in response to polling request as shown below.

TX start frame (time) Data reporting

POLLING Message - - - Program UnreserveqData Reporting > -
[ 0003 LESID :101 (Tdnor 5.51nc)
Sub Address : 000 Member Number : 001 Response: No Response

Receivg Data & Time: 02-02-25 00:01 (UTC) Received
Polling
Start Frame: 00030 Interval: 00030 >—— TX interval Command

02-02-25 00:01 (UTC)
Data Report Program has been initiated by Polling.

POLLING Message - - - Initiate Unreserved Data Reporting - - -
D 004 LESID
Sub Address : 000

1101 (Telnor SS.nc
Member Number :001 Respongg Data Report_>
Receive Data & Time: 02-02-25 00:01 (UTC)

TX data set on Data

Start Frame: 00030 Interval: 00030

,,,,,,,,,,,,,,,,,,,,,,,,,, Report _________

Data Reported (Poll Response)

LES :Telnor S.S.Inc Date : 02-02-25

D 00D Time 00:03 (UTC)

Member No. :001 Tx message

Position LAT  10:14.03N recipient and
LON 124:36.81E TX data

02-02-25 00:06 (UTC)
Successful Data Report Sending.

; Received
Receive Message Poliing
Message No. : R0020205.002 Command
Message Ref. No. : 00616923
LES 1 KDDI
Priority : Normal
Message Size 121 characters

Receive Data & Time: 02-02-25 04:07 (UTC)
KDD INMARSAT-C SERVICE 25-FEB-02 04:02:28 UTC REF:616923
XXXXXXXXX ABCD X viaKDDI LES

D??7?2-12345678-test:test

02-02-25 04:09 (UTC)
Successful Sending message.

Sent Message TX message
DELIVERY CONFIRMATION OFF recipient and
TX data

Message File : Report Message Size : 284 characters
LES :KDDI Date : 02-02-25
Priority : Normal Time :04:09 (UTC)
Destination : TELEX 582 (IA5)
582+
Date & Time 02-02-25 04:07 (UTC)
Position LAT 12:34.56N Water Temp 321

LON 123:45.67E Water Current 22.3KTS
Course 3211 111.0
Speed 1L1KTS Depth 123.4FT

Sample MES signaling channel printout
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5.3.1

5.3.2
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DNID (Data Network Identification)

When you make a contract with an information provider, DNIDs are downloaded
from the information provider to your FELCOM 15, via the appropriate LES.

Up to 64 DNIDs can be downloaded to the FELCOM 15. You can see which
DNIDs are stored as below.

Displaying DNID

It is necessary to contract with an LES to exchange data within a group. The
LES sends a DNID (Data Network Identification) number to each member of the
group. The FELCOM 15 can store 64 DNIDs.

1. Press the [F5] key to display the Reports menu.
2. Press the [3] key to display the Data Network ID list.

Sub address—‘ Member number using DNID
Data Network ID
Mark *' means activation. CtrI+J3: Print
No. Act DNID LES Subaddr Member Text
01 * 00004 101 (0/00) 001
02 * 00004 101 002 003
03 = 23456 101 002 223
04 + 03333 101 002 044
05 = 03333 101 000 044
06 * 07777 101 000 099
o7 * 09999 101 000 088
08
09
10
*

DNID effective

Data network ID list

Note: Asterisk-marked DNIDs are available for use.

Enabling/Disabling DNID

DNID can be enabled or disabled as follows:

=

Press the [F5] key followed by the [3] key to show the Data Network ID list.
Press the [1] or [1] key to choose desired DNID from the data network ID list.
3. Press the [Enter] key to enable or disable the DNID as appropriate. An
asterisk appears next to the DNID when it is enabled.

N

Note: If a DNID is disabled during data reporting, “running data program
(poll)” is displayed and polling is cancelled.

4. Press the [Esc] key twice to return to the standby display.



6.

DISTRESS OPERATIONS

6.1

Transmitting the Distress Alert

Set the LES where to send the distress alert, referring to steps 1-3 in paragraph
6.2.

When a life-endangering situation arises on your vessel and you do not have the
time to specify the nature of distress, do the following to transmit the distress
alertto an LES.

1. Open the cover of the [DISTRESS] button on the terminal unit or the Distress
Alert Unit/Received Call Unit IC-305.

2. Press the [DISTRESS] button until the lamp in the button lights continuously
(about four seconds).

The distress alert will not be transmitted until the lamp in the button lights
continuously and the audio alarm sounds. The message “Sending Distress
Alert” appears on the screen while the distress alert is being transmitted.
When you receive acknowledgment of the distress alert from an LES, the
message “Distress Acknowledgement Received” appears on the screen, the
lamp in the [DISTRESS] button flashes slowly and the audio alarm sounds
intermittently. To silence the audio alarm, press the [F10] key on the keyboard.

Note: The [DISTRESS] button on the FELCOM 15 or the Distress Alert/Receive
Call Unit IC-305 cannot be used to silence the audio alarm for incoming
distress or EGC urgency broadcast. The [DISTRESS] button is for
transmitting distress alert for own ship. It cannot be used to silence the
audio alarm. Use the [F10] key to silence the audio alarm.
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6.2  Transmitting the Distress Alert with Nature of
Distress Specified

When a life-endangering situation arises on your vessel and there is time to
specify nature of distress and recipient (LES) of distress alert send own ship
data (position, time, speed and course) as follows:

1. Press the [F8] key to display the Setup menu.
2. Press the [1] key to display the Distress Alert Setup screen.

Distress Alert Setup

303 (KDDI)
Update Time  06:23 02-02-25 (YY-MM-DD)
Position LAT 35:00N
LON 135:00E
Protocol Maritime
Nature Undesignated
Course 187
Speed 10 KTS

Distress Alert setup screen
3. Press the [Enter] key to display the LES ID list. Press the [1] or [1] key to
choose a suitable LES and then press the [Enter] key.
Press the [1] key to choose Update Time and then press the [Enter] key.
Enter time and then press the [Enter] key.
Press the [1] key to choose Position and then press the [Enter] key.
Enter position in latitude and longitude. Enter co-ordinate with appropriate
alphabet key N, S, E or W.
8. Press the [Enter] key to close the window.

No ok

Note: The menu item Protocol is fixed at Maritime.

9. Press the [1] key to choose Nature.

10.Press the [Enter] key to display the Nature of Distress list and then choose
appropriate nature of distress. If nature of distress is not specified,
“Undesignated” is automatically selected.

Undesignated Listing

Fire/Explosion Sinking

Flooding Disabled & Adrift

Collision Abandoning ship
Grounding Further assistance required

Piracy or armed attack
11. Press the [Enter] key to close the list.
12.Press the [1] key to choose Course and then press the [Enter] key.
13.Enter course and then press the [Enter] key.
14.Press the [1] key to choose Speed and then press the [Enter] key.
15. Enter speed and then press the [Enter] key.
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16.Press the [Esc] key to show the update window.

Setup |
Distress Alert Setup
LESID 303 (KDDI)
Update Time 06:23 02-02-25 (YY-MM-DD)
Position LAT 30:00N
LON 140:00E
Protocol Maritime
Nature Grounding
Course 187
Speed 0 KTS Update
I No

Distress alert setup, update window
17.Yes is selected; press the [Enter] key to register settings.

Setup |
Distress Alert Setup
LESID 303 (KDDI)
Update Time 06:23 02-02-25 (YY-MM-DD)
Position LAT 30:00N
LON 140:00E
Protocol Maritime
Nature Grounding
Course 187
Speed 0 KTS
Distress Alert updated.
Press any key to escape.

Distress alert setup, distress alert updated
18. Open the cover of the [DISTRESS] button on the terminal unit or the Distress
Alert Unit/Received Call Unit IC-305.
19.Press the [DISTRESS] button until the lamp in the button lights continuously
(about four seconds).

The distress alert will not be transmitted until the lamp in the button lights
continuously and the audio alarm sounds. The message “Sending Distress
Alert” appears on the screen while the distress alert is being transmitted.
When you receive acknowledgment of the distress alert from an LES, the
message “Distress Acknowledgement Received” appears on the screen, the
lamp flashes slowly and the audio alarm sounds intermittently. To silence the
audio alarm, press the [F10] key on the keyboard.
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6.3

6-4

Distress Message

The distress alert provides the minimum distress information: own vessel's ID,
speed, course, L/L position and nature of distress. After receiving the distress
alert acknowledgment from an LES and you are not pressed for time, you may
send a distress message as below to provide more detailed information.

w

© 00N O

Press the [F1] key followed by the [1] key to display the editor screen.
Type distress message. Below is an example.

MAYDAY MAYDAY MAYDAY
THISIS--------memeeeees Ship's name

| NEED HELP -------------- : Type of assistance required

Sample distress message

Press the [F3] key.
Press the [1] key to choose Transmit Message. The screen should look
something like the illustration below.

Transmit ——— <[1] UNTITLED1>
Transmit Message

Norma

Message File Message now being edited  Size 63
Station Name COSt ¥ *****x% x% (U%)
Destination Type TELEX
Prefix Code
Country/Ocean Code
Station ID
Modem Type
Address
Subject
L Attach File ]
LESID
Option
Confirmation ON
Send Delay 00:00
Delivery Delay Immediate
Code IA5
[ TRANSMIT ]

Transmit message screen
Priority is selected; press the [Enter] key to open the priority options window.
Press the [1] key to choose Distress.
Press the [Enter] key to close the window.
Press the [1] key to choose LES ID.
Press the [Enter] key to open the LES list.

10 Press the [1] or [1] key to choose the LES where the distress message is to

be transmitted, preferably the one where the distress alert was transmitted.

11. Press the [Enter] key to close the LES list.
12.Press the [1] key to place the cursor on TRANSMIT.
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6. DISTRESS OPERATIONS

13.Press the [Enter] key. The display should look similar to the illustration below.

- Transmit ——— <[1] UNTITLED1>
Transmit Message
Priority Distress
Message File Message now being edited  Size 63
Station Name Cosgt *****xx* % (|SE)
Destination Type TELEX
Prefix Code
Country/Ocean Code 000
Station ID SEARCH AND RESCUE
Modem Type
- Address
Subject
L Attach File _
LESID 303(KDDI) Start
Option e e m e e e
Confirmation ON I No
Send Delay 00:00
Delivery Delay Immediate
Code IAS
[ TRANSMIT ]

Transmit message screen with send start confirmation prompt
14. Press the [Enter] key to transmit the distress message to the LES.

The message “Distress Message Call Activated.” appears (in red) while the
distress message is being transmitted. When you receive acknowledgment
from an LES, the message “Distress Message Call Acknowledged.” appears
and flashes.

Note: Country/Ocean Code and Station ID are not required in a distress
message.

Testing the Distress Button

The [DISTRESS] button on the terminal unit and the Distress Alert/Received Call
Unit IC-305 may be tested as below without transmitting the distress signal. Note
that the distress alert cannot be transmitted while testing the [DISTRESS]
button.

1. Press the [F7] key to display the Options menu.

—— Options —— Options

2. Logout 2. Logout

3. Abort 3. Abort

4, Select NCS 4, Select EGC Ch.

5. Ocean Region 5. LES Information

6. LES Information 6. Test

7. Test
FELCOM 15 functions FELCOM 15 functions
as Inmarsat MES as EGC receiver

Options menu
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2.

3.

o

™~

6-6

Press the [7] key ([6] key when the FELCOM 15 functions as an EGC
receiver) to display the Test menu.

Test

1. PV Test

2. PV Test Result
3. Self Test
4. Distress Alert Button Test

Test menu
Press the [4] key.
—— Options —
Test ,
Distress Alert Buttd Start
I No

Distress alert button mode screen
Press the [Enter] key to start the test. The buzzer sounds repeatedly,
signifying the start of the test mode. Further, the message “Distress buttons
are under test. Cancel the test mode if a real distress alert needs to sent.” is
displayed in red.

—— Options —
Test

]
Distress Alert Button Test

Distress alert button test mode.
CAUTION

INF: Distress Buttons entered into TEST MODE.

<Press ESC key to continue>

Distress alert button test
Open the [DISTRESS] button cover.
Press the [DISTRESS] button four seconds. The buzzer sounds rapidly for
three seconds and then sounds repeatedly, as in step 4. The message
“Distress Button works correctly.” appears if the button is working properly.
Close the [DISTRESS] button cover.
To escape from the test, press the [Esc] key on the keyboard of the terminal
unit twice. The test mode alarm stops and the message shown below
appears to notifying you that normal operation has been restored.

CAUTION
INF: Distress Buttons returned to NORMAL OPERATION.

<Press ESC key to continue>

Distress buttons returned to normal state
Press the [Esc] key three times to return to the standby display.



/7. OTHER FUNCTIONS

This chapter describes how to abort operation, scan NCS, choose EGC and
NCS channels and display LES information.

7.1  Aborting an Operation

You can abort transmission, receiving or scanning (on the NCS common
channel) as follows:

1. Press the [F7] key to display the Options menu.

—— Options
2. Logout
3. Abort
4. Select NCS
5. Ocean Region
6. LES Information
7. Test

Options menu (when FELCOM functions as Inmarsat MES)
2. Press the [3] key to choose Abort.

—— Options ]

Abort

Abort screen

3. Yes is selected; press the [Enter] key to abort current operation.
The message “FORCED CLEARING” replaces “SENDING” or “RECEIVING”
at the bottom of the screen. When the process has been aborted, the
message “Process Aborted. Press any key to escape.” appears.

Note: If aborting is attempted in modes other than those mentioned above, the
message “Ignored: Can not abort current process.” appears.
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7.2

7-2

Scanning NCS Common Channel

Scanning is possible when the FELCOM 15 is in idle state and functions as an
Inmarsat C receiver. If the FELCOM 15 is not in idle state the message “Ignored:
MES is not idle.” appears. Wait until the equipment becomes idle.

1. Press the [F7] key to display the Options menu.
2. Press the [5] key to display the Ocean Region menu.

—— Options —
Ocean Region

Auto
West-Atlantic
East-Atlantic

Indian

— NCS you are currently tuned to appears in reverse video.

Ocean region menu
3. Pressthe [1] or [1] key to choose another NCS and press the [Enter] key.
If Auto is selected, FELCOM 15 scans all ocean regions in turn.

—— Options —
Ocean Region

Auto |
West-Atlantic
East-Atlantic Start

Pacific |- --------

NCS scan confirmation screen

4. Yes is selected; press the [Enter] key to start the scanning.

The message “Starting Scan Process. Press any key to escape.”
appears during the scanning.

5. Press the [Esc] key twice to return to the standby display.
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7. OTHER FUNCTIONS

Choosing EGC Receiving Channel

EGC channel can be selected when the terminal unit is set to operate as an
EGC-only receiver. However, this procedure is shown for reference only;
currently there is only one EGC channel per NCS.

1. Press the [F7] key to display the Options menu.
—— Options

2. Logout

3. Abort

4. Select EGC Ch.
5. LES Information
6. Test

Options menu (when FELCOM functions as EGC receiver)
2. Press the [4] key to choose Select EGC Ch.

EGC Channel List

ENTER: Set ESC: Quit
————— e et
ploslopg | 12580* | 10840* | 11088*

EGC channel list

3. Choose desired channel and then press the [Enter] key.
4. Press the [Esc] key to return to the standby display.
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7.4  Choosing NCS Channel

You may select NCS common channel as shown below. Currently, each satellite
transmits one global beam. In the future, the satellites will transmit multiple spot
beams, namely, the NCS will have multiple channels.

1. Press the [F7] key to display the Options menu.
2. Press the [4] key to display the NCS Channel List.

—— Options —|
1. Login
9 NCS Channel List

ENTER: Set ESC: Quit
B e e bmmmmmm— - R
No | AOR (WEST) | AOR (EAST) | POR [ IOR

IID FREQ | ID FREQ |ID FREQ | ID FREQ

B e N bmmmmmm— - R

| 011 044 | 11080* | 144 | 12580* | 244 | 12580* | 344 | 10840*
0210 | 11 | | 2 | I3 |
0310 | 11 | | 2 | I3 |
0410 | 1 | | 2 | I 3 |
0510 | 11 | | 2 | I3 |
0610 | 11 | | 2 | I 3 |
0710 | |1 | | 2 | I3 |
0810 | 11 | | 2 | I 3 |

NCS channel list

3. Choose desired channel and then press the [Enter] key.
4. Press the [Esc] key to return to the standby display.

7-4



7.5

7. OTHER FUNCTIONS

LES Information

Each time you log in LES data is automatically downloaded through the NCS
common channel to the FELCOM 15, and saved to the LES Information display.
You may view this display as follows:

1. Press the [F7] key to show the Option menu.

—— Options —— Options

2. Logout 2. Logout

3. Abort 3. Abort

4, Select NCS 4. Select EGC Ch.

5. Ocean Region 5. LES Information

6. LES Information 6. Test

7. Test
FELCOM 15 functions FELCOM 15 functions
as Inmarsat MES as EGC receiver

Options menu

2. Press the [6] key (Inmarsat MES) or [5] key (EGC receiver) to show the LES
Information display.

B8-B1
LES Informatig
LESIDName Status 7 Services  TDMCh. |
201 Telnor S.S.Inc 11111000 AS----EL 11982
202 Stratos M.N. 11111000 AS----EL 11826
203 KDDI 11111000 AS---EL 11806
204 11111000 AS----EL 11762
208 KoreaTelecom 11111000 AS---EL 11778
210  Singapore Telecom 11111000 AS----EL 11842
211  Beijing Marine 11111000 AS----EL 11754
212 KDDI 11111000 AS----EL 11802

LES information display

3. Use the [1] or [|] key to scroll the list.
4. Press the [Esc] key twice to return to the standby display.

Description of LES information table

Bit No. | Status Flag Meaning
B8 Return link speed 1 600 bps
0 300 bps
B7 Operational or spare satellite 1 Operational
operation 0 Spare
B6 LES status 1 In service
0 Out of service
B5 LES status 1 Clear
0 Congested
B4 Used only by land earth stations | 1 Terrestrial links open
0 Terrestrial links closed
B3-1 Spare
Services:
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Alphabet shown only when Flag is “1” for a bit.

Bit No. | Flag Meaning Display
1B8 1 Maritime distress alerting A

0 Maritime distress alerting None
1B7 1 SafetyNET traffic S

0 No SafetyNET traffic None
1B6 1 Inmarsat-C traffic C

0 No Inmarsat-C traffic None
1B5 1 Store and Forward T

0 No Store and Forward None
1B4 1 Half Duplex H

0 No Half Duplex None
1B3 1 Full Duplex D

0 No Full Duplex None
1B2 1 Closed Network N

0 No Closed Network None
1B1 1 FleetNET Traffic F

0 No FleetNET Traffic None
2B8 1 Prefixed store and forward message supported P

0 Prefixed store and forward message not supported None
2B7 1 Land mobile alerting Not used

0 No Land mobile alerting
2B6 1 Aero-C service supported

0 Aero-C service not supported
2B5 1 ITA2 transmission supported I

0 ITA2 transmission not supported None
2B4 1 Data transmission supported B

0 Data transmission not supported None
2B3 1 Basic X.400 supported X

0 Basic X.400 not supported None
2B2 1 Enhanced X.400 supported E

0 Enhanced X.400 not supported None
2B1 1 Low power C MES supported L

0 Low power C MES not supported None

TDM Ch.: TDM channel used by LES to transmit.




8.

8.1

8.1.1

E-MAIL BY PC

Overview

The FELCOM 15 incorporates various e-mail protocols including POP3 and
SMTP. Connected to a LAN via the Ethernet(10Base-T) port on a PC, the
FELCOM 15 can send and receive e-mail using the PC’s e-mail application, for
example, Outlook Express.

Overview of mail functions

Mail gateway
Received mail may be forwarded to specific mail server.

Selective forwarding
Received mail which contains a keyword can be forwarded to the mail
address which appears after the keyword in a message.

Access restriction
A specific PC on a network can be designated to send mail.

Automatic attachment decoding
MIME-encoded mail sent from a network can be automatically decoded by
UUENCODE or BINARY decoding format.

Outgoing message size restriction

The administrator of the FELCOM 15 can specify maximum outgoing
message size (Max. size 32KB) allowable for the PC client. This allows
control over the size of mail messages which can be sent by the PC client.
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8.1.2

E-mail restrictions

The Inmarsat C e-mail system has restrictions not found on the land-based
e-mail system. Further there are some restrictions which apply to the FELCOM

15.

Use 7-bit characters in the Subject field, text and attachment. Some LES may

not use 8-bit characters (Japanese, etc). Since most LES use 7-bit

characters in the header, 8-bit characters may not be properly received.
US-ASCII characters

H

N | < | X
)
o]
<

Mmoo |wm|>|©
<|lCc|ldA|lwnw|Dm|O|T
(@]
=~
()]

Z2 | Z || R

- f n Y ~

~ o ol ESN w N = o
N

? G @) W g o] w

8.1.3

8-2

The maximum number of simultaneous transmissions is 32. Any
simultaneous transmission in excess of that amount will not be sent. When
transmitting, wait until the message “Successful Sending message.” appears
before transmitting another message.

The maximum number of characters available for the “Subject” field is 60.

The maximum number of characters per line is 1000. Characters in excess of
1000 will not be transmitted. Use maximum 1000 character per line.

The maximum number of multiple addressees is 10. Any number in excess of
that amount will not be transmitted.

Destination cannot be specified as “Bcc:”. “Bcc: is automatically changed to
“Cc:” because Bcc is not used in Inmarsat C.

Set the encoding format on the PC’s e-mail client to BASE64.

E-mail precautions

Confirm the port chosen to output received messages from the FELCOM 15.
Set Message Output Port on the System Setup menu to INT or INT+EXT.

Set the mail format at the e-mail client for “Text.” HTML increases
communication charges because of its large size.

The FELCOM 15 does not have account management functions, for example,
multiple accounts.

All received and transmitted messages (incl. those on a LAN) are saved to
the communications log. The log may be printed in real time or when desired.

Sending and receiving stations should use the same font to read each others’
messages. Use of different fonts may result in unreadable characters.
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When a file with an attachment is transmitted from land, the LES (e-mail
service provider) separately forwards the file and attachment to the intended
MES. The file name for the attachment as received at the FELCOM 15 is
“ATTACH.DAT.” For that reason request that land-based e-mail with
attachment contain the attachment file name in the text of the message.

File and accompanying attachment are sent separately regardless of the
delivery address specified with the auto delivery keyword. The message file
is delivered according to the auto delivery keyword setting and the
attachment goes to the Mail Address set on Mail Gateway.
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8.2 Connection of FELCOM 15 with single PC

Received messages are stored in the FELCOM 15. Messages are transmitted by
the PC’s e-mail client.

FURUNO PC
FELCOM 15 | LAN port
= / \
5 / ]
e — O D ———

10BASE-T(100BASE-T)
Cross cable

FELCOM 15 and single PC
Parts required

e 10BASE-T or 100BASE-T cross cable
e PC (with LAN port or LAN card)

Wiring
1. Remove the plate from the LAN port at the rear of the terminal unit.

2. Connect the cross cable between the LAN port on the terminal unit and the
LAN port on the PC.

Settings on FELCOM 15

Default settings are as below. It is not necessary to set IP address and subnet
mask if their default values are used.

IP address: 172.31.16.1
Subnet mask: 255.255.0.0
Message size: 8 KB*

Attachment decoding format: UUENCODE**

* Setting may be changed. See paragraph 8.3.5
** Setting may be changed. See paragraph 8.3.6.

Settings on PC

Set network settings on the PC. For details refer to the PC’s owner’s manual.

Item Setting
IP address 172.31.16.100
Subnet mask 255.255.0.0
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8. E-MAIL BY PC

Function Settings

For network setting, consult your shipboard LAN administrator.

Setting IP address and subnet mask

Set IP address and subnet mask as below if they are different from their default
settings, in case that DHCP is off.

1.
2.

© N OA

Press [F8] and [2] to show the System Setup menu.
Press the [1] or [1] key to choose Network Setup and then press the [Enter]

key.
Network Setup
Mail Gateway

Network setup menu
Choose Network and then press the [Enter] key.

Network
[IFNele[g=S 172. 31. 16. 1
Subnet Mask 255.255. 0. 0
DHCP OFF

Gateway

Network menu

IP address is selected; press the [Enter] key.

Enter IP Address and then press the [Enter] key.

Press the [1] key to choose Subnet Mask and then press the [Enter] key.
Enter subnet mask and then press the [Enter] key.

Press the [Esc] key to show the Update window.

Yes is selected; press the [Enter] key to update settings. The message
“Press ESC key to Restart FELCOM15.” appears if the IP Address was
changed. Press the [Esc] key to restart the FELCOM 15. If the subnet mask
setting was only changed go to the next step.

10.Press the [Esc] key three times to return to the standby display.
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8.3.2

8-6

Enabling DHCP settings

With DHCP turned on, IP address and subnet mask are automatically assigned
when a DHCP server resides on a LAN. The default DHCP setting is OFF.

O O O 0O 0 O O HUB
oo
10BASE-T(100BASE-T) 10BASE-T(100BASE-T)
Straight cable Straight cable
Jj DHCP Server

LAN port I
FURUNO PC PC
1
FELCOM 15
7 A\ 7 A\
L] L]

':' ——————
(I) ——— ——— ——

Procedure

No Ok

©

Press [F8] and [2] to show the System Setup menu.

Press the [1] or [1] key to choose Network Setup and then press the [Enter]
key.

Choose Network and then press the [Enter] key.

Press the [1] key to choose DHCP and then press the [Enter] key.

Press the [1] key to choose ON and then press the [Enter] key.

Press the [Esc] key to open the update window.

Yes is selected; press the [Enter] key to update settings. The message
“Press ESC key to Restart FELCOM15.” appears.

Press the [Esc] key to restart.

After restarting has been completed, confirm that IP address and subnet
mask have been assigned.
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8.3.3 Gateway setting

Set gateway IP address when mail is sent from a PC on a different network
through a router.

Router
Network 1
O O O O O
nooogop | HUB Network 2

o] o
J J
BAAAAAE] HUB
L LAN Port l 0 o & ] ll
PC PC PC PC PC
FELCOM 15 PC
| = [ = |

Note: If the router has DHCP, turn on DHCP in the Network menu to
automatically assign IP address, subnet mask and gateway.

Procedure

1. Press [F8] and [2] to show the System Setup menu.

2. Pressthe [1]or [1] key to choose Network Setup and then press the [Enter]
key.

3. Choose Network and then press the [Enter] key.

Press the [1] key to choose Gateway and then press the [Enter] key.

5. Enter gateway IP address (IP address set on router) and then press the
[Enter] key.

6. Press the [Esc] key to open the update window.

7. Yes is selected; press the [Enter] key to update settings. The message

“Press ESC key to Restart FELCOM15.” appears.
. Press the [Esc] key to restart.

»

0o

8-7



8. E-MAIL BY PC

8.3.4

8-8

Restricting access

Specify the IP address of the PC which is to be used to send and receive e-mail.
A PC not specified cannot send e-mail but it can receive e-mail. If no IP address
is specified, all PCs connected to the LAN can send and transmit e-mail.

For example, the IP address of the PC allowed to perform e-mail functions is
172.31.16.5. Then, only that PC on the LAN can send mail.

172.31.16.2 172.31.16.3 172.31.16.4 172.31.16.5

PC PC PC PC
LS L= = =
Cannot
/send
send mail OK

mail I
Sent mail is rejected
Can send mail

FELCOM 15
Bo 172.31.16.1

1. Press [F8] and [2] to show the System Setup menu.

2. Pressthe [1]or [1] key to choose Network Setup and then press the [Enter]
key.

3. Press the [1] key to choose Mail Gateway and then press the [Enter] key.

Cannot

Procedure

Mail Gateway

Send Limit Size (KB) 8
Attach UUENCODE
Delivery To Server
Server IP .
Address Mode FIXED
Mail Address
Auto Delivery Keyword

Mail gateway menu
Choose SMTP Enable IP Address and then press the [Enter] key.
5. Enter IP address of PC which is to send e-mail and then press the [Enter]
key.
6. Press the [Esc] key to show the Update window.
Yes is selected; press the [Enter] key to update settings.
8. Press the [Esc] key three times to return to the standby display.

»

~
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Restricting outgoing message size

The FELCOM15 administrator may limit the size of outgoing messages. When a
PC client attempts to send an e-mail message which is larger than permitted, the
message “Data size too large” appears and the message is not sent.

Note that attachments are encoded which increases messages by 1.5 times.

Procedure

1.
2.

3.

o

© 0N

Press [F8] and [2] to display the System Setup menu.

Press the [1] or [1] key to choose Network Setup and then press the [Enter]
key.

Press the [1] key to choose Mail Gateway and then press the [Enter] key.
Press the [1] key to choose Send Limit Size (KB) and then press the [Enter]
key.

Press the [1] or [1] key to choose maximum message size to send within
shipboard LAN. The choices are 2, 4, 6, 8, 10, 16 and 32 (KB).

Press the [Enter] key.

Press the [Esc] key to show Update window.

Yes is selected; press the [Enter] key to update settings.

Press the [Esc] key three times to return to the standby display.

8-9



8. E-MAIL BY PC

8.3.6

8-10

Automatically converting attachments

Using the default setting, mail (MIME encoded) sent from a PC in a network is
encoded with UUENCODE. For Inmarsat C use UUENCODE.

If the intended receiver does not use UUENCODE, an attachment may be
unreadable. In this case, change the encode format to BINARY and re-send then
message. In the BINARY setting the attachment file name is not sent to the
receiver. To switch to BINARY follow the procedure below.

Note: Some LES do not use the BINARY format. Contact your LES for details.

Procedure

1. Press [F8] and [2] to display the System Setup menu.

2. Pressthe [1]or [1] key to choose Network Setup and then press the [Enter]
key.

Press the [1] key to choose Mail Gateway and then press the [Enter] key.
Press the [1] key to choose Attach and then press the [Enter] key.

Press the [1] or [1] key to choose the encoding format for attachments:
UUENCODE, or BINARY. For Inmarsat C use UUENCODE.

Press the [Enter] key.

Press the [Esc] key to show Update window.

Yes is selected; press the [Enter] key to update settings.

Press the [Esc] key three times to return to the standby display.

ok w
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8. E-MAIL BY PC

Connection of FELCOM 15 to shipboard LAN mail server
When a mail server is installed on a LAN, received mail is forwarded to the mail
server via the LAN. The illustration below shows how mail is forwarded to the
mail server.
Mail server: 172.32.16.10
LAN domain name: ship.furuno.co.jp
Forwarding mail address: felcom@ship.furuno.co.jp (IP Address: 172.31.16.2)
Mail Server roP3
F 8.‘S’I§R : felcom - USER : smith
- Password : XXXXX — - Password : xxxxx
_ —| -
> || —
€ C ||  mmmrmmmmmmmmememseoes >
OK = NG
172.31.16.2 172.31.16.10 172.31.16.3
Domain name;
ship.furuno.co.jp
Forwarding
E-Mail message
i POP3
e
= B| --------mmememeo o > —
172.31.16.1 NG(Error) E
172.31.16.4
Note: If there is no mail server, disregard the procedure below.
Procedure
1. Press [F8] and [2] to display the System Setup menu.
2. Pressthe [1] or [1] key to choose Network Setup and then press the [Enter]
key.
3. Press the [1] key to choose Mail Gateway and then press the [Enter] key.
— Mail Gateway
Send Limit Size (KB) 8
Attach UUENCODE
Delivery To Server
Server IP -
Address Mode FIXED
Mail Address
Auto Delivery Keyword
4. Press the [1] key to choose Delivery To and then press the [Enter] key.
5. Press the [1] key to choose Server and then press the [Enter] key.
PC Mailer: A mail-dedicated PC is connected to the FELCOM 15. The mail
received by the FELCOM 15 can be read by the PCs.
Server: FELCOM 15 is connected to mail server connected to a LAN. Mall
received by the FELCOM 15 is forwarded to the mail server.
6. Press the [1] key to choose Server IP and then press the [Enter] key.
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7. Enter server IP address and then press the [Enter] key.

8. Press the [1] key to choose Address Mode and then press the [Enter] key.

9. Press the [1] key to choose FIXED.
Auto: When the keyword (entered in Auto Delivery Keyword) is found in the
text of a message, the message is sent to the address which appears after
the keyword. If the keyword is not found the mail is delivered to “Mail
Address.”
Fixed: Message is sent mail address specified in Mail Address.

10. Press the [Enter] key.

11.Press the [1] key to choose Mail Address and press the [Enter] key.

12.Enter IP address of PC where the e-mail server is to forward e-mail and then
press the [Enter] key.

13.Press the [Esc] key to open the Update window.

14.Yes is selected; press the [Enter] key to update settings. The message
“Press ESC key to Restart FELCOM15.” appears.

15.Press the [Esc] key to restart.
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Selective forwarding

When a keyword is found in a message the message is forwarded to the
address which appears after the keyword. For example, the keyword is
“/+forward+/felcom@ship.furuno.co.jp”. The keyword “+forward” is found and the
message is then forwarded to felcom@ship.furuno.co.jp.

To use selective forwarding with a land-based subscriber, you should request the
land-based subscriber to do the following:

* Insert the keyword and mail address on the first line of the message.

* Do notinsert a space in the keyword or mail address.

e Maximum number of mail addresses is 10

Mail server IP address: 172.31.16.10
LAN domain name: ship.furuno.co.jp
Mail address to forward to: felcom@ship.furuno.co.jp (IP address: 172.31.16.2)
Keyword: [+forward+/
Mail Server
POP3 POP3

- USER : felcom - USER : smith 172.31.16.3
- Password : XXXxx = - Password : XXXXX

—
—
-
MSG‘ 1

L% — MSG. 3 =

172.31.16.2

172.31.16.10

Domain name;

ship.furuno.co.jp

X
. Foy
Forwarding \
all e-Mail messages
Incoming
E-Mail message PC
FELCOM 15
L =

= Ho

172.31.16.1
172.31.16.4

TO: $KKK@FFK KKK TO: $KKK@FFK KKK TO: $KKK@FFK KKK

SU[Z/‘ECt.' ...... .

Test mail

Subject: =-+++- .. Subject: e« .

Test mail Test mail

/+forward+/felcom@ship.furuno.co.jp /+orward+/443109910@ship.furuno.co.jp This is test message-"-+"

/+forward+/smith@ship.furuno.co jp This is test message+-+++-
This is test message-"*-*+

MSG 1 MSG2 MSG3
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8-14

Procedure

12.
13.
14.

15.
16.

17.

Press [F8] and [2] to display the System Setup menu.

Press the [1] or [1] key to choose Network Setup and then press the [Enter]
key.

Press the [1] key to choose Mail Gateway and then press the [Enter] key.
Press the [1] key to choose Delivery To and then press the [Enter] key.
Press the [1] key to choose Server and then press the [Enter] key.

Press the [1] key to choose Server IP and then press the [Enter] key.

Enter mail server IP address and then press the [Enter] key.

Press the [1] key to choose Address Mode and then press the [Enter] key.
Press the [1] or [1] key to choose auto. (FIXED: Messages are delivered to
PC specified in Mail Address.)

.Press the [1] key to choose Mail Address and press the [Enter] key.
. Enter the mail address corresponding to the mail server which is to receive

mail and then press the [Enter] key. Mail not containing the keyword will be
sent to this address.

Press the [1] key to choose Auto Delivery Keyword.

Press the [Enter] key to open the auto delivery keyword entry window.
Enter auto delivery keyword. Enter characters (incl. symbol) not normally
found in your e-mail documents. Maximum 15 characters may be entered.
Upper and lower case letters are not distinguished in the search for keyword.
Press the [Esc] key to open the update window.

Yes is selected; press the [Enter] key to update settings. The message
“Press ESC key to Restart FELCOM 15.” Is displayed.

Press the [Esc] key to restart.



8.4

E-mail Client Setup Example

For network settings contact your LAN administrator.

8. E-MAIL BY PC

See the owner’s manual of the PC for how to set up for communications via a

LAN.

The settings in the table are applicable when Delivery To in the Mail Gateway

menu is set to PC Mailer.

Auto Delivery Keyword

——  Mail Gateway
Send Limit Size (KB) 8
Attach UUENCODE
Delivery To Server <———
Server IP .
Address Mode FIXED
Mail Address

Mail gateway menu

Server

PC Mailer

PC settings when “Delivery To” set to “PC Mailer” on FELCOM 15

Item Setting Remarks

POP3 server FELCOM's IP address

POP3 port no. 110 Cannot be changed
SMTP server FELCOM's IP address

SMTP port no. 25 Cannot be changed.
User account IMN number Cannot be changed
POP3 password IMN number Cannot be changed

Mail Address

Mail address of LES used
for communications

The receiver is not informed
of the mail address. The
e-mail station thru which the
e-mail was forwarded is
sent to the receiver.

Signature

Any

Signature is not passed to
the receiver.

Check-for-incoming-mail
interval

2 minutes

The FELCOM 15'’s capacity
for message storage is 32
KB. When the capacity is
reached the oldest
message is deleted to make
room for the latest.
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8.5 SMTP Error Messages

The table below shows the SMTP error messages which may appear when
communication error between the FELCOM 15 and the e-mail client is found.
Check the e-mail client whenever an SMTP error message appears.

SMTP error messages

Message

Meaning

sorry, system busy now.

The Tx message queue is full.

current LES out of service area.

Selected service provider is not within current
ocean area.

no target address.

Delivery address has not been set.

too many address.

The number of delivery addresses is more than
the system can handle.

Send message type mismatch.

Address parameter error

Send message parameter mismatch.

Address parameter error

lllegal address.

Invalid character used in delivery address, or
invalid domain name (no period entered)

Mail data abnormal.

Abnormal mail header

Data size too large.

Size of message is larger than set with Send
Size Limit on the Mail Gateway menu.

Your address access denied.

The SMTP Enable IP Address on
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9.

MAINTENANCE,
TROUBLESHOOTING

9.1

This chapter provides the information necessary for the maintenance and
checking of the FELCOM 15. Please review the safety information at the
beginning of this manual before attempting any maintenance procedures.

General Checking and Maintenance

Turn off the power before conducting any maintenance procedures other than
the cleaning of the terminal unit.

NOTICE

Do not apply paint, anti-corrosive sealant or contact spray
to coating or plastic parts of the equipment.

Those items contain organic solvents that can damage coating
and plastic parts, especially plastic connectors.

Cleaning the terminal unit

Wipe the LCD carefully to prevent scratching, using tissue paper and an LCD
cleaner. To remove dirt or salt deposits, use an LCD cleaner, wiping slowly with
tissue paper so as to dissolve the dirt or salt. Change paper frequently so the
salt or dirt will not scratch the LCD. Do not use solvents such as thinner, acetone
or benzine for cleaning; they can remove paint and marks or deform the
equipment.

Checking connectors and earth terminal

Check that the connectors and earth terminal on the terminal unit are tightly
fastened. If the copper strap (earth material) has rusted, clean it.

Floppy disk drive head

The floppy disk is coated with a magnetic material which stores the information
entered into the disk. If this material is damaged by foreign material adhering to
the disk drive head it may not be possible to read from or write to the disk. Clean
the head regularly with a cleaning floppy disk to prevent loss of data.

When the power can’t be turned on

When the terminal unit cannot be turned on do the following:

e Check that the power cable connector on the rear panel of the terminal unit for
tightness.

e Check if the ship’s mains switchboard is turned on.

e Have a qualified technician check the power voltage at the power connector
on the rear of the terminal unit.
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9.2

9.2.1

9.2.2

9-2

Diagnostics

The system is equipped with a diagnostic test which checks it for proper
operation.

Self test at power on

The terminal unit performs the ROM sum test and RAM read and write test when
turned on. If the test results are normal the equipment goes into standby. If error
is found you cannot transmit.

Testing the terminal unit through the keyboard, displaying
program version no.

This test can only be initiated from the main terminal and it must be idle
condition to execute the test.

1. Press the [F7] key to display the Options menu.

—— Options —— Options

2. Logout 2. Logout

3. Abort 3. Abort

4. Select NCS 4. Select EGC Ch.

5. Ocean Region 5. LES Information

6. LES Information 6. Test

7. Test
FELCOM functions as FELCOM functions as
Inmarsat MES EGC receiver

Options menu

2. Press the [7] key ([6] key if FELCOM functions as an EGC receiver) to
display the Test menu.

—— Options ]

Test

1. PV Test

2. PV Test Result
3. Diagnostic Test
4., Distress Alert Button Test

I —

Test menu
3. Press the [3] key to choose Diagnostic Test.

—— Options
Test |
Diagnostic Test

Start window

4. Yes is selected; press the [Enter] key to start the test. The message “Now
testing” (flashing) appears during the testing.



9.3

9.3.1
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When the test is completed, the screen shows the test results as shown at
the top of the next page.

Options —]

Test

1
Diagnostic Test
TERM CPU 1650162-XX  RFCON CPU 1650159-XX |-<— Program No.

(XX = Version No.)

ROM OK ROM OK
RAM OK RAM OK
DRAM OK EEPROM OK

GPS* OK
Press any key to escape.

* = Internal GPS. "**" shown when no internal GPS receiver is installed.

Sample communication unit self test results

The results are shown as OK or NG (No Good), and any NG is accompanied
by the audio alarm. For any NG, contact your dealer for advice.

5. Press the [Esc] key to stop the test and return to the Test menu.

Note: Diagnostic test-related error messages appear at the bottom of the screen
as follows:
TROUBLE: RFCON CPU ROM NG
TROUBLE: RFCON CPU RAM NG,
TROUBLE: RFCON CPU EEPROM NG.

Performance Verification (PV) Test

After the FELCOM is installed, the installer usually confirms that it is functioning
properly, by logging in and conducting the PV test. This test consists of the
receiving a test message from an LES, transmitting a message to an LES and a
distress alert test.

The results of the test appear on the PV test result display.

The PV test cannot be conducted from an auxiliary terminal unit. Note that the
test can also be initiated by an NCS.

PV test sequence

1. Choose PV Test from the Test menu.

The MES requests an NCS to conduct the PV test.

NCS acknowledges request for testing.

The MES, upon receiving acknowledgment from NCS, goes into pending
state.

NCS will choose an LES to perform the test.

The LES transmits a test message to the MES.

The MES transmits a test message to the LES.

The LES receives test message.

The MES automatically transmits the distress alert test within two minutes
after completion of step 8.

o

©ooNOo O
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10.When the distress alert test is finished, the LES sends the results of the PV
test to the MES.

9.3.2 PV test procedure

1. Confirm that the terminal unit is in idle condition and logged in.
2. Press the [F7] key to display the Options menu.

3. Press the [7] key to choose Test.

4. Press the [1] key to choose PV Test.

—— Options —]

Test 1

PV test screen
5. Yes is selected; press the [Enter] key to transmit the PV test request to NCS.

—— Options

Test |
PV Test

Starting PV Test Process.
Press any key to escape.

PV test screen

Note: If the terminal unit is not idle when the test is initiated, the screen
displays “Ignored: MES is not idle now. Cannot start PV Test.” And if
you are not logged in, “Ignored: MES is not Login. Please operate
Login.” appears.

6. Press the [Esc] key to return to the standby display.
7. The (automatic) testing sequence is as follows:
a) The screen displays “Current State: Idle (pending!)” when you receive the
acknowledge signal from the NCS.
b) When preparations for testing have been completed, “Current State:
TESTING” appears at the bottom of the screen. Further, the following
message appears.

Automatic test mode: Normal communication disabled.
Do not press any distress button unless you are in distress.

c) Receive a message from the LES. Send a test message to the LES.

d) Then, the distress alert test is automatically conducted after you have sent a
test message. Do not operate the equipment at this time.

e) When testing has been completed, “Current State: IDLE” appears at the
bottom of the screen.
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8. The test results appear on the PV Test Result screen. See the next section
for how to interpret the results.

Displaying PV test results

1. Atthe standby display, press the [F7] key to display the Options menu.
2. Press the [7] key to display the Test menu.

—— Options
Test
2. PV Test Result

3. Diagnostic Test
4. Distress Alarm Button Test

Test menu
3. Press the [2] key to choose PV Test Result.
—— Options —]
Test |
PV Test Result
Ctrl+P: Print  ESC: Quit
Test Date & Time 02-02-25 01:58 (UTC)
L_| Attempts First attempt
BBER Pass

Distress Alert
Signal strength

Overall Result

Shore-to-Ship Attempts ~ First attempt
Ship-to Shore Attempts  First attempt

Pass (Test OK)
Pass (Greater than Std level + 10dB)

Pass (Applicable tests pass)

Sample PV test results

4. To return to the standby display, press the [Esc] key three times.

Interpreting the PV test results display

Test Date & Time:
Attempts:
BBER:

Shore-to-Ship Attempts:
Ship-to-Shore Attempts:
Distress Alert:

Signal Strength:

Overall Result:

Date and time of test

Number of times the PV test was conducted.
Bulletin Board Error Rate (%). “Pass” appears for no
error.

Number of tests initiated by LES.

Number of tests initiated by MES.

“Pass (Test OK)” appears for successful testing.
“Pass” appears if signal strength is greater than
standard level.

“Pass” appears for satisfactory completion of the
test.
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9.4

9-6

System Status Monitor

The system status monitor, which is always displayed, provides date, time,
equipment status and navigation data.

File Edit Transmit EGC Reports Logs Options Setup Position StopAlarm
IMN: 443156710
Date 02-02-25 BBER 000
Time 01:32 (UTC) CIN OK ( 0dB)
Send Level OK( 0
Position LAT 34:30.00N Rx AGC Level OK (254)
LON 135:00.00E REF Offset Freq OK( OHz
Waypoint LAT Synthe Local OK
LON VCXO Control 131
Course 345.5 DEG
Speed 10.2KTS
Current NCS 344 (IOR) LOGOUT Antenna Power Supply  OK
Current Channel  NCSCC
Current TDM NCSCC Water Temperature 68.2 DEG
MES Status Idle Water Current
GPS Status Forkk Direction 232 DEG
Speed 19 KTS
DCE Memory 32818 Bytes free Depth
Current State: IDLE Retuning 02-02-25 01:32 (UTC)
NCS: IOR LOGOUT LAT: 34:30.00N
DCE F15 Ver. ## LON: 135:00.00E

##: Program Version No. of RF CON Board

System status monitor display

Interpreting the system status monitor

Date:
Time:
Position:

Waypoint:
Course:

Speed:

Current NCS:
Current Channel:
Current TDM:
MES Status:
GPS Status:

Current date

Current time

Own ship’s L/L position (either manual entry or
automatic input by navigator)

L/L position of destination waypoint set on navigator
Course

Ship’s speed

NCS your vessel is logged in with

Channel in use

Channel TDM

Operational status of MES

Receiving signal status from GPS receiver.
CST: Cold Start

ACK: Acquired; Almanac data acquired

IMP:  Impossible; cannot receive GPS signal

INT: Interrupted; object interfering with reception
of GPS signal

ALM: Receiving the almanac

2D, 3D: Position-fixing method by 2D or 3D



DCE Memory:
BBER:
C/N:

Send Level:

RX AGC Level:

REF Offset Freq:
Synthe Local:
VCXO Control:

Antenna Power Supply:

Temperature*:
Water Current*
Direction:

Speed:
Depth*:

9. MAINTENANCE, TROUBLESHOOTING

Memory remaining in communication unit

Bulletin Board Error Rate (%)

Check of circuit status with LES, receiving circuit in
antenna unit and RF CON/CPU Board in
communication unit. OK appears for figure greater
than 31.

TX level check. At transmission, OK appears for
figure greater than 123. At reception, OK appears for
figure lower than 32.

Check of the receiving circuit of the antenna unit and
the RF CON/CPU Board in the communication unit.
OK appears for figure greater than 60.

OK appears for figure lower than 150.

Check of RF CON/CPU Board.

Oscillator frequency control value.

NG appears for discontinuity or short in antenna
cable. OK is shown if the antenna is receiving
electrical power.

Water temperature

Tidal current direction
Tidal current speed
Depth of water

* = Requires data from appropriate sensor.
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9.5

9.6

9-8

Replacing the Battery

The lithium battery in the terminal unit is used to backup system settings when
the power is turned off. The life of this battery is about five years, however actual
life depends on usage. When the battery is dead, the terminal unit automatically
reverts to default system settings. When this occurs, contact your dealer to
request replacement of the battery.

Lithium Battery

Name: BATT(MN-LI)
Code No.: 000-144-941-10
Type: CR2450-F2ST2L

Replacing the Fuse

The 15A fuse (for 12 VDC) or 7A fuse (for 24 VDC) in the power cable protects
the equipment from overcurrent and reverse polarity. If the fuse blows, find out
the case before replacing it. If it blows again after replacement, contact your
dealer for advice. Be sure to use the correct fuse. Use of a wrong will damage
the equipment and void the warranty.

/\ CAUTION

Use the proper fuse.

Use of a wrong fuse can result in damage
to the equipment.

Fuses

12VDC

Code No.: 000-155-827-10
Type: FGBO 125V 15A PBF
24VDC

Code No. 000-155-831-10
Type: FGBO 125V 7A PBF
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Error Messages

This section describes the more commonly seen error messages and the means
to restore normal operation. If normal operation cannot be restored, contact your

dealer for advice.

Equipment trouble messages

Messages in this category are prefixed with “TROUBLE:”.

Equipment trouble messages

Error Message

Meaning

Action

ANT power voltage
abnormality.

Antenna power voltage.

Have a licensed
radiocommunications
technician check the set.

Carrier power level.

Carrier power level too high or
too low.

Have a licensed
radiocommunications
technician check the set.

DISTRESS ALERT
UNIT Fault.

Trouble at Distress Alert

Unit/Received Call Unit IC-305.

Check that the IC-305 is
powered and connected to
the FELCOM.

DMC connection
abnormality.

Trouble at Distress Message
Controller DMC-5.

Check that the DMC-5 is
powered and connected to
the FELCOM.

EEPROM ERROR.

EEPROM trouble.

Contact a FURUNO agent
or dealer for advice.

ALARM UNIT
Fault.

Trouble at Alarm Unit IC-306.

Check that the IC-306 is
powered and connected to
the FELCOM.

Invalid MES ID, This
equipment is
defected. Please
contact FURUNO.

MES ID is corrupted.

Have a licensed
radiocommunications
technician check the set.

Synthesizer
UNLOCK.

Synthesizer unlock.

Have a licensed
radiocommunications
technician check the set.
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9.7.2

9-10

Warning messages

Messages in this category are prefixed with “WARNING:”

Warning messages

Error Message

Meaning

Action

BBER over 80%.
Scanning NCS start
manually.

BBER (Bulletin Board Error
Rate) exceeded 80%.

Select NCS manually.

Cannot enter new
DNID. Memory full for
DNIDs.

Memory for DNIDs is full.

Delete unnecessary
DNIDs to enter new ones.

Cannot enter new
ENID. Memory full for
ENIDs.

Memory for ENIDs is full.

Delete unnecessary
ENIDs to enter new ones.

Cannot find NCS CC in
all region. Scanning is
continued.

No NCS found in region.

Scanning automatically
continues.

Cannot find NCS CC in
preferred region.
Scanning all region is
started.

NCS could not be found in
region selected. Scanning
started to find NCS.

If NCS could not be
found, contact you dealer
for advice.

External NAV
equipment failure.

No navigation data from
navigator.

Check navigator.

Internal GPS UNIT
failure.

GPS signal could not be
detected.

Internal GPS receiver
may be damaged if this
message appears
frequently. Contact your
dealer for advice.

Synchronization loss.
Please change EGC
channel.

Your station is not
synchronized with selected
EGC channel.

Change EGC channel.

Synchronization loss.
Please check the
current ocean region.

Your station is not
synchronized with selected
NCS.

Change NCS.
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Menu Tree

F1: File

— 1.
— 2.
— 3.
— 4.
— 5.
— 6.
— 7.
— 8.
— 9.

New

Open

Close

Save

Delete

Rename

Print

Format Disk — 2HD (1.44MB), 2DD (720kB)
MIME (Decode)

F2: Edit
— 1. Cut
— 2. Copy
— 3. Paste
— 4. Insert (With Citation)
— 5. Select All
— 6. Search or Replace 1. Search —[ Search Word
—[ Direction Forward, Back
2. Replace Search Word
Replace Word
Direction Forward, Back
Query or All — Query, All

. Goto Line 1. Top of Text
E 2. End of Text
3. Goto Line — Chooses line to go to.

. Time or Pos. Ins —[ 1. Time

2. Position

. Change Window

AP-1
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F3: Transmit

— 1. Transmit Message —

— Priority
— Message File
[ Station Name

Normal, Distress

I Destination Type

| Prefix Code (Prefix selected)

— Country/Ocean Code
| Station ID
— Modem Type

(FAX, FAX prefixed selected)

— Address (E-mail, SMS)
| Subject (For e-mail)

| Attach File (For e-mail)
— LEDID

— Option )
Confirmation

Send Delay ——
Delivery Delay
- Code
— TRANSMIT

— 2. Cancel Select Message
— 3. Request Delivery Status — Select Message
F4: EGC

1. Display EGC Message
2. EGC Network ID

-

AP-2

TELEX

— FAX

— E-Mail

— CSDN

— PSDN

— X400

— DNID

— SPEC

— TELEX (Prefixed)
— FAX (Prefixed)
— PSDN (Prefixed)
— X400 (Prefixed)
— DNID (Prefixed)
— SPEC (Prefixed)

T30 FAX

— V21 V.21 300bps Duplex

— V22 V.22 1200bps Duplex

— V22B V.22bis 2400bps Duplex
— V23 V.23 600/1200bps

— V26B V.26bis 2400/1200bps

— V26T V.26ter 2400bps Duplex
— V27T V.27ter 4800bps/2400bps
— V32 V.32 9600bps Duplex

— Other

ON, OFF

00:00 - 99:59; 00:00
Immediate, Deferred
IA5, ITA2, DATA



F5: Reports
— 1. Data Report —

— 2. Message
Report

— 1. Data Report 1 —

APPENDIX B TECHNICAL DATA

— Status

— Report Length ————————7—

— Destination

— 2. Data Report 2
— 3. Data Report 3
— 4. Data Report 4

— 1. Message Report 1 T PIN Code

— Activation
~Interval Time

(Regular Interval chosen)
— Report Times
~ Start Time 1 (Daily chosen)—
~ Start Time 2 (Daily chosen)—
~ Start Time 3 (Daily chosen)—
— Start Time 4 Daily chosen) —
Same as Data Report 1
Same as Data Report 1
Same as Data Report 1

— Status
— Station Name
— Destination Type
— Prefix Code (Prefix chosen) 1~
— Country/Ocean Code B
— Station ID —
- Modem Type —— [~

(FAX, FAX Prefixed chosen) | [~
— Address B

(E-Mail, SMS chosen) B
— Subject (E-Mail chosen) B

OFF

ON: Enhanced Data Report
ON: Usual Data Report
Position Only

Position and Course/Speed
Position and Course/Speed
with SEA INF

DNID selection

Regular Interval, Daily
00:10-99:59; 00:10

1-999; 1, - - - (No Limit)
00:00-23:59
00:00-23:59
00:00-23:59

Max. 8

ON, OFF
Subscriber selection
TELEX

FAX

E-Mail

SMS

PSDN

X400

DNID

SPEC

TELEX (Prefixed)
FAX (Prefixed)
PSDN (Prefixed)
X400 (Prefixed)
DNID (Prefixed)
SPEC (Pefixed)

“— T30 FAX

— V21 V.21 300bps Duplex

— V22 V.22 1200bps Duplex

— V22B V.22bis 2400bps Duplex
— V23 V.23 600/1200bps

— V26B V.26bis 2400/1200bps
— V26T V.26ter 2400bps Duplex
— V27T V.27ter 4800/2400bps
— V32 V.32 9600bps Duplex

— Other
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— LESID LES selection
— Activation Regular Interval, Daily
~ Interval Time ———— 00:10 - 99:59; 00:10
(Regular Interval chosen)
~ Report Times ——— 1-999; 1, - - - (No Limit)

— Start Time 1 (Daily chosen) — 00:00 - 23:59
~ Start Time 2 (Daily chosen) — 00:00 - 23:59
~ Start Time 3 (Daily chosen) — 00:00 - 23:59
— Start Time 4 (Daily chosen) — 00:00 - 23:59

— Report Contents ——————— NAV, NAV+SEA INF,
NAV (R), FILE
- File (File chosen) — File selection

— 2. Message Report 2 — Same as Message Report 1
— 3. Message Report 3 — Same as Message Report 1
— 4. Message Report 4 — Same as Message Report 1
— 3. Data Network ID

F6: Logs
1. Send Message Log
2. Receive Message Log
3. EGC Log
4. Log

F7: Options (FELCOM functions as Inmarsat MES)

— 1. Login——  Yes, No
— 2. Logout —  Yes, No
— 3. Abort— Yes, No
— 4. Select NCS
— 5. Ocean Region —— Auto, West-Atlantic, East-Atlantic, Pacific, Indian
— 6. LES Information
— 7. Test 1. PV Test Yes, No
2. PV Test Result
3. Diagnostic Test —— Yes, No

4, Distress Alert Button Test — Yes, No

F7: Options (FELCOM functions as EGC receiver)

— 1. Login—— Yes, No
— 2. Logout — Yes, No
— 3. Abort —  Yes, No

— 4. Select EGC Ch.
— 5. LES Information

— 6. Test 1. PV Test Yes, No
— 2. PV Test Result
— 3. Diagnostic Test ————— Yes, No
L 4. Distress Alert Button Test — Yes, No
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F8: Setup
— 1. Distress Alert Setup —

— 2. System Setup

— LESID
— Update Time
— Position
— Protocol
— Nature

— Course
— Speed
— System Date & Time ——
— IMN
— MES Operation Mode —
— Nav Port

— Active Port

— Message Output Port —
— EGC Output Port
— Network Setup

— Command Window
(For service technicians.)

APPENDIX

LES selection

00:00 - 23:59

Latitude and longitude input

Maritime

Undesignated, Fire/Explosion, Flooding,
Collision, Grounding, Listing, Sinking,
Disabled & Adrift, Abandoning ship
Further assistance required,

Piracy or Armed attack

0-999;0

0-99;0

Date input

IMN input

INMARSAT-C, EGC

OFF, EXT, INT

INT, ALL

INT, EXT, INT+EXT, AUTO

INT, INT+EXT

Network IP Address
Subnet Mask
DHCP —— ON, OFF
Gateway

Mail Gateway — SMTP Enable IP Address
— Send Limit Size (KB) — 2, 4,
6, 8,
10, 16,
32
— Attach ———— UUENCODE,
BINARY
— Delivery To — Pc Mailer,
Server
— Server IP
(Server chosen)
— Address Mode - FIXED,
(Server chosen)Auto
— Mail Address
(Server chosen)
— Auto Delivery Keyword
(Auto chosen)
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— 3. Editor Setup —— Text Mode ———— Telex, Ascii
— Edit Mode — Insert, Overwrite
— Word Wrap —— ON, OFF
— Line No. ——  ON, OFF
— Tab Width — 2 Char, 4 Char, 8 Char
— Column Width Telex (Fixed at 69), ASCII (40 - 80, 69)
— Cursor Type Block, Underline
— Scroll — Full Screen, Half Screen
— 4. Terminal Setup Date Disp. Form — YY-MM-DD, MMM-DD-YY, DD-MMM-YY
Currency Unit SDR, US$, EUR, YEN, OTHER (Currency unit input, 4 digits max.)
Screen Saver ON, OFF
Window Color —— Window Color Setup — Window — RCV Message Display,
EGC Message Display,
EDIT 1, EDIT 2,
Function, SUB Menu 1,
SUB Menu 2,
SUB Menu 3,
SUB Menu 4,
Message,
Base Window
— Fore Color]— L-WHITE, YELLOW,

— Back Color! L-MAGENTA, L-RED,
L-CYAN, L-GREEN,
L-BLUE, GRAY,
WHITE, BROWN,

MAGENTA, RED,

CYAN, GREEN,
BLUE, BLACK
— Default Color —— Yes, No
— 5. EGC Setup — 71— Additional Position — 1 position
— Navarea — 9 areas max.
— Fixed Area
— Waypoint —  ON, OFF

(Destination waypoint set
on navigator)

— Station Code A-Z

— Type of Message
— lce reports ———  ON, OFF
— Meteo. forecasts ON, OFF
— Pilot service ——— ON, OFF

— DECCA messages — ON, OFF
— LORAN messages — ON, OFF
~ OMEGA messages—— ON, OFF
~ SATNAV messages — ON, OFF
— Other navaid msg —— ON, OFF
~ QRU (no message)— ON, OFF
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— 6. Auto Mode
Setup

— 7. E-mail Setup

— Auto Log Print ON, OFF
— Receive Alarm ON, OFF
— Auto Receive Message Save —— ON, OFF
— Auto Receive Message Print —— ON, OFF
— Data Report & Polling Print ON, OFF
— Auto EGC Message Save —— System

— 9. Configuration —

LES setting

— 8. Directories —[ Message Directory
EGC Message Directory

— 1. Station List
(Max. 99 stations)

— FleetNET
— SafetyNET
(Routine)

— SafetyNET
(Safety)

— Auto EGC Message Print —

— SafetyNET
(Urgent&Distress)

— System

— FleetNET

— SafetyNET
(Routine)

— SafetyNET
(Safety)

— Station Group
— Station Name
— Destination Type —
— Prefix Code

(Prefix chosen)

— Country Code

— Station ID

— Modem Type
(FAX, FAX
prefixed chosen)

— E-Mail Address

— Remarks

(E-Mail, SMS chosen)

APPENDIX

ON, OFF
ON, OFF
ON, OFF

ON, OFF
ON, OFF

ON, OFF
ON, OFF
ON, OFF

ON, OFF

Max. 5 characters

Max. 5 characters

TELEX

FAX

E-Mail

SMS

PSDN

X400

DNID

SPEC

TELEX (Prefixed)

FAX (Prefixed)

PSDN (Prefixed)

X400 (Prefixed)

DNID (Prefixed)

SPEC (Prefixed)

T30 FAX

V21 V.21 300bps Duplex
V22 V.22 1200bps Duplex
VV22B V.22bis 2400bps Duplex
V23 V.23 600/1200bps
V26B V.26bis 2400/1200bps
V26T V.26ter 2400bps Duplex
V27T V.27ter 4800/2400bps
V32 V.32 9600bps Duplex
Other

Max. 20 characters
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F9: Position
': LAT
LON

F10: Stop Alarm

AP-8

— 2. LES List
(44 per oceanl E
region)

— 5. E-Mail/SMS[O —
Service List —
(Max. 16) —

— 6. Save/Load —[

Name

Remarks

Charge (TELEX - SPEC) ——
— 3. EGC Channel List (20 per ocean region)
— 4. NCS Channel List (20 per ocean region)

Service LES Name
Service ID (E-mail)
Service ID (SMS)
LES ID (AORW)
LES ID (AORE)
LES ID (POR)
LES ID (IOR)

To:

Cc:

Subject:

Separator:
SMS:

Attach File (MIME)

Save to FD
Load from FD

Max. 15 characters
Max. 20 characters
Enter charges per 256 bit

Max. 19 characters
Max. 9 characters
Max. 4 characters

3 digits

3 digits

3 digits

3 digits

Max. 9 characters
Max. 9 characters
Max. 9 characters
Max. 9 characters
Max. 4 characters
OFF, ON (BASE64)
ON (UUENCODE)
1. ALL

2. Station List

3. LES List

4., E-Mail/SMS Service List
5. Other
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International Telex/Telephone Country Code List

Area and Country nglnet?;%%%e Teleégggntry Remarks for Telex Code
Afghanistan 93 79
Alaska 1 200
Albania 355 604
Algeria 21 408
American Samoa 684 770
American Virgin Is. 1 208 Telex calls to former WUI subscribers, insert the figure
"9" after the destination code "208".
Andorra 33 590
Angola 244 991
Anguilla 1 391
Antigua & Barbuda 2 393
Argentina 54 33 Disregard the figure "0" at head of subscriber number.
Armenia 7 684
Aruba 297 303 Subscriber numbers are 2XXX or 5XXX
Ascension 247 939 Manual calls 3XXX
Australia 61 71
Australian External 672 766
Territories
Austria 43 a7
Azerbaijani 994 784
Azores Is. 351 404 Destination code is the same as for Portugal.
Bahamas 1 297
Bahrain 973 490
Bangladesh 880 780
Barbados 1 392
Belarus 7 681
Belgium 32 46
Belize 501 371
Benin 229 972
Bermuda 1 290
Bhutan 975 890
Bolivia (Rep. of) 591 371
Bolivia (ENTAL) 309
Bosnia-Hercegovina 387 600
Botswana 267 962
Brazil 55 38 Disregard the figure "0" at head of subscriber number.
British Virgin Is. 1 292
Brunei Darussalam 673 809
Bulgaria 359 67
Burkina Faso 226 978
Burundi 257 903
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Area and Country Cgﬁlrﬁ?;'%r(‘)%e Teleécc):ggntry Remarks for Telex Code
Cambodia 855 807 Kampuchea Rep.
Cameroon 237 970
Canada 1 21 Disregard the figure "0" at head of subscriber number.
{ 26
Canary Is. 34 52 Destination code is the same as for Spain.
Cape Verde 238 993
Cayman Is. 1 293
Central Africa Rep. 236 971
Chad 235 976
TCH subscribers 2XXXXX
ENTEL subscribers 5XXXXX
Chile 56 34 TRA subscribers 3XXXXX
TECOM subscribers 6XXXXX
VTR CM subscribers 4XXXXX
China 86 85
Christmas Is. (Aus) 672 766
CIS (formerly USSR) 7 64
Cocos-Keeling Is. 672 766
Colombia 57 35 Disregard the figure "0" at head of subscriber number.
Comoros 269 994 Manual calls
Congo 242 981
Cook Is. 682 772
Costa Rica 506 376
Cote d'lvoire 225 983 Ivory Coast
Croatia 385 599
Cuba 53 28
Cyprus 357 605
Czechoslovakia 42 66
Denmark 45 55
Diego Garcia 246 938
Djibouti 253 979
Dominica 1 394
201 RCA subscribers 4XXXXX
Dominican Rep. 1 202 For subscriber number beginning with 346, disregard
"346" at head of subscriber number.
241 AGEM IR subscribers 61XX
Ecuador 593 308
Egypt 20 91
El Salvador 503 373
Estonia 372 537
(formerly USSR)
Ethiopia 251 980

AP-10




APPENDIX

Area and Country C;)rslnetrr);(():r;%e Tele)égggntry Remarks for Telex Code
Falkland Is. (Malvinas) 500 306
Faroe Is. 298 502
Fiji 679 701
Finland 358 57
France 33 42
French Guiana 594 300
French Polynesia 689 702
Gabon 241 973
Gambia 220 996
Georgia 7 683
Germany (Fed, Rep. of) 49 69 formerly East Germany
49 { 41 formerly West Germany
Ghana 233 94
Gibraltar 350 405
Greece 30 601
Greenland 299 503
Grenada 1 395
Guadeloupe 590 299
Guam (RCA) 671 700
Guatemala 502 372
Guiana 594 300
Guinea Conakry 224 995 Manual calls
Guinea Bissau 245 969
Guyana 592 295
Haiti 509 203 RCA subscribers 9XXX
704 RCA subscribers 8XXX or 2968XX
705 ITT subscribers 743XXX
Hawaii 1 708 WUI subscribers 63XXX or 63XXXX
709 WUH subscribers 39XXXX
(773) Telex calls to HTC subscribers can be made using
Semi-automatic calls.
Honduras 504 374
Hong Kong 852 802
Hungary 36 61
Iceland 354 501
India 91 81
Indonesia 62 73 Disregard the figure "0" at head of subscriber number.
Iran 98 88
Irag 964 491
Ireland 353 500
Israel 972 606 Disregard the figure "0" at head of subscriber number.
Italy 39 43
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Area and Country C(Iﬁlrﬁ?;]%%%e Teleégggntry Remarks for Telex Code
Jamaica 1 291
Japan 72 KDDI (for 5 digits)
81 NTT
Jordan 962 493
Kazakhstan 7 785
Kenya 254 987
Kiribati 686 761 Subscriber numbers are 770XX
Korea (Demo, People's 850 (899)
Rep. of)
Korea (Rep. of) 82 801
Kuwait 965 496
Kyrgyzstan 7 788
Lao 856 804
Latvia (formerly USSR) 371 538
Lebanon 961 494
Lesotho 266 963
Liberia 231 997
Libya 21 901
Liechtenstein 41 45
Lithunia 370 539
(formerly USSR)
Luxembourg 352 402
Macao 853 808
Macedonia 389 597
Madagascar 261 986 Subscriber number beginning with 4, 5, 7, 8 and 9 can
be reached by Manual Calls.
Madeira Is. 351 404 Destination code is the same as for Portugal.
Malawi 265 904
Malaysia 60 84
Maldives Is. 960 896
Mali 223 985
Malta 356 406 Subscriber number beginning with 11XX can be
reached by Semi-automatic calls.

403
Mariana Is. 671 760
Marshall Is. 692 765
Maritinique 596 298
Mauritania 222 974
Mauritius 230 966
Mexico 52 22 Disregard the figure "0" at head of subscriber number.
Micronesia 691 764
Moldova 373 682
Monaco 33 42 Destination code is the same as for France.
Mongolia 976 800
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Area and Country Cgﬁlﬁey%ﬁje Teleégggntry Remarks for Telex Code
Montserrat 1 396
Morocco 21 407
Mozambique 258 992
Myanmar 95 83
(formerly Burma)
Namibia 264 908
Nauru 674 775
Nepal 977 891
Netherlands 31 44
Netherlands Antilles 599 390
New Caledonia 687 706
New Zealand 64 74
Nicaragua 505 375
Niger 227 975 2XXXX other numbers are for Semi-automatic calls.
Nigeria 234 905
Niue Is. 683 776
Northern Mariana Is. 670
Norfolk Is. 672 766
Norway 47 56
Oman 968 498
Pakistan 92 82
Palau 680 763
377 TRT subscribers
Panama 507 378 AACR subscribers
379 INTEL subscribers
Papua New Guinea 675 703
Paraguay 595 305
Peru 51 36
PHILCOM subscribers 2XXXX
RCPI subscribers 7XXXX
Philippines 63 75 < | GMCR subscribers 4XXXX
ETPI subscribers 6XXXX
CAPWIRE subscribers 1XXXX
For PTT subscribers, insert the figure "8" after the
L | destination code "75".
Poland 48 63 Disregard the figure "0" at head of subscriber number.
Portugal 351 404
205 RCA subscribers 2XXX
Puerto Rico 1 206 ITT subscribers 345XXX
207 C&W, WUI subscribers
209 ACPR (PRCA) subscribers
Qatar 974 497
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Area and Country C;I)—S:](at?;]%%%e Teleéc():g:ntry Remarks for Telex Code
Reunion 262 961 Subscriber numbers are 916 XXX
Romania 40 65 Disregard the figure "0" at head of subscriber number.
Russian Federation 7 64
Rwanda 250 909
Saipan 670 760
San Marino 378 505
Sao Tome & Principe 239 967 Manual calls
Saudi Arabia 966 495
Senegal 221 906
Seychelles 248 965
Sierra Leone 232 998
Singapore 65 87
Slovak 42 66
Slovenia 386 598
Solomon Is. 677 778
Somalia 252 900
Cape Town subscribers XXXXXX

South Africa 27 95 Bophuthatswana subscribers 08XXXX
Transkei subscribers 09XXX

Spain 34 52

Spanish North Africa 34 52

Sri Lanka 94 803

St. Helena 290 (960) Manual calls 4XXX

St. Kitts & Nevis 1 397

St. Lucia 1 398

St. Pierre & Miquelon 508 204

St. Vincent & 1 399

the Grenadines

Sudan 249 984

Suriname 597 304

Swaziland 268 964

Sweden 46 54

Switzerland 41 45

Syria 963 492

Tajikistan 7 787

Taiwan 886 769

Tanzania 255 989

Thailand 66 86

Togo 228 977

Tokelau 690 762

Tonga 676 777

Trinidad & Tobago 296 294

Tunisia 21 409

Turkey 90 607

Turkmenistan 7 789
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Telephone | Telex Country

Area and Country Remarks for Telex Code

Country Code Code
Turks & Caicos Is. 1 296
Tuvalu 688 774
U.A.E. 971 893
Abu Dhabi 2XXXX, 3XXXX, BXXXX
Ajman 695XX
Dubai AXXXX
Fujairah BXXXX
Ras Al Khaimah 9XXXX
Sharjah 68XXX
Umm Al Qaiwain 697XX
Uganda 256 988
Ukraine 7 680
United Kingdom 44 51
United Arab Emirates 971 893
Upper Volta 226 978 Same as "Burkina Faso".
Uruguay 598 32
Uzbekistan 7 786

CCI subscribers 7XXXXXX

U.S. A 1 23 ITT subscribers 4XXXXX, 4XXXXXX, 4XXXXXXXXX
RCA subscribers 2XXXXX

WUI subscribers 6XXXX, BXXXXX, BXXXXXX

23 TRT subscribers IXXXXX, IXXXXXXXXX

FTCC subscribers 8XXXX, 8XXXXX

U. S. A. (Mainland) ) GRPHNET subscribers 36 XXXXX, 37XXXXX

For WUT subscribers, insert the figure "0" after the
destination code "23".

25 Telex calls to TWX subscribers whose numbers do not
contain "0" as the third figure of the 10 figure code can
be made as Semi-automatic calls.

U. S. S. R. (Former) 7 640 Russian Federation

Vanuatu 678 771

Vatican 379 504

Venezuela 58 31

Viet Nam 84 805 Subscriber number beginning with 561XXX can be

made using manual calls

Wallis & Futuna Is. 681 707

Western Samoa 685 779

Yemen (Rep. of) 969 806 Formerly Yemen (P. D. Rep. of)
Yugoslavia (Former) 967 895 Formerly Yemen (Arab Rep.)
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Area and Country Cgﬁ:ﬁ‘:;%r:)%e Teleégg:ntry Remarks for Telex Code

Zaire 243 982 Telex calls to places other than Kinshasa Subscriber
beginning with 2XXXX can be made as Semi-automatic
calls.

Zambia 260 902

Zanzibar 259 990

Zimbabwe 263 907

Ocean Area o;;r:fli?]pggg i?)n R-I(;(geli(cen); 2%‘2‘223 Remarks
Access Code

AOR-W 874 584 Atlantic Ocean-W

AOR-E 871 581 Atlantic Ocean-E

POR 872 582 Pacific Ocean

IOR 873 583 Indian Ocean
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LES List
April/2002

Land earth station operator Country AOR- E | AOR- W IOR POR
Beijing Marine China 311 211
Bezeq Israel 127 327
CAT Thailand 319
CP Radio Marconi Portugal 118
Embratel Brazil 114
France Telecom France 121 021 321 221
France Telecom (Ex DeteSat) [France 115 333
KDDI Japan 103 003 303 203
Korea Telecom South Korea 308 208
Morviasputnik (Nudel Les) Russia 117 317
OTE Greece 120 305
Polish Telecom Poland 116 316
Saudi Telecom Co Saudi Arabia 125 325
Singapore Telecom Singapore 328 210
Stratos Mobile Networks Canada 102 002 302 202
Telecom Company of Iran Iran 314
Telecom ltalia Italy 105 335
Telenor Satellite Services Inc  |USA 101 001 201
Telenor Satellite Services AS  [Norway 104 004 304 204
Turk Telecom Turkey 110 310
Vishipel Vietnam 330
VSNL India 306
Xantic Netherlands 112 012 312 212
Xantic Australia 122 022 322 222
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International Telex Abbreviations

Abbreviation

Meaning

ADV
ACK
AGN
BI (GS)
BK
CFN
CoL
CRV
DER
DWN
EEE
FM
GA
MNS
MOM
MUTI
NA
NC
NCH
NP
NR
occC
OK
P (or 0)
PLS (PSE)
PPR
P (RCD)
RAP
RD
RE
RPT
SRY
SVP
TAX
TEST MSG
THRU
TKS (TNX)
TLX

Advise

Acknowledge

Again

Good bye

| cut off.

Confirm

Collation

How do you receive?

Out of order

Down

Error

From

Go ahead.

Minutes

Wait (Waiting)

Mutilated

Correspondence to this subscriber is not admitted.
No circuits

Snbscriber’'s number has been changed.
The called party is not or no longer is a subscriber.
Indicate your call number.

Subscriber is engaged.

Agreed.

Stop your transmission.

Please

Paper

Received

I will call you again.

Read

Referring to

Repeat

Sorry

Please

What is the charge?

Please send a test message?

You are in communication with telex position
Thanks

Telex
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International Telegraphy Alphabet

No. FIGURES | LETTERS No. FIGURES | LETTERS
1 - A 17 1 Q
2 ? B 18 4 R
3 C 19 S
4 qp* D 20 5 T
5 3 E 21 7 U
6 L= F 22 = \Y
7 . g G 23 2 W
8 * H 24 / X
9 8 | 25 6 Y
10 BELL* J 26 + Z
11 ( K 27 CARRIAGE RETURN
12 ) L 28 LINE FEED
13 M 29 LETTERS
14 , N 30 FIGURES
15 9 0 31 SPACE
16 0 P 32 BLANK

* = Cannot be entered.

APPENDIX
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Messages

Below are the various operational messages and their meanings. Messages are arranged
according to function key.

[F1]
1.

2.

8.

9."

10

11."

12.

13.

14.

15.

16.

17.

18.

19.

20.

21

File

"Overwrite?"
You are asked if you are sure to overwrite file name entered.
"OK to save?"
You are asked if you are sure to save a file.
"OK to delete file?"
You are asked if it is OK to delete selected file.
"Can't delete."
File cannot be deleted.
"Enter new filename"
Enter a new file name (to save file under new name.)
"Can't rename."
Cannot rename file.
"Insert new disk for drive "
You are asked to insert a floppy disk in the disk drive.
"And select media type"
Select media type of floppy disk.
Format start."
Formatting of the disk begins.
. "xx% Completed."
Percentage of floppy disk formatted.
Format completed. "
Formatting of floppy disk completed.
"Format failed."
Could not format floppy disk.
"Press any key to escape.”
Press any key to escape and erase message shown.
"Abort process."
Formatting aborted.
"Drive not ready."
No floppy disk in disk drive.
"Write protected.”
Floppy disk is write protected.
"Drive error."
Floppy disk may be defective.
"Checking "
Checking MIME-coded file.
"Decode ?"
Decode Base64 coded file.
"Now decoding..."
Decoding file.
. "Complete."
File decoding completed.
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22."

23.

24.

25.

26."

27

APPENDIX

Decode failed. "
File could not be decoded.
"This terminal not support this code."
File could not be decoded because type of code not supported.
"Decoded 1 file(s)."
Decode MIME coded file.
"This file is not encoding."
Cannot encode file selected.
File is already exist. Overwrite?"
You are asked if it is OK to write over MIME-coded file.
“Directory not found.”
You have specified a directory which does not exist on a floppy disk.

[F3]: Transmit

1.’

2."

3."

8."

9.'

10

11.°

12.

13.

14.

15."

16.

'Input Error : Message File."

Invalid message selected for transmission.
Input Error : Country/Ocean Code."

Invalid country/ocean code entered.
Input Error : Station ID."

Invalid station ID entered.

"Input Error : Modem Type."

Invalid mode type entered. (For FAX, choose T30.)

"Input Error : E-Mail Address."

Invalid e-mail address entered.

“Input Error : LES ID."

Invalid LES ID entered.

"Input Error : Send Delay."

Invalid send delay time entered.
Input Error : Prefix Code."
Invalid prefix code entered.

'Invalid character detected in message."

Invalid character found in TX message.
"Don't support E-Mail service in this NCS."
Selected NCS does not handle e-mail.
Input Error : Too many stations."
You have selected too many stations to transmit to.
"Message file is too large (but send only with 32KB)."
The size of the file you want to send is larger than 32,000 bytes. (The file can be
sent, but only the first 32,000 bytes of information will be received.)
"Attach file is too large."
The size of the attachment you want to send is larger than 32,000 bytes.
"Attach file (file name) is not found."
Cannot find attached file.
Message is entered in sending Queue. Press any key."
Tx message entered into queue.
"Can't enter this message to sending Queue. Press any key."
Could not enter TX message into queue.
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17. "Can't delivery a mail to server.”
Message cannot be forwarded to shipboard mail server.
18. "DHCP server not exist."
IP address cannot be acquired because DHCP server does not exist.

[F5]: Data report

1. "Input Error : Country/Ocean Code."
Invalid country/ocean code entered.
2. "Input Error : Station 1D."
Invalid station ID entered.
3. "Input Error : LES ID."
Invalid LES ID entered.
4. "Input Error : Interval Time"
Invalid interval time entered.
5. "Input Error : Start Time"
Invalid start time entered.
6. "Input Error : Modem Type"
Invalid modem type entered.
7. "Input Error : Report Contents"
Invalid report contents entered.
8. "Input Error : Report Times"
Invalid number of report times entered.
9. "Input Error : Destination”
Invalid destination entered.
10. "Input Error : E-Mail Address"
Invalid e-mail address entered.
11. "Don't support E-Mail service in this NCS."
NCS does not handle e-mail.
12. "Input Error : Prefix Code"
Invalid prefix code entered.

[F7]: PV test

1. "Starting PV Test Process."

Going into PV test mode.
2. "Automatic test mode: Normal communication disabled."

Going into automatic test mode — all communications are disabled.
3. "Do not press any distress button unless you are in distress."

Do not operate the [DISTRESS] button except in an emergency.

Printing

1. "Can't enter in Print Que."

2. "Print Que is Full."

3. "Can't print. PRINTER NOT READY."
4. "Can't print. Paper Low."

5. "Disk full. Can't enter in Print Que."
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Digital Interface (IEC 61162-1 2" Edition)

Output sentences
GGA, GLL, GSV, RMC, VTG, ZDA

Input sentences
BWC, BWR, DBT, GGA, GLL, MTW, RMA, RMB, RMC, VDR, VTG, WPL, ZDA

Transmission interval

GLL, GGA, VTG, RMC: 2 s
ZDA:1s
GSV:10s

Data transmission

Data is transmitted in serial asynchronous form in accordance with the standard referenced
in 2.1 of IEC 61162-1. The first bit is a start bit and is followed by data bits,
least-significant-bit as illustrated below.

The following parameters are used:
Baud rate: 4800

Data bits: 8 (D7 = 0), parity none
Stop bits: 1

DO |D1 | D2 |D3 | D4 | D5 | D6 | D7

Start - - » Stop
bit Data bits bit
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Data sentences

Input sentences

BWC - Bearing and distance to waypoint - great circle

$--BWC, hhmmss.ss, llILIL, a yyyyy.yy, a, x.x, T, X.X, M, X.x, N, ¢c--c, a*thh<CR><LF>

L |—Checksum

Mode indicator
(see note 1)
Waypoint ID*

Distance, nautical miles
Bearing, degrees magnetic*
Bearing, degrees true
Waypoint longitude, E/W*

Waypoint latitude, N/S*
— UTC of observation*

*: Not used

NOTE 1: Positioning system Mode indicator:
A = Autonomous
D = Differential
E = Estimated (dead reckoning)
M = Manual input
S = Simulator
N = Data not valid
The Mode indicator field shall not be a null field.
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BWR - Bearing and distance to waypoint - rhumb line

$--BWR,hhmmss.ss, lllLIIL,a,yyyyy.yyy,a,x.x,T,x.x,M,x.x,N,c--c,a*hh<CR><LF>
(I I

+ 1

. UTC of observation

. Waypoint latitude, N/S

. Waypoint longitude, E/W

. Bearing, degrees true

. Bearing, degrees magnetic
. Distance, nautical miles

. Waypoint ID

. Mode indicator(see note)

. Checksum

OCoONOODWN-=-

NOTE Positioning system Mode indicator:
A = Autonomous
D = Differential
E = Estimated (dead reckoning)
M = Manual input
S = Simulator
N = Data not valid
The Mode indicator field shall not be a null field.

DBT - Depth below transducer

$--DBT,x.X,f,x.X,M,Xx.X,Frfhh<CR><LF>
| |

1. Water depth, feet

2. Water depth, m

3. Water depth, fathoms
4. Checksum

APPENDIX
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GGA - Global positioning system(GPS) fix data

$--GGA,hhmmss.ss,llILIILa,yyyyy.yyy,a,x,xX,X.X,X.X,M,X.X,M,X.X,xxxx*hh<CR><LF>
[

|
||
||
||
||
|1
||
| +
+

+ +
T T

ot 2
+ 1

. UTC of position
. Latitude, N/S
. Longitude, E/W
. GPS quality indicator (see note)
. Number of satllite in use,00-12, may be different from the number in view
. Horizontal dilution of precision
. Antenna altitude above/below mean sealevel, m
. Geoidal separation, m
9. Age of differential GPS data
10. Differential reference station 1D, 0000-1023
11. Checksum
NOTE
0 = fix not available or invalid
1 = GPS SPS mode, fix valid
2 = differential GPS, SPS mode, fix valid
3 = GPS PPS mode, fix valid
4 = Real Time Kinetic. Satellite system used in RTK mode with fixed integers
5 = Float RTK. Satellite system used in RTK mode with floating fingers
6 = Estimated (dead reckoning) mode
7 = Manual input mode
8 = Simulator mode
The GPS quality indicator shall not be a null field.

O~NO U WN P
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GLL - Geographic position - latitude/longitude

$--GLL LI a,yyyyy.yyy,a,hhmmss.ss,A,a*hh<CR><LF>
[ I I [ O

. Latitude, N/S

. Longitude, E/W

. UTC of position

. Status: A=data valid, V=data invalid
. Mode indicator(see note)

. Checksum

O WNPE

NOTE Positioning system Mode indicator:
A = Autonomous
D = Differential
E = Estimated (dead reckoning)
M = Manual input
S = Simulator
N = Data not valid

The Mode indicator field supplements the Status field. The Status field shall be
set to V=invalid for all values of Operating Mode except for A=Autonomous and
D=Differential. The positioning system Mode indicator and Status field shall not

be null fields.

MTW - Water temperature

$--MTW,x.x,C*hh<CR><LF>
[ |
I

S —— 1

1. Temperature, degrees C
2. Checksum

APPENDIX
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RMA - Recommended minimum specific LORAN-C data

$--RMA A ILIILa, yyyyy.yy,a,Xx.X,X.X,X.X,X.X,X.X,a,a*hh<CR><LF>
(I | Il

e o —
+
+
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
~

+
T

+-t 3
+--—+ 2
+ 1

1. Status: A=data valid, V=blink, cycle or SNR warning
2. Latitude, degrees N/S

3. Longitude, degrees E/W

4. Time difference A, microseconds

5. Time difference B, microseconds

6. Speed over ground, knots

7. Course over ground, degrees true

8. Magnetic variation(see note 1),degree E/W

9. Mode indicator(see note 2)

10. Checksum

NOTE 1 - Easterly variation(E) subtracts from true course
Westerly variation(W) adds to true course

NOTE 2 Positioning system Mode indicator:
A = Autonomous
D = Differential
E = Estimated (dead reckoning)
M = Manual input
S = Simulator
N = Data not valid

The Mode indicator field supplements the Status field. The Status field
shall be set to V=invalid for all values of Operating Mode except for
A=Autonomous and D=Differential. The positioning system Mode indicator
and Status field shall not be null fields.
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RMB - Recommended minimum navigation information

$--RMB, A x.x,a,c--C,c--C,llILINLa,yyyyy.yyy,a,x.X,X.x,x.X,A,a*hh<CR><LF>
I I [ I |1

ot 6
+ 5

+

I
I
I
I
I
I
I
I
I
I
| 4
| + 3

2

+
T

+ 1

. Data status: A=data valid, V=navigation receiver warning
. Cross track error(see note 2) n.miles

. Direction to steer L/R

. Origin waypoint ID

. Destination waypoint ID

. Destination waypoint latitude,N/S

. Destination waypoint longitude,E/W

. Range to destination, n.miles(see note 1)

. Bearing to destination, degrees true

10. Destination closing velocity, knots

11. Arrival status: A=arrival circle entered or perpendicular passed
12. Mode indicator(see note 3)

13. Checksum

O©CoO~NOOOUTA,WNPE

NOTES
1 If range to destination exceeds 999.9 nautical miles, display 999.9.
2 If cross track error exceeds 9.99 nautical miles, display 9.99.

3 Positioning system Mode indicator:
A = Autonomous
D = Differential
E = Estimated (dead reckoning)
M = Manual input
S = Simulator
N= Data not valid

The Mode indicator field supplements the Status field. The Status field
shall be set to V=invalid for all values of Operating Mode except for
A=Autonomous and D=Differential. The positioning system Mode indicator
and Status field shall not be null fields.

APPENDIX
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RMC - Recommended minimum specific GPS/TRANSIT data
$--RMC,hhmmss.ss,A llILIILa,yyyyy.yyy,a,X.X,X.X, XXXXXX,X.X,a,a*hh<CR><LF>
I I ||

I I I I [ I

| [ [ I | | | +--10
I I I O O | | +---9
I I [ Hombonee 8
| I N N s 7

I I N B B 6

I I [ |+ 5

| I +e-t 4

| | -+ 3

| + 2

+ 1

1. UTC of position fix

2. Status: A=data valid, V=navigation receiver warning
3. Latitude, N/S

4. Longitude, E/W

5. Speed over ground, knots

6. Course over ground, degrees true

7. Date: dd/mml/yy

8. magnetic variation, degrees E/W

9. Mode indicator(see note)

10. Checksum

NOTE Positioning system Mode indicator:
A = Autonomous
D = Differential
E = Estimated (dead reckoning)
M = Manual input
S = Simulator
N = Data not valid

The Mode indicator field supplements the Status field. The Status field
shall be set to V=invalid for all values of Operating Mode except for
A=Autonomous and D=Differential. The positioning system Mode indicator
and Status field shall not be null fields.

VDR - Set and drift

$--VDR,x.X, T,X.X,M,Xx.X,N*hh<CR><LF>
I

1. Direction, degrees true

2. Direction, degrees magnetic
3. Current speed, knots

4. Checksum
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VTG - Course over ground and ground speed

$--VTG,x.X,T,x.x,M,x.X,N,x.Xx,K,a*hh<CR><LF>
| [ 1]

1. Course over ground, degrees true

2. Course over ground, degrees magnetic
3. Speed over ground, knots

4. Speed over ground, km/h

5. Mode indicator(see note)

6. Checksum

NOTE Positioning system Mode indicator:
A = Autonomous
D = Differential
E = Estimated (dead reckoning)
M = Manual input
S = Simulator
N = Data not valid

The positioning system Mode indicator field shall not be a null field.

ZDA - Time and date

$--ZDA, hhmmss.ss, XX, XX,XXXX,XX,XX*hh<CR><LF>

+ 1

1. UTC

2. Day, 01 to 31(UTC)

3. Month, 01 to 12(UTC)

4. Year(UTC)

5. Local zone hours, 00h to +-13h

6. Local zone minutes, 00 to +59
as local hours

7. Checksum
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Output sentences

GGA, GLL, RMC, VTG, ZDA - see Input sentences

GSV - GNSS satellites in view

$--GSV, X, X, XX, XX, XX, XXX, XX........., XX, XX, XXX, XX*hh<CR><LF
N N
O I R 10
O O L At it iy 9
I O O I B R 8
I O I 7
I I I 6
[T+ 5
[+ 4
||+ 3
| + 2
+ 1

1. Total number of messages, 1to 9

2. Message number, 1t0 9

3. Total number of satellites in view

4. Satellite ID number

5. Elevation, ddegrees, 90deg maximum

6. Azimuth, degrees true, 000 to 359

7. SNR(C/No) 00-99 dB-Hz, null when not tracking

8. Second and third SVs

9. Fourth SV

10. Checksum
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Serial interface I/O circuit

16P0209
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+ 33V
8
6| , DT|4
A 3
R38 10,,, PEDE £
R40 10y, 7B RO 1 q;
U1l Cl1
R42 270
M— LTC1488CS8
i Y
TD_A 6
- = | FL27 L N 4
EXC_CET102U § 3 ¥»|3°——
TD_B 7< GND
- FL28 R37 270 £
EXC_CET102U €7
RD_A 8
= | FL29
EXC_CET102U
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F IFL23
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Parts List

This equipment contains complex modules in which fault diagnosis and repair down to
component level are not practical (IMO A.694(17)/8.3.1. Only some discrete components
are used. FURUNO Electric Co., Ltd. believes identifying these components is of no value
for shipboard maintenance; therefore, they are not listed in the manual. Major modules can
be located on the parts location photos on the next several pages.

FURUNO Model |FELCOM 15
Unit
TERMINAL UNIT IC-215
ELECTRICAL PARTS LIST Ref.Dwg.|C5635-K01-A Page
Oct-02|Blk.No.
SYMBOL TYPE CODE No. REMARKS SHIPPABLE
ASSEMBLY
PRINTED CIRCUIT BOARD
B2 16P0208A, RF CON/CPU 004-439-200 X
B3 16P0209, TERM CPU 004-439-300 X
B4 16P0211, PWR 004-439-120 X
B5 16P0212, SW 004-439-100 X
B6 16P0226, MCN 004-439-220 X
B10 16P0214, PWR C 004-439-170 X
ASSEMBLY
B7 JU-226A032FC, FDD 000-146-045 X
B8 NL6448BC33-46, LCD 000-144-814 X
B9 GN-79L5A-N, GN-79 (option) 000-146-179 X
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FURUNO Model |FELCOM 15
Unit
ANTENNA UNIT IC-115
ELECTRICAL PARTS LIST Ref.Dwg. |C5635-K04-A Page
Oct-02|BIk.No.
SYMBOL TYPE CODE No. REMARKS SHIPPABLE
ASSEMBLY

PRINTED CIRCUIT BOARD
B2 16P0206, ANT B 004-439-020 X
B3 16P0207, ANT RF 004-439-040 X
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Parts Location

Terminal unit

PWR Board .
(16P0211) [ i

TERM CPU Board
(16P0209)

£ RF CON/CPU Board
= Il (16P0208A)

1 | MCN Board
e} (16P02026)

INT GPS Assy.
(Option)
(GN-79L5A-N)

FDD Assy.
PWR C Board (JU-226A032FC)
(16P0214)
LCD Asembly
(NL64488C33-46)
SW Board
(16P0212)

Terminal unit, inside view
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Antenna unit

ANT RF Board
(16P0207) -

//’
~~___ ANT B Board
(16P0206)

Antenna unit, cover opened
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FURUNO

FELCOM 15

SPECIFICATIONS OF INMARSAT C MES

FELCOM 15

Inmarsat-C mobile earth station FELCOM 15 has the function of LRIT (Long-Range Identification

and Tracking System). It obtained the type approval from Telefication in July 2008, in accordance
with SOLAS Chapter V/19-1 and IMO Res. MSC.210 (81).

11
12
13
14
15
1.6
17
1.8
1.9
1.10

111

2.1
2.2

2.3
2.4
2.5

GENERAL

Transmitting frequency 1626.5 to 1646.5 MHz

Receiving frequency
Channel interval
GIT

EIRP

Modulation
Modulation rate
Coding

Decoding

1530.0 to 1545.0 MHz

5 kHz

Better than -23 dB/K (elevation angle 5°)

12 to 16 dBW (elevation angle 5°)

BPSK

1200 sps

Convolution with coding rate 1/2 and constraint length 7
Viterbi decoder

Navigation data interface IEC61162-1, Internal GPS Board (option)

Input data sentences

Output data sentences
EGC Receiver

ANTENNA UNIT
Antenna type
Gain

Horizontal:

Vertical:
Declination
Axial ratio

VSWR

POWER SOURCE

BWC, BWR, GGA, GLL, VTG, WPL, RMA, RMB, RMC, MTW,
DBT, VDR, ZDA

GGA, ZDA, GLL, VTG, RMC, GSV

Built in (EGC: Enhanced Group Call)

Daisy loop antenna

Omnidirectional

0 dBi or more (angle of elevation: 90°)
+1.3 dBi or more (angle of elevation: 5°)
Clockwise circular

Within 6 dB (5° to 90°)

1.5 or less (50 ohm)

12-24 VDC: 13.0-5.0 A (Transmit), 1.7-0.9 A (Receive)

ENVIRONMENTAL CONDITION

Ambient temperature
Exposed equipment:
Protected equipment:

-35°C to +55°C (storage: -35°C to +70°C)
-15°C to +55°C

SP-1 E5635S01K
080827


三好 悦子
 


FURUNO

4.2
4.3

4.4

51
52
5.3

Relative humidity
Degree of protection
Antenna unit

Others

Vibration

UNIT COLOR
Antenna unit
Terminal unit
Others

95% (at +40°C)

IPX6
IPX0
IEC 60945

Upper: N9.5, Lower: 2.5PB3.5/10

N3.0
2.5GY5/1.5

SP-2
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Declaration of Conformity

We FURUNO ELECTRIC CO., LTD.
(Manufacturer)
9-52 Ashihara-Cho, Nishinomiya City, 662-8580, Hyogo, Japan
(Address)

declare under our sole responsibility that the product

Inmarsat Mobile Earth Station Types FELCOM 15 and FELCOM 15 with SSAS functionality which is
capable of operation within the Long Range Identification & Tracking System (LRIT) in accordance
with IMO SOLAS Regulation V/19-1 and Resolution MSC.263(84)

(Model name, type number)

to which this declaration relates conforms to the following standard(s) or normative

document(s)
Standards Test standards
IMO Resolutions MSC.36(63), MSC.97(73) IEC 61097-4: 1994-11
IMO Resolutions A.570(14), A.664(16), A.807(19) EN 60945: 2002-10 (IEC 60945 edition 4.0: 2002-08)
IMO Resolutions A.694(17), MSC.68(68)/A4 IEC 61162-1 edition 2.0; 2000-07

IMO Resolution MSC.147(77)
IMO MSC Circular MSC/Circ.862

(title and/or number and date of issue of the standard(s) or other normative document(s))
For assessment, see

+ Certificate of EC type-examination (Module B) certificate No. 09212007 issued by Telefication b.v.
(0560), The Netherlands

* Production Quality System (Module D) certificate No. P 112 issued by Telefication b.v. (0560), The
Netherlands

This declaration is issued according to the provisions of European Council Directive 96/98/EC on
marine equipment modified by the Commission Directive 2008/67/EC.

On behalf of Furuno Electric Go., Ltd.

Nishinomiya City, Japan nager, QMS Secretariat
June 04, 2009 Quality Assurance Department

(Place and date of issue) (name and signature or equivalent marking of authorized person)
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